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Welcome to DB2 Connect

This book provides you with an easy start to installing and using the basic functions of
DB2 Connect.

Part 1 gives an overview of DB2 and DB2
Connect products.

Part 2 provides information on planning for

and installing DB2 Connect on 0OS/2, Windows DB2

NT, Windows 95, Windows 3.1, or Windows for .

Workgroups 3.11 workstations. ’ I IllVGI'S al
A
Database

Part 3 provides information on using the Data
Sources Setup tool or the Client Configuration
Assistant to configure communications
between DB2 Connect and host systems.

Part 4 describes how to configure SNA
software manually.

Part 5 describes how to install and configure
DB2 Clients.

Part 6 describes how to use DB2 Universal - 5 . !
Database. : | 1 "4

Part 7 describes the unattended installation of

DB2 Connect. v

Part 8 describes configuring DRDA hosts to
accept connections from DB2 Connect.

Part 9 contains reference information and
describes viewing, printing, and ordering the
manuals that are provided in online format.

Conventions

This book uses these highlighting conventions:

¢ Boldface type indicates commands or graphical user interface (GUI) controls such
as names of fields, folders, icons, or menu choices.

e Monospace type indicates examples of text you enter exactly as shown.

e Jtalics indicates variables that you should replace with a value. It is used also to
indicate book titles, and to emphasize words.
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This is a fast path icon. It tells you if you can skip sections to get to the "how
to" information. It is shown to indicate where you should go next.

This icon marks a Tip — additional information that can help you complete a

task.

Road Map to DB2 Connect Information

Use the following table to quickly find the information you need.

workstation's operating system:
e For OS/2:

— Chapter 5, “Installing DB2 Connect on OS/2
Systems” on page 25

— Chapter 26, “Unattended DB2 Installation on
0OS/2 or Windows 3.x Workstations” on
page 179

e For Windows 95 or Windows NT:

— Chapter 6, “Installing DB2 Connect on Windows
95 and Windows NT Systems” on page 29

— Chapter 27, “Unattended DB2 Installation on
Windows 95 or Windows NT Workstations” on
page 189

e For Windows 3.1x systems:

— Chapter 7, “Installing DB2 Connect for
Windows 3.1 and Windows for Workgroups
3.11" on page 37

— Chapter 26, “Unattended DB2 Installation on
0S/2 or Windows 3.x Workstations” on
page 179

Required
If you want to... Refer to... Reading?
Understand the different Chapter 1, “About DB2 Connect” on page 3 and Optional.
options for deploying DB2 Chapter 3, “How to Use DB2 Connect in Your Network”
Connect in your network, on page 9.
Confirm that your system “Software Requirements” on page 19 and “Disk Recommended.
meets the DB2 Connect Requirements” on page 18.
software and hardware
prerequisites,
Install DB2 Connect, the installation chapter for your environment and your Required.
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If you want to...

Refer to...

Required
Reading?

Create SNA connections to
DRDA databases,

the chapter that applies to your workstation's operating
system and SNA communications subsystem:

For OS/2:

Chapter 9, “Configuring DRDA Host
Connections on OS/2, Windows 95, or Windows
NT Workstations” on page 49

Chapter 12, “Configuring Communications
Server for OS/2 for DB2 Connect for OS/2” on
page 59

For Windows 95 or Windows NT:

Chapter 9, “Configuring DRDA Host
Connections on OS/2, Windows 95, or Windows
NT Workstations” on page 49

Chapter 13, “Configuring Integrated SNA
Support Manually on Windows Workstations” on
page 75

Chapter 14, “Configuring IBM Communications
Server for Windows NT” on page 81

Chapter 15, “Configuring IBM Communications
Server for Windows NT SNA Client” on

page 93

Chapter 16, “Configuring Microsoft SNA Server
for DB2 Connect for Windows NT” on page 101

Chapter 17, “Configuring Microsoft SNA Client”
on page 117

For Windows 3.1 or Windows for Workgroups 3.11:

Chapter 8, “Configuring Host Connections on
Windows 3.1 or 3.11 Workstations” on page 45

Chapter 13, “Configuring Integrated SNA
Support Manually on Windows Workstations” on
page 75

Chapter 17, “Configuring Microsoft SNA Client”
on page 117

Required.

Configure DB2 Connect
Personal Edition to

Chapter 19, “Configuring Your DB2 Connect Personal
Edition to Access a Remote DB2 Server” on page 127.

Required, if you
will access DB2

communicate with DB2 Universal
Universal Database servers, Database
servers.
Use the DB2 components, Chapter 21, “Getting Started with the DB2 Universal Recommended.
Database” on page 135.
Control access, “Changing Default Privileges for Users” on page 137. Recommended.

authentication, passwords,
and username management,

Welcome to DB2 Connect
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If you want to...

Refer to...

Required
Reading?

Use clients,

Chapter 22, “Running Your Own Applications” on
page 141.

Recommended.

Bind applications and utilities
to DB2 for MVS/OS390, DB2
for AS/400, or DB2 for VM &
VSE to give applications
access to host data,

“Binding Database Utilities” on page 141.

Required by you
or your database
administrator.

Set up a DB2 Call Level
Interface or ODBC
environment to enable ODBC
applications such as Lotus
Approach to access DB2
data,

“Running CLI/ODBC Programs” on page 143.

Recommended if
you will use this
function.

Use the DB2 Command Chapter 23, “Entering DB2 Commands and SQL Recommended.
Center or the DB2 command Statements” on page 151.

line processor to enter SQL

statements or DB2

commands interactively,

Prepare DRDA hosts to Chapter 29, “Configuring DRDA Hosts for DB2 Connect” Recommended

accept connections from DB2
Connect,

on page 223.

Configure TCP/IP
connections to DB2 for
0S/390 databases,

“Configuring TCP/IP for DB2 for OS/390” on page 232

for your DRDA
and network
administrators.

Print or view online “Printing the PostScript Books” on page 251 or “Viewing Recommended.
documentation, Online Books” on page 252.
Learn about last-minute The Installation Notes that are on the CD-ROM or the Recommended.

changes to the product,

Release Notes that are installed with the products.
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Part 1. Introduction to DB2 Connect
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Chapter 1. About DB2 Connect

IBM's DB2 for OS/390, DB2 for AS/400, and DB2 for VSE & VM databases continue to
be the systems of choice for managing most critical data for the world's largest
organizations. While these host and AS/400 databases manage the data, there is a
great demand to integrate the data managed by these systems with applications
running on PCs, UNIX workstations, and Apple Macintosh workstations.

DB2 Connect Personal Edition (formerly known as DDCS Single User) enables
applications on your OS/2, Windows 3.1, Windows for Workgroups 3.11, Windows 95,
and Windows NT workstations to directly access host databases stored on:

e« DB2 for MVS/ESA, DB2 for AS/400, DB2 for VM and VSE systems
e DB2 Universal Database servers running on 0OS/2, Windows NT, and several UNIX
systems.

DB2 Connect provides access to those databases in a cost-effective way by
implementing a standard architecture for managing distributed data, known as
Distributed Relational Database Architecture (DRDA). Use of DRDA allows your
applications to establish a fast connection to host and AS/400 databases without
expensive host components or proprietary gateways. DB2 Connect products implement
a DRDA Application Requester that can access DRDA Application Servers running on
MVS, AS/400, OS/390, VM, and VSE systems.

DB2 Connect products provide a run-time environment for database applications written
in C, C++, Java, COBOL, FORTRAN, SmallTalk, REXX, and other programming
languages. Programmers can use the latest tools, such as IBM VisualAge, Microsoft
Visual Studio, Borland Delphi, and many others, to develop database applications using
the following Application Programming Interfaces (APIs):

¢ Microsoft ODBC

e DB2 Embedded SQL (both static and dynamic)
e DB2 Call Level Interface

e Java Database Connectivity

This allows you to use a wide range of off-the-shelf or custom-developed database
applications, and provides application programmers with a broad selection of tools and
functions. For example, you can use DB2 Connect products with:

e Spreadsheets, such as Lotus 1-2-3 and Microsoft Excel, to analyze real-time data
without the cost and complexity of data extract and import procedures.

e Decision support tools, such as Business Objects, Intersolv Q+E Database Editor,
and Crystal Reports, to provide real-time information.

e Database products, such as Lotus Approach and Microsoft Access.

e Development tools, such as IBM VisualAge, PowerSoft PowerBuilder, Microsoft
VisualBasic, and Borland Delphi, to create client/server solutions.

© Copyright IBM Corp. 1993, 1997 3
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DB2 Connect Personal Edition provides an integrated package that gives all of the tools
you need to be productive quickly. DB2 Connect Personal Edition includes:

Direct host access without gateways or host components.

An Integrated SNA Support (except on OS/2) that gives you out-of-the-box
connectivity without the need to purchase extra network components.

Highly optimized ODBC and JDBC drivers for instant support of thousands of
client-server and Java applications.

A complimentary copy of the award-winning Lotus Approach to help you quickly
turn your host and AS/400 data into information you can use.

Each copy of DB2 Connect Personal Edition provides separate versions of the code
optimized for OS/2, full 32-bit versions for Windows 95 and Windows NT, as well as
16-bit versions for Windows 3.1 and Windows for Workgroups 3.11. This means that
the copy you purchased will serve you no matter which operating system you are using
today or plan to move to in the future.

DB2 Connect Personal Edition is a member of the DB2 family of products, which
includes relational database systems, middleware, and application development tools.
The following is a list of other DB2 family products that are available separately:

DB2 Universal Database Workgroup Edition is a relational database management
system that enables local and remote clients and applications to create, update,
control, and manage relational databases using Structured Query Language (SQL),
ODBC, or CLI.

In addition, you get the DB2 Client Pack CD-ROM, which contains all the latest
DB2 Client Application Enablers. With DB2 Client Application Enabler, clients from
a variety of platforms can connect to DB2 databases.

DB2 Universal Database Enterprise Edition includes all the functions of the DB2
Universal Database Workgroup Edition plus includes the DB2 Connect support that
allows access to databases on host systems.

DB2 Application Developer's Kit (AD Kit) contains a collection of DB2 Universal
Database products, clients, DB2 Connect products, DB2 Software Developer's Kits,
and application development tools for all supported platforms. The AD Kit gives you
all the tools you need to create multimedia database applications that can run on a
variety of platforms and can connect to any DB2 server, including mainframe and
AS/400 databases.

DB2 Universal Database Personal Edition allows you to create and use local
databases and to access remote databases if they are available. This product is
available for the OS/2, Windows NT, and Windows 95 operating systems.

DB2 Connect Enterprise Edition (formerly known as DDCS Multi-User Gateway)
provides access from clients on the network to DB2 databases residing on host
systems such as MVS/ESA, 0S/390, OS/400, VM, and VSE.

DB2 Universal Database Extended Enterprise Edition (formerly known as DB2
Parallel Edition) provides the ability for a database to be partitioned across multiple
independent computers of a common platform. To the end-user and application

DB2 Connect Personal Edition Quick Beginnings



developer, it still appears as a single database on a single computer. This fully
scalable database system enables an application to use a database that is simply
too large for a single computer to handle efficiently. SQL operations and utilities
can operate in parallel on the individual database partitions, thereby speeding up
the execution time of a single query or utility.

Note: DB2 Workgroup Edition, DB2 Enterprise Edition, DB2 Personal Edition, and
DB2 Extended Enterprise Edition are commonly referred to as DB2 server
throughout this book.

Chapter 1. About DB2 Connect 5
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Chapter 2. What's New in DB2 Connect
Version 5?

¢ New easier to purchase packaging:

— A single DB2 Connect Personal Edition package that contains OS/2, Windows
3.1, Windows 95, and Windows NT versions of the product. This package
contains everything that is needed to get started, including a complimentary
copy of Lotus Approach.

— A single DB2 Connect Enterprise Edition package that contains 0OS/2,
Windows NT, and all UNIX versions.

e Capability:
— New Level 3 ODBC driver with many improvements
— Updated JDBC driver for better Java support

— Support for stored procedures that return multi-row result sets and multiple
result sets (requires DB2 for OS/390 Version 5.1)

— Built-in replication support

— Generic bind option: you can specify any bind option supported by the host
database.

— SYSPLEX exploitation (DB2 Connect Personal Edition only; requires DB2 for
0S/390 Version 5.1)

e Usability:
— New installation method

— TCP/IP database connections are much easier to configure (requires DB2 for
0S/390 Version 5.1)

— Integrated SNA support with point-and click configuration (DB2 Connect
Personal Edition only)

— New point and click configuration utility for configuring host connections.

— Much easier process for connecting desktop client systems to DB2 Connect
Enterprise Edition servers. Clients can discover DB2 Connect servers and all
of the databases that are defined on each server

— Improved ODBC traces with detailed information for performance analysis
— Control Center and other GUI tools that simplify several DBA tasks

e Security:
— DCE security (requires DB2 for OS/390 Version 5.1)
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— Ability to run ODBC applications without having to authorize each user to base
tables. Users can now bind their ODBC driver in such a way as to allow
applications to run under the authority of the person that bound the ODBC
driver.

e Performance:
— Faster access to the DB2 catalog for ODBC applications
— Reduced network traffic:
- Early close for cursors
- Deferred prepare
- Reduced byte count on Compound SQL
- Several other network flow enhancements

- Support for ASCII storage on the host (requires DB2 for OS/390 Version
5.1)

e Connectivity:

— Support for DRDA over TCP/IP connections to other IBM DRDA Application
Servers, as they introduce support for TCP/IP. (Native TCP/IP support
currently requires DB2 for OS/390 Version 5.1)

— SNA over TCP/IP via integrated MPTN support (requires AnyNet on the host).
— Support for additional SNA connectivity options:
- IBM Communication Server for Windows NT
- IBM Personal Communications
e Other:

— Ability to initiate 2-phase commit transactions over TCP/IP (requires DB2 for
0S/390 Version 5.1)

— Ability for desktop applications to participate in a 2-phase commit transactions
without the need for a gateway (TCP/IP only, requires DB2 for OS/390 V5.1)

— Ability to use DB2 for OS/390 for added reliability of transaction coordination
(requires DB2 for OS/390 Version 5.1 and TCP/IP)

— Numerous other enhancements and fixes affecting all aspects of system
performance, reliability, and usability.
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Chapter 3. How to Use DB2 Connect in
Your Network

Go directly to Chapter 5, “Installing DB2 Connect on OS/2 Systems” on page 25 or Chapter 6,
“Installing DB2 Connect on Windows 95 and Windows NT Systems” on page 29 if you want to
start installing the product immediately.

Your network is a complex combination of hardware and software components, set up
to best fit the needs of your organization. DB2 Connect products provide several ways
of connecting to S/370, S/390, and AS/400 database servers to enable you to choose
the best way to connect your workstations to your host databases. This chapter
describes the following network configurations:

* Direct SNA connection from DB2 Connect to a DRDA host, such as DB2 for
MVS/ESA, using DB2 Connect Personal Edition.

¢ Indirect connection from DB2 Connect to a DRDA host via a communications
gateway, such as IBM Communications Server or Microsoft SNA Server.

¢ Server-based connection from DB2 clients to DRDA hosts via a DB2 Connect
Enterprise Edition gateway.

In addition to access to mainframe and AS/400 databases, DB2 Connect products can
also be used to provide access to DB2 Universal Database servers. This chapter
provides a brief description of such a configuration.

Note: If is important that you decide which of the network configurations applies to
your environment. This is required for you to set up connectivity to your
database servers.

Direct Connection to a DRDA Host

Direct connection without intermediate gateways and servers is a very convenient and
desirable configuration. This is especially true for situations where the host database
supports TCP/IP connectivity (for example, DB2 for OS/390 V5.1 or later). In such a
configuration, each DB2 Connect workstation establishes a direct TCP/IP connection to
DB2 for OS/390 or, using the Integrated SNA Support, connects via APPC to DB2 for
MVS and other host and AS/400 databases.

TCP/IP connectivity requires that the host database support TCP/IP. At this point, DB2
for OS/390 V5.1 provides support for native TCP/IP connections. An alternative to
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native TCP/IP is MPTN connectivity. MPTN connections require that IBM AnyNet
products be installed on the target database system, but does not require the host
database to provide native TCP/IP support.

Figure 1 shows workstations directly connected to a DRDA host. Each workstation has

DB2 Connect Personal Edition installed.
DB2 for il O
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H DB2 for DB2for
H HH“ VSE 0S/400
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DB2 for P
S/390 /370 VM /
y\
\\ /
* Requires DB2 for TCP/IP* MPTN SNA
0S/390 V51 Coax***
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** For AS/400 only. Ethernet Y Twinax**
*** For host connections only. SDLC Token-ring
*** APPC over TCP/IP (MPTN) . 4 /’ LS S
requires AnyNet on AS/400 / \\
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[T——\

DB2 Connect Personal Edition

Figure 1. Direct Connection Between DB2 Connect and a DRDA Host

In this environment, if you are using a Windows 3.x, Windows 95, or Windows NT
workstation, you can use the DB2 Connect Personal Edition Integrated SNA Support to
connect directly to the host servers. DB2 Connect Integrated SNA Support permits
connections over a variety of local and wide area networks, such as Token-Ring,
Ethernet, SDLC, Twinax, Coax and Asynchronous dial-up. The DB2 Connect Integrated
SNA Support implements both APPC and MPTN connections over networks using
hosts and AS/400 systems that have IBM AnyNet products installed. Users of OS/2
workstations can use IBM Personal Communications for OS/2. IBM Communications
Manager V1.11, or IBM Communications Server for OS/2 to achieve direct APPC and
MPTN connectivity.

10 DB2 Connect Personal Edition Quick Beginnings



Connections via Communications Gateway

Some organizations prefer to concentrate access to SNA networks through dedicated
SNA Gateways , such as IBM Communications Server, Microsoft SNA Server, or Novell
Netware for SAA. DB2 Connect products support connections through gateways, so this
can be a good choice if you need terminal emulation and other SNA services not
provided by DB2 Connect. Figure 2 on page 11 illustrates such a situation.

DB2 for il R
05/390 H :
i ﬂ]lf E =
DB2 for DB2 for —
NH i VSE 0S/400
|||
DB2 for —_—
ﬁ VM « AS/400

‘\
\\
Coax** Channel Asynch SNA
Ethernet Twinax*
SDLC Token-ring

Windows NT

SNA Gateway

(for example, IBM Commumication
Server for NT, or Microsoft SNA Server)

* For AS/400 only.

** For host connections only.

IPX/SPX, NetBIOS
TCP/IR APPC

I I
Windows 31 Windows 95 Windows NT 0S/2

DB2 Connect Personal Edition with SNA Gateway Client Software

Figure 2. Indirect Connection to DRDA Host via SNA Communications Gateway
Although you can use DB2 Connect Personal Edition with SNA gateways, you may find

DB2 Connect Enterprise Edition a better choice if you want to use many DB2 Clients.
DB2 Connect Enterprise Edition can be installed on the same machine as IBM
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Communications Server or Microsoft SNA Server, and in many cases it can provide a
less expensive and better-performing solution. Figure 3 on page 13 provides an
overview of the DB2 Connect Enterprise Edition gateway scenario.

Contact your authorized IBM reseller for additional information about DB2 Connect
Enterprise Edition.

Connections via a DB2 Connect Enterprise
Edition Server

12

Figure 3 on page 13 illustrates IBM's solution for environments in which you want to
use a DB2 Client Application Enabler making an indirect connection to a DRDA host
through DB2 Connect Enterprise Edition server.

All DB2 and DB2 Connect products include a Client Application Enabler component. In
addition, the DB2 Client Application Enabler is available as a separate product for AIX,
DOS, HP-UX, Macintosh, OS/2, SCO OpenServer, Silicon Graphics, SINIX, Solaris,
Windows NT, Windows 3.1, Windows for Workgroups 3.11, and Windows 95.

This type of connectivity is most appropriate for environments where large numbers of
workstations need well-managed, secure access to host and AS/400 databases. It
allows database administrators to concentrate all access to host data through one or
more DB2 Connect servers.
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Actual connectivity options depend on the platform chosen.

Figure 3. Indirect Connection to DRDA Host via DB2 Connect Enterprise Edition
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Connections to DB2 Universal Database
Servers

Figure 4 illustrates a direct connection between a DB2 Universal Database server and
the DB2 Client Application Enabler software that is included in DB2 Connect Personal
Edition. You can use these connections concurrently with connections to DRDA hosts.

DB2 Universal Database servers are available for AlX, HP-UX, OS/2, Solaris, and
Windows NT.

DB2
Universal
Database
Server

IPX/SPX, NetBIOS
TCP/IR APPC

Windows 3.1x Windows 95 Windows NT

DB2 Connect Personal Edition

Figure 4. Connection between DB2 Connect Personal Edition and a DB2 Server
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Part 2. DBZ2 Connect: Planning and
Installation
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Chapter 4. Planning for Installation

If you know that your system meets DB2 Connect's hardware and software requirements, and you
want to start installing DB2 Connect right away, go directly to either Chapter 5, “Installing DB2
Connect on OS/2 Systems” on page 25, Chapter 6, “Installing DB2 Connect on Windows 95 and
Windows NT Systems” on page 29, or Chapter 7, “Installing DB2 Connect for Windows 3.1 and
Windows for Workgroups 3.11” on page 37 .

DB2 Connect provides many components that you might want to use in your
environment. Use the product and planning information in this section to confirm that
your system has the prerequisites, and to decide which components you want to install.

Memory Requirements

If you want to access host data from your local machine, use the configuration shown in
Figure 5. The diagram shows DB2 Connect Personal Edition installed on the system
and various local applications able to access data from host databases.

DB2 Connect Personal Edition - Memory Requirements

DB2 Connect Personal Edition

0S/2
Win NT
Win 95
Win 3.1x

Application n

o~
c
2
T
L2
=y
o
<

Application 1

Figure 5. Configuration for Accessing Host Databases Using DB2 Connect Personal Edition

The amount of memory you need on your system depends on the applications you
intend to run. We suggest that you have a minimum of 32 MB to access host
databases using DB2 Connect Personal Edition. Use this guideline to determine the
amount of memory necessary in your environment.
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Disk Requirements

This section shows the minimum amount of disk space that is required by DB2
products. It does not include the disk requirements necessary for the operating system,
application development tools, and communications products. Consult each product's
documentation for these values. Estimates for disk space requirements are listed here.
The actual amounts required depend on the functions you are using. Use this
information to plan for systems with a large number of concurrent clients or databases.

Estimating Fixed Disk Requirements

To estimate the disk requirements for a particular configuration, add the recommended
minimum disk sizes for the products and components you want to install. Include an
allowance for your application data.

Disk Requirements Table

Use Table 1 on page 19 to estimate the amount of disk space you need to install DB2
and associated products on your operating system.
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Table 1. Estimating Disk Requirements

DB2 Connect Personal Edition for OS/2

DB2 Connect — this amount includes the following components: 100 MB
¢ Client Configuration Assistant 5 MB
e Graphical Tools 5 MB
¢ Control Center 30 MB
¢ Performance Monitor 10 MB
¢ Visual Explain 5 MB
¢ Windows Support 10 MB
e East Asian Conversion Support 5 MB

Online documentation in HTML format 30 MB

DB2 Connect Personal Edition for Windows 95 or Windows NT
DB2 Connect — this amount includes the following components: 70 MB
¢ Graphical Tools (Client Configuration Assistant, Control Center, 35 MB
Performance Monitor, and Visual Explain)
¢ East Asian Conversion Support 5 MB
Online documentation in HTML format 30 MB
DB2 Connect Personal Edition for Windows 3.1x

DB2 Connect 50 MB

Online documentation in HTML format 30 MB
e East Asian Conversion Support 5 MB

Note: The disk amounts listed are approximations.

Software Requirements

The following sections outline the software that is required to run DB2 Connect

Enterprise Edition or DB2 Connect Personal Edition on each of the supported operating

systems.

DB2 Connect Personal Edition relies on network software to provide connectivity to host
and AS/400 databases as well as to DB2 Universal Database servers. Therefore, it is
important to establish which network software you will use before proceeding with the

installation.

DB2 Connect Personal Edition uses communication software for establishing host

connectivity and connectivity to DB2 Universal Database servers. For the host

connectivity, your software requirements will depend on:

¢ The protocol that you will be using (APPC, TCP/IP, or MPTN)
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¢ Whether you will be using direct connection (see “Direct Connection to a DRDA
Host” on page 9) or connections via SNA gateway (see “Connections via
Communications Gateway” on page 11).

Software Requirements for OS/2 Users

DB2 Connect Personal Edition can be used on machines running one of the following
levels of the OS/2 operating system:

e OS/2 Warp Version 3 and Version 4
e OS/2 Warp Connect Version 3

e OS/2 Warp Server Version 4

e OS/2 Warp Server Advanced V4

e 0OS/2 Warp Server SMP

Because of DB2 Connect Personal Edition's requirement for communications, versions
of OS/2 with built-in communications capabilities, such as OS/2 Warp Connect, OS/2
Warp Server, OS/2 Warp Server Advanced and OS/2 Warp Version 4 are
recommended.

Host Communications

For direct connection to host and AS/400 databases via SNA (APPC), one of the
following communications products is required:

¢ |IBM Communication Manager for 0S/2 V1.11
¢ |IBM Communication Server for OS/2 Version 4
¢ |IBM Personal Communications for OS/2 V4.1

For direct connections to host databases via TCP/IP, no additional software is required
for network-enabled versions of OS/2. Users of OS/2 Warp Version 3 require IBM
TCP/IP for OS/2 Version 3.0 or later.

For connections via communications gateway, see “Connections via Communications
Gateway” on page 11 and the documentation for your SNA gateway product that
described the enablement of OS/2 clients for APPC (LU6.2) communications.

Software Requirements for Windows NT Users

20

DB2 Connect Personal Edition can be used on machines running Windows NT 3.51 or
later version of the operating system. Both Windows NT workstation and Windows NT
server are supported.

Windows NT supplies all the communication support required to establish TCP/IP,
NetBIOS, and IPX/SPX connectivity. Therefore, no additional software is required for
connecting to DB2 Universal Database servers.
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Host Communications

For direct connection to host and AS/400 databases via SNA (APPC), and MPTN, DB2
Connect Personal Edition provides an Integrated SNA support. Alternately, one of the
following communication products can be used for connecting DB2 Connect Personal
Edition to host databases via SNA (APPC):

¢ |BM Personal Communications for Windows NT V4.1 or later

¢ |IBM Communication Server for Windows NT V5 or later

* Microsoft SNA Server V2.11 or later

¢ Wall Data Rumba

e Other communications products that provide APPC connectivity and fully comply
with WinCPI-C specification

For direct connections to host databases via TCP/IP, no additional software is required
as Windows NT provides built-in TCP/IP support.

For connections via SNA gateway, see “Connections via Communications Gateway” on
page 11 and the documentation for your SNA gateway product that describes the
enablement of Windows NT clients for APPC (LU6.2) communications.

Software Requirements for Windows 95 Users

DB2 Connect Personal Edition can be used on machines running the Windows 95
operating system.

Windows 95 supplies all the communication support required to establish TCP/IP,
NetBIOS, and IPX/SPX connectivity. Therefore, no additional software is required for
connecting to DB2 Universal Database servers.

Host Communications

For direct connection to host and AS/400 databases via SNA (APPC), and MPTN, DB2
Connect Personal Edition provides an Integrated SNA support. Alternately, one of the
following communication products can be used for connecting to host databases via
SNA (APPC):

¢ |BM Personal Communications for Windows 95 V4.1 or later

e Wall Data Rumba

e Other communications products that provide APPC connectivity and fully comply
with WIinCPI-C specification

For direct connections to host databases via TCP/IP, no additional software is required
as Windows 95 provides built-in TCP/IP support.
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For connections via SNA gateway, see “Connections via Communications Gateway” on
page 11 and the documentation for your SNA gateway product that describes the
enablement of Windows 95 clients for APPC (LU6.2) communications.

Software Requirements for Windows 3.1 and
Windows for Workgroups 3.11 Users

22

DB2 Connect Personal Edition can be used on machines running the Windows 3.1 and
Windows for Workgroups 3.11.

Because Windows for Workgroups 3.11 provides communication support for TCP/IP,
NetBIOS, and IPX/SPX connectivity, this version of the 16-bit Windows operating
system is preferable to Windows 3.1. When using Windows for Workgroups 3.11, no
additional software is required for connecting to DB2 Universal Database servers.

Windows 3.1 workstations require the following connectivity software:

e IPX/SPX — Novell Requester for DOS

¢ NetBIOS - IBM LAN Support Program, IBM DOS LAN requester or other NetBIOS
connectivity software

e TCP/IP — IBM TCP/IP for DOS V2.1.1 or any other TCP/IP product that conforms
to the WinSOCK V1.1 specification.

Host Communications

For direct connection to host and AS/400 databases via SNA (APPC), and MPTN, DB2
Connect Personal Edition provides an Integrated SNA support.

For direct connections to host databases via TCP/IP, no additional software is required
as Windows for Workgroups V3.11 users who have obtained TCP/IP communications
subsystem from Microsoft. Windows 3.1 users can use any WinSOCK V1.1-compliant
TCP/IP product, such as IBM TCP/IP for DOS V2.1.1.

For connections via SNA gateway, see “Connections via Communications Gateway” on
page 11 and the documentation for your SNA gateway product that describes the
enablement of Windows 3.1 clients for APPC (LU6.2) communications.
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Security Requirements

Since you will be accessing data managed by other systems, you will require a user ID
and password so that you can be authenticated by the system. To obtain these,
contact the administrator responsible for the system where the data resides.

In addition, to access to the system, you will require authorization to access data
objects on the target database server; for example, tables, views, and program
packages. To obtain the appropriate authorization, contact your database administrator.

An additional DB2 security mechanism called binding allows database administrators to
limit access to specific applications. This mechanism is used to build program packages
or plans. The database administrator then grants authority to users to execute these
packages.

If you will be running an application developed using embedded SQL, a package will be
supplied with your application. You must bind this package to each database that the
application will access. Package files are usually supplied with the file type “bnd.”
ODBC users do not bind individual applications; instead, they must bind the ODBC
diver itself to each database that will be accessed.

To bind applications or the ODBC driver, you require the following privileges on each
database:

DB2 for OS/390 or DB2 for MVS
BINADD privilege, plus CREATE IN COLLECTION NULLID,
SYSCTRL, or SYSADM authority.
DB2 for VSE & VM
DBA authority
DB2/400
*CHANGE authority or higher on the NULLID collection.

If your database administrator will not grant you these privileges, another user (usually
the administrator) must perform the required binds.
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Chapter 5. Installing DB2 Connect on OS/2

Systems

If you need to install software on many OS/2 systems, see Chapter 26, “Unattended DB2
Installation on OS/2 or Windows 3.x Workstations” on page 179.

This chapter describes how to install DB2 Connect on an OS/2 workstation.

Before You Begin Installing on OS/2

Before you begin the installation, be sure that you have the following items and
information:

The type of host connectivity that you want to use (a direct connection using DB2
Connect Personal Edition or a connection that uses an SNA gateway).

The protocol to be used for host connectivity:

- APPC
- TCP/IP
— MPTN

A user ID that has local administrator or administrator authority in User Profile
Management (UPM). The Administration Server uses this user ID to log on when it
is started.

If UPM is installed, the user ID you specify must have Administrator or Local
Administrator authority. Create a user ID with these characteristics if necessary;
see Chapter 25, “Administering and Using OS/2 User Profile Management on OS/2
Systems” on page 169 for more information.

When prompted for this user ID and password during install, the user ID will be
checked to ensure that it exists, can logon, and has administrative authority on the
system. If the checks fail, install will not continue until a user ID and password are
properly verified. You can minimize the install window if necessary to create the
user ID, but it is recommended that this be done prior to starting the install.

If UPM is not installed, DB2 will install it, and the user ID and password entered
will be used to create a user ID with the correct authorities so that the
Administration Server can be logged on and started when the system is booted.
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¢ The names of the products you want and are licensed to install (see Table 2 on
page 26). To see descriptions of each of the products, see Chapter 1, “About DB2
Connect” on page 3.

e If you decide to install the Control Center, you must also decide whether you want
the Control Center to autostart. The Control Center is a graphical tool used to
perform the following DB2 administration tasks: managing databases, tables and
views; configuring systems; performing database backup and recovery; scheduling
jobs; and replicating data.

Selecting Products and Components

The following table lists the products and selectable components that you can install
with DB2 Connect Personal Edition.

Table 2. Products and Components for DB2 Connect Personal Edition

Product Components

DB2 Connect Personal Edition
Graphical Tools

Client Configuration Assistant

Control Center

Performance Monitor

Visual Explain

Windows Support

Documentation

Japanese Conversion Support

e Korean Conversion Support

¢ Simplified Chinese Conversion Support
¢ Traditional Chinese Conversion Support

DB2 Connect Personal Edition

Ensure that you select DB2 Connect Personal Edition, not DB2 Universal
Database Personal Edition.

Performing the Installation on OS/2

To install DB2 from CD-ROM, do the following:
1 Insert the CD-ROM in the drive.

2 There are two ways to begin the DB2 installation. These are:

e If you have the OS/2 Warp Server installed, double-click on the Server
Installation icon located in the Server folder on the desktop.
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OR

¢ Open an OS/2 windows and set the drive to x:, where x is the letter that
represents your CD-ROM drive.

¢ Set the current directory to \db2\language\install, where language is the
two-character country code that represents your language (for example, EN
for English). Table 16 on page 256 lists the code for each available
language.

¢ Enter the command install .

You can invoke the install command with optional parameters to create error
and history log files. See “Step 3. Run the CMD/BAT File from the Remote
Workstation” on page 183 for more information.

3 The IBM DB2 for OS/2 Version 5 Installation window opens. Select the product
that you want to install on your system. Select the Install radio button and then
click on the Continue push button. Following is a sample of the window:

|68 DB for 052 Version 5 Installarion

Gelect the product(s) you are licensed o install. Your Prool of
Entitlement and License Information booklat identify the product{s) for
wihich yow are leensed.

Product Selection
_ IEM DEZ Universal Database Personal Edition
¥ IEM DEZ Connect Personal Edition

Operation Typsa
= hnstall o DelEne

Comtinue Exit Help

4 In the Update CONFIG.SYS File window, indicate whether or not you want to
update the config.sys file as part of the installation.

¢ If you want the config.sys file updated, click on OK. A backup copy of your
existing file is kept as config.0xx.

¢ If you do not want the config.sys file updated, clear the Update CONFIG.SYS
check box and click on OK. You will need to manually update your config.sys
file with the values that are stored in the config.add file that will be created in
the root directory of your boot drive.
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5 The Install - Directories window provides a list of the product's components. You
can choose which of the components you want to install on your system.

For the Install - Directories window, complete the entries as follows:

a
b

e

Select each of the components you want to install.

Click on the Descriptions button for a brief description of the selected
components.

In the File directory field, type the directory where you want the product
installed. The default value is c:\sqllib.

Note: If a DB2 Version 5 product is already installed on the workstation,
you must install on the same drive and directory.

Click on the Disk Space button to see how much space you have on each
of the drives on your machine and to change disks if necessary.

Click on the Install button to continue.

6 The product and components you have chosen are installed on your system. A
progress window appears until the installation is complete.

7 A message appears when the installation is complete. Click on OK to dismiss the
message, shut down and reboot your system.

This completes the installation.

If DB2 fails to start after you reboot your system, see the file db2cnfg.out in
the x:\sgllib\misc directory, where x is the drive where you installed DB2.
This file contains the results of database manager configuration updates,
and other actions necessary for automated startup upon reboot.

To set up connections to DRDA databases, see Chapter 9, “Configuring DRDA Host Connections
on OS/2, Windows 95, or Windows NT Workstations” on page 49 or Chapter 12, “Configuring
Communications Server for OS/2 for DB2 Connect for OS/2” on page 59.
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Chapter 6. Installing DB2 Connect on
Windows 95 and Windows NT Systems

If you need to install software on many Windows NT or Windows 95 systems, see Chapter 27,
“Unattended DB2 Installation on Windows 95 or Windows NT Workstations” on page 189.

This chapter describes how to install DB2 Connect on a Windows 95 or a Windows NT
workstation.

Before You Begin Installing on Windows NT
and Windows 95

Read and perform the steps in this section before you begin the installation to ensure
that you have the required items and information that you will need.

You need to ensure that you know the type of host connectivity that you want to use (a
direct connection using DB2 Connect Personal Edition or a connection that uses an
SNA gateway), and the protocol to be used for host connectivity:

« APPC
« TCP/IP
« MPTN

Creating Usernames for DBZ2 Installation and
Operation

This section describes the usernames required to install the DB2 product and its
components.
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Creating a Username for Installing DB2
Products

Windows 95
The username must be a valid DB2 username.

A valid DB2 username is eight characters or less, and complies with DB2's naming
rules. For more information on DB2's naming rules, see Appendix C, “Naming Rules”
on page 265.

Windows NT

You need to have a username that will be used to install DB2. The username must
belong to the Administrators group, and also be a valid DB2 username or have the "Act
as part of the operating system" advanced user right.

A valid DB2 username is eight characters or less, and complies with DB2's naming
rules. For more information on DB2's naming rules, see Appendix C, “Naming Rules”
on page 265.

If this username does not comply with DB2's naming rules, but has the "Act as part of
the operating system" advanced user right, the setup program will create the username
DB2ADMIN to perform the installation.

This username will be removed from the system when the installation is
complete.

Selecting Products and Components

Choosing Which Optional Components to
Install

DB2 Connect offers the option of using APPC, TCP/IP, or MPTN protocols for host
connectivity. For your convenience, DB2 Connect Personal Edition includes an
Integrated SNA Support that provides APPC and MPTN connectivity. If you plan to use
only TCP/IP for your host connectivity, you do not need to install the Integrated SNA
Support. If you do choose to install Integrated SNA Support, you must ensure that you
have the Microsoft DLC driver installed on your workstation. See “Ensuring DLC is
Installed on Windows NT Workstations” on page 31 for instructions on installing the
DLC driver.

Note: DB2 Connect Personal Edition for Windows NT and Windows 95 offers you the
option of installing Integrated SNA Support. Do not install Integrated SNA
Support if your workstation has SNA support already installed. Products that can
provide SNA support include:
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e IBM Communications Server for NT V5

e IBM Communications Server for NT SNA Client

e PCOMM AS/400 and 3270 V4.1 or later

e Wall Data Rumba

* Microsoft SNA Server

e Microsoft SNA Client.
The following table lists the products and selectable components that you can install on
DB2 Connect Personal Edition. For information on the products and components, see
Chapter 1, “About DB2 Connect” on page 3. The check marks in the columns for
Typical Install and Compact Install indicate the components that are installed when

these types of install are used. See “Performing the Installation on a Windows 95 or
Windows NT Workstation” on page 32 for more information on install types.

Table 3. Products and Components for DB2 Connect Personal Edition for Windows NT and Windows 95

Product Components and Subcomponents Typical Compact
Install Install

DB2 Connect Personal O Graphical Tools v

Edition (Host Connect) O Client Configuration Assistant v

O Control Center
O Performance Monitor
O Visual Explain

O Integrated SNA Support v

0 DB2 ODBC Driver v v
O East Asian Conversion Support

o Documentation 4

Ensuring DLC is Installed on Windows NT
Workstations

If you plan to install the Integrated SNA Support, you need to ensure that DLC is
already installed before you install DB2 Connect on your Windows NT workstation:

1 Click on the Start button and select Settings ->Control Panel .
2 Double-click on the Network icon.
3 Select the Protocols tab.

4 In the Protocols field, see if DLC is listed.
e |If DLC is listed, you can install the DB2 Connect software.

e |If DLC is not listed, install it as follows:

a On the Network Protocols window, click on the Add push button.
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b Select the DLC Protocol option.

C Insert your original Windows NT operating system CD-ROM into the
CD-ROM drive.

d Click on the Have Disk push button, and provide the installation drive
and path.

€ Click on OK to return to the Network Protocol window.

—

Click on OK.

Close the Network folder.

o «Q

Reboot you workstation when prompted.

Performing the Installation on a Windows 95
or Windows NT Workstation

To install DB2 Connect Personal Edition on a Windows 95 or Windows NT workstation:

1 If you are installing on a Windows NT workstation, log on as a user that meets
the requirements for installing DB2. For more information, see “Creating
Usernames for DB2 Installation and Operation” on page 29.

2 Shut down any other programs so that the setup program can update files as
required.

3 Insert the CD-ROM into the drive. The auto-run feature automatically starts the
setup program. The setup program will determine the system language, and
launch the setup program for that language. If you want to run the setup program
in a different language, see the tip that follows.

To manually invoke the setup program, do the following:

1 Click on the Start button and select Run

2 Type the following in the Open field:
x:\setup /i=LANGUAGE
where

e x: represents your CD-ROM drive

e | ANGUAGE represents the two-character country code for your
language (for example, EN for English). Table 16 on page 256
lists the code for each available language.

3 Select OK
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4 The Welcome window opens. Click on the Next push button to open the Select
Products window, as shown below. Select the product that you want to install and
click on the Next push button.

Select Products

Select the product(z] pou are licensed to install. v'our Proof of
Entitlement and License Infarmation boaklet identify the
product(z] far which you are licensed.

[ DBZ Connect Perzonal Edition

— Description

DEBZ Perzonal Edition provides a zingle-uzer version of the
DBZ Univerzal D atabaze for use at your workstation,

< Back I et I

Carnicel Help

5 You can select the installation type you prefer by clicking on the appropriate
graphic push button:

...............................

Typical Install:

Installs those DB2 components that are used most often,

including all required components, ODBC support, documentation, and

commonly used

DB2 tools such as the Information Center, and the Client

Configuration Assistant. The DB2 instance is created.

Compact Install:

Installs only required DB2 components and ODBC support.

The DB2 instance is created.

Custom Install:

Installs only those components that you select. The DB2

instance is created. The default for a Custom install is to install those
components and subcomponents you would get in a Typical install.
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The Client Configuration Assistant (CCA) component makes it easy for you
to configure and administer connections to databases and to bind
application and utilities to a database. See Chapter 28, “Administering
Clients Using the CCA” on page 209 for a complete description of the
CCA's features.

If the CCA is not installed, you will need to use the command line processor
to configure connections to a database.

To not install a particular component, such as the Integrated SNA Support,
choose a Custom installation and deselect the components you do not require.

Note: You cannot selectively uninstall components after the setup program
completes the installation.

Respond to the setup program's prompts. Online help is available to walk you
through the remaining steps. Invoke online help by clicking on the Help push
button at any time.

Note: If a DB2 Version 5 product is already installed on the workstation, you
must install the product on the same drive and in the same directory.

You can click on the Cancel push button at any time to end the installation.

After you install the product, you must reboot your workstation before you can
begin to use it. Select a reboot option and click on the Finish push button.

For information on errors encountered during product installation, see the
db2.log file. The db2.log file stores general information and error messages
resulting from installation and uninstall activities. By default, the db2.log is
located in the x:\db2log directory; where x: is the drive on which your
operating system is installed.

The installation program has:

8

Created DB2 program groups and items (or shortcuts).
Registered a security service.
Updated the Windows registry.

Created a default instance named DB2.

If you have installed DB2 Connect on a Windows 95 workstation, you must now
install DLC software:

a From the Control Panel, double-click on the Network icon.
b Click on the Add push button.

C Double-click the Protocol icon.
d

Insert your original Windows 95 operating system CD-ROM into the
CD-ROM drive.
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€ Click on the Have Disk push button, then enter:
x:\install_dir\sna\ms32dic

where x is the installation drive and install_dir is the installation directory
(usually \sqllib).

f Click on OK.
Click on OK to return to the original panel.

h Follow the instructions that appear. When you are instructed to do so, use
your original Windows 95 operating system CD-ROM to install the
remainder of the required files.

i Reboot your workstation when prompted.

To set up connections to DRDA databases, see one of the following chapters:

e Chapter 9, “Configuring DRDA Host Connections on OS/2, Windows 95, or Windows NT
Workstations” on page 49

e Chapter 13, “Configuring Integrated SNA Support Manually on Windows Workstations” on
page 75

e Chapter 14, “Configuring IBM Communications Server for Windows NT” on page 81

e Chapter 15, “Configuring IBM Communications Server for Windows NT SNA Client” on
page 93

e Chapter 16, “Configuring Microsoft SNA Server for DB2 Connect for Windows NT” on
page 101

e Chapter 17, “Configuring Microsoft SNA Client” on page 117.
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Chapter 7. Installing DB2 Connect for
Windows 3.1 and Windows for Workgroups
3.11

If you need to install software on many Windows 3.1x systems, see Chapter 26, “Unattended DB2
Installation on OS/2 or Windows 3.x Workstations” on page 179.

This chapter describes how to install DB2 Connect on a Windows 3.1 or a Windows for
Workgroups 3.11 workstation.

Before you begin, ensure that you know the type of host connectivity that want to use
(a direct connection using DB2 Connect Personal Edition or a connection that uses an
SNA gateway), and the protocol to be used for host connectivity:

« APPC
« TCP/IP
e MPTN

Performing the Installation on Windows 3.1
or Windows for Workgroups 3.11

Read this section if you are installing DB2 Connect Personal Edition on a workstation
that runs Windows 3.1 or Windows for Workgroups 3.11.

Choosing Which Optional Components to Install

DB2 Connect Personal Edition for Windows 3.1 and Windows for Workgroups 3.11
offers you the option of installing the following components:
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Table 4. Products and Components for DB2 Connect Personal Edition for Windows 3.1x

Product Components

DB2 Connect Personal Edition e DB2 Connect Personal Edition

¢ Integrated SNA Support (see the
note, below)

e Data Sources Setup tool (see the

note, below)

Documentation

Japanese Conversion Support

Korean Conversion Support

Simplified Chinese Conversion

Support

¢ Traditional Chinese Conversion
Support

DB2 Connect offers the option of using APPC, TCP/IP, or MPTN protocols for host
connectivity. For your convenience, DB2 Connect Personal Edition includes an
Integrated SNA Support that provides APPC and MPTN connectivity. If you plan to use
only TCP/IP for your host connectivity, you do not need to install the Integrated SNA
Support. If you do choose to install the Integrated SNA Support, you must ensure that
you have the Microsoft DLC driver installed on your workstation. See “Step 1. Ensure
DLC is Installed” on page 39 for instructions on installing the DLC driver.

Note:

Integrated SNA Support
Do not install Integrated SNA Support if your workstation has SNA
support already installed. SNA support is already installed if your
workstation has, for example:

e Wall Data Rumba
¢ Microsoft SNA Client.

Data Sources Setup Tool
Install the Data Sources Setup Tool if you want to configure the
SNA provided with:

e PCOMM AS/400 and 3270 V4.1 or later

¢ Integrated SNA Support

e Wall Data Rumba

e Microsoft SNA Client

e Other products that conform to the IBM CPI-C specification
with Microsoft WinCPI-C extensions.

You can also install the Data Sources Setup Tool if you want to
configure DB2 using a GUI, rather than by issuing commands from
a command line.
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Step 1. Ensure DLC is Installed

If you choose to install the Integrated SNA support on either Windows 3.1 and Windows
for Workgroups 3.11, DLC must be installed on the workstation before DB2 Connect is
installed:

On Windows 3.1

To determine if DLC is installed, examine the autoexec.bat file or the config.sys file for
a reference to msdic.exe.

e |f DLC is already installed, go to “Step 2. Ensure Win32s is Installed” on page 40.

e [fitis not, you need to acquire DLC from the manufacturer of your workstation's
communications adapter. For example, if you are using an IBM network adapter,
you should obtain IBM DOS LAN Support Program Version 1.33 or higher, and
install it by following the instructions provided.

On Windows for Workgroups 3.11

1 From the Program Manger, double-click on the Network icon.
2 In the Network folder, double-click on the Network Setup icon.
3 In the Network Setup window, see if DLC is listed in the Network Drivers field.
e Ifitis, go to “Step 2. Ensure Win32s is Installed” on page 40.
e Ifitis not listed:
a Obtain DLC from Microsoft.

Microsoft distributes the DLC driver wfwdlc.exe free of charge. You can
obtain it from the Microsoft Download Service either by calling (206)
936-6735 or by going to the Microsoft home page on the Internet
(http://www.microsoft.com).

b On the Network Setup window, select Drivers ->Add
Protocol ->Microsoft DLC .

Click on OK.
Enter the path to the installation media.

Click on OK->Close ->OK.

- ® 9 O

Reboot your workstation.
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Step 2. Ensure Win32s is Installed

To determine if Win32s is installed, check to see if the \windows\system\win32s
directory exists.

e If it does, go to “Step 3. Install DB2 Connect for Windows 3.1."

e |If it does not:
1 Insert the DB2 Connect Personal Edition CD-ROM into the CD-ROM drive.
2 From the Program Manager, select File->Run.
3 In the Command Line field, enter:

x:\language\winl6\win32s\setup

where language is the two-character country code that represents your
language (for example, EN for English). Table 16 on page 256 lists the code
for each available language.

Step 3. Install DB2 Connect for Windows 3.1

To install DB2 Connect Personal Edition on Windows 3.1 or Windows for Workgroups
3.11:

1 Insert the DB2 Connect Personal Edition CD-ROM into the CD-ROM drive.
2 From the Program Manager, select File->Run.
3 In the Command Line field, enter:

x:\language\winl6\install

where language is the two-character country code that represents your language
(for example, EN for English). Table 16 on page 256 lists the code for each
available language.

The Welcome screen appears, followed shortly by the first install window.
Select OK to update AUTOEXEC.BAT and to continue.

On the Install-directories window, select DB2 Connect Personal Edition, and any
other options you want to install.

You should install the Documentation, the DB2 Data Sources Setup tool, and
Integrated SNA Support, in addition to DB2 Connect Personal Edition.

Important:  You should not install the DB2 Connect Integrated SNA Support if
your DB2 Connect workstation already has another SNA product installed.

See “Choosing Which Optional Components to Install” on page 30.
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7 Select your preferred install drive and path; if necessary, select the Disk Space
button to check available disk space.

Select the Install button to continue.

If your system already had Wall Data Rumba software installed, you need to copy
the file \Rumba_root_dir \system\cpic.dll to \Rumba_root_dinsystem\wincpic.dll. By
replacing wincpic.dll with cpic.dll, you enable both your original applications and
DB2 Connect to work together.

10 After the DB2 Connect software is installed:
a Restart your workstation.
b Open the DB2 folder.

C Click on the Logon icon to start DB2 Connect. (You need to perform this
step before you can use the Data Sources Setup tool to define a connection
to a DRDA database.)

Check the README files!:  Read the two README files by clicking on their
icons in the DB2 folder.

To set up connections to DRDA databases, see Chapter 8, “Configuring Host Connections on
Windows 3.1 or 3.11 Workstations” on page 45 or Chapter 13, “Configuring Integrated SNA
Support Manually on Windows Workstations” on page 75.
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Part 3. Configuring Access to Host and
AS/400 Databases
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Chapter 8. Configuring Host Connections
on Windows 3.1 or 3.11 Workstations

For an application to work with DB2 data, it must be able to refer to that data using a
symbolic name. Applications using ODBC refer to the data by using a Data Source
Name (DSN). Applications developed using Embedded SQL refer to data by using an
alias. Therefore, the goal of configuring a host connection is to create both a Database
alias as well as an ODBC data source name that can be used by applications running
on the DB2 Connect workstation.

The DB2 Data Sources Setup tool is an easy-to-use utility that greatly simplifies the
task of defining aliases and ODBC data sources for DB2 databases. It provides a
point-and-click interface that guides you through the process of creating an APPC or a
TCP/IP connection and cataloging the nodes and databases. It also enables you to
perform such functions as binding DB2 utilities and testing connectivity. If you have an
organization that has many DB2 Connect Personal Edition workstations, you can share
definitions you have created by exporting them to a file and having other users import
those definitions.

This chapter describes how you:

e Create a DB2 data source definition for your workstation (see “Defining a DB2 Data
Source Definition”)

e Create a DB2 data source definition for another workstation (see “Exporting DB2
Data Source Definitions” on page 46)

e Use a DB2 data source definition created by others (see “Importing DB2 Data
Source Definitions” on page 47).

Defining a DB2 Data Source Definition

1 In the DB2 for Windows folder, double-click on the DB2 Data Sources Setup
icon.

The DB2 Data Sources window opens.

On Windows 3.1 systems, if the DB2 Data Sources window open briefly
then disappears, this indicates that Win32s is not installed. See “Step 2.
Ensure Win32s is Installed” on page 40 for installation instructions.
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The Configured DB2 data sources area lists the DB2 data sources that your
workstation is currently able to access.

To add a new data source, click on the Add push button. A screen containing a
series of panels appears.

2 Fillin the information, moving from panel to panel by clicking on the Next push
button. When you are finished, click on Done. The data source that you defined
appears in the list.

3 If you want to test the connection:

a Click on the DB2 data source definition that you just created.

The Test push button becomes selectable.
b Click on Test.

C In the screen that appears, enter your user identifier and password, then
click on OK. The test results appear on the screen.

Note: The initial connection may take a minute to establish. (Subsequent
tests of that connection will take less time).

4 Once you have connected successfully, bind utilities, such as ODBC/CLI support,
to the target DB2 database. To do this, click on the Show Administrator
Functions push button, then click on the Bind push button.

By defining the data source, you have configured your DB2 Connect workstation to
access a host database. You can now provide that data source definition to other DB2
Connect workstations (as described in “Exporting DB2 Data Source Definitions”).

Exporting DB2 Data Source Definitions

46

The Data Sources Setup tool enables you to create DB2 data source definitions that
you can provide to other DB2 Connect users. The instructions that follow assume that
you start with a working DB2 data source definition, which you can create by following
the instructions in “Defining a DB2 Data Source Definition” on page 45.

1 Click on the Data Sources Setup tool icon in the DB2 folder.

The DB2 Data Sources window opens, listing the available data sources.
Click on the DB2 data source definition that you want to make available.

If you want to modify an existing definition, click on the Setup push button and
follow the instructions on the screen to complete your modifications. When you
are finished, click on OK.

4 If you want to test the connection, click on Test.
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Note:

To save the data source definition to a file, click on the Show Administrator
Functions push button, then click on the Export push button. When you choose
the location for the definition file, remember that it must be made available to the
users who will import it.

The Export function implicitly captures many elements of your data source
setup, including performance-enhancing settings such as any ODBC
customization that you may have performed on the DB2 Connect workstation
that you are exporting from. Such settings are applied automatically to the DB2
Connect workstation that imports your exported definition.

By exporting the data source definition, you can now provide that data source definition
to other DB2 Connect workstations (as described in “Importing DB2 Data Source
Definitions™).

Importing DB2 Data Source Definitions

The Data Sources Setup tool enables an administrator to create DB2 data source
definitions that can be imported on other DB2 Connect Personal Edition workstations
(as described in “Exporting DB2 Data Source Definitions” on page 46.) The instructions
that follow assume that an Administrator has supplied you with the location of the DB2
data source definition, whether on a shared drive or on a diskette.

To apply a previously-created DB2 data source definition to your DB2 Connect
workstation:

1

Click on the Data Sources Setup tool icon in the DB2 folder.

The first Data Sources Setup tool window, DB2 Data Sources , opens.
Click on the Import push button.

The Import Data Source Definitions  screen appears.

Click on the Browse push button.

Click on the file which contains the DB2 data source definitions, as instructed by
your administrator.

Click on OK.

Click on the data source that you want to add to your workstation from the list of
data sources contained in the definition file.

¢ |If the data source definition is complete, the DB2 Connect workstation is
configured.
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¢ |If the data source definition is incomplete, a screen will appear showing
which information is missing. Provide the missing information, then click on
the Done push button.

Your DB2 Connect workstation will be configured to access the selected data
source automatically. The imported data source definition may contain
performance enhancing information such as ODBC customization settings. In
this case, the additional information will be applied to your DB2 Connect
workstation automatically.

To test the connection, from the Data Sources Setup tool:

1 Click on the DB2 data source definition from the list.

The Test push button becomes selectable.

2 If your host has been configured to permit a connection from your workstation,
click on Test.

3 In the screen that appears, enter your user identifier and password, then click on
OK. The test results appear on the screen.

The initial connection may take several minutes to establish, but
subsequent connection will take less time. You can now use
applications to access data at the target database.
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Chapter 9. Configuring DRDA Host
Connections on OS/2, Windows 95, or
Windows NT Workstations

If you have installed the Client Configuration Assistant on your workstation, you can use
this tool to configure your DB2 Connect workstation to access host or OS/400
databases. Although the Client Configuration Assistant provides three methods to
configure connection to DB2 Universal Database databases, you must use the "Manual"
method to define a connection to a DRDA database. Perform the following steps:

1 If the Client Configuration Assistant is not already running, start it: Click on Start
and select Programs ->DB2 for Windows 95 or Windows NT ->Client
Configuration Assistant . You are presented with a Welcome panel.

Note: The Welcome panel appears whenever you use the Client Configuration
Assistant and have no databases cataloged.

2 Click on the Add Database push button to configure connections using the Add
Database SmartGuide.

3 Select the Manually configure a connection to a DB2 database radio button,
then click on the Next push button.

4 Choose the protocol you want to use, either APPC or TCP/IP:
¢ If you want to use APPC:

a Select APPC as the protocol for the connection, then select the Target
Operating System for the host to which you want to connect. Click on
the Next push button.

b You need to enter a Symbolic destination name:

— If you have already defined a symbolic destination (also known as
the CPI-C side information), for the database to which you will be
connecting, type in the Symbolic destination name, then click on
the Configure push button.

— If the Configure push button is greyed and cannot be selected, it
means that the CCA cannot guide you through the process of
defining a symbolic destination name for your database, and you
will need to configure this manually. If your SNA product is one of
those described in this manual, go to those configuration
instructions now. (Refer to Chapter 11, “Configuring
Communications to Host and AS/400 Databases Manually” on
page 57 for a list of the SNA products that are described.)
Otherwise, you need to use the documentation supplied with your
SNA product to configure the CPI-C name (symbolic destination).
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When you have defined the symbolic destination for the database,
come back to this CCA page and type in the name. Then skip to
step 5.

C Select either the APPC (SNA) radio button or the APPC over TCP/IP
radio button, then click on the Next push button. You are presented
with two new pages.

d Fill in the fields on the This PC page and the Server page. (In most
situations you do not need to fill in values for the Session section.)
Click on the Done push button.

¢ If you want to use TCP/IP:

a Select TCP/IP as the protocol for the connection, then select the Target
Operating System for the host to which you want to connect.

b Click on the Next push button.

C Fillin the Hostname and Port Number fields. Optionally, fill in the
Service Name field. Click on the Next push button.

5 On the Target Database page, fill in the requested value, then click on the Next
push button.

6 Fillin values for the Alias page, and, if you want to run ODBC applications, the
ODBC page. Click on the Done push button to complete the definition.

7 Click on the Test Connection push button to test the connection to the specified
database.

8 Enter your user ID and password if needed to access the database and click on
the OK push button. If the connection is successful, a message confirming the
connection appears. If not, refer to the Troubleshooting Guide for possible
causes. You are now able to use the database.

9 It is strongly recommended that you bind DB2 utilities to the database you just
defined. To do this:

a Select the database to which you want to bind the utilities.
b Click on the Bind push button.

C Select whether you want to bind utilities or applications.

d Click on the Continue push button.
e

Enter a user ID and password to connect to the database. The user ID must
have the authority to bind new packages against the database.

f Select the utilities you want to bind and click on OK.

If you want to access another database, select the Add Another push button.
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Now that you have configured host connections, go to Chapter 19, “Configuring Your DB2
Connect Personal Edition to Access a Remote DB2 Server” on page 127 to configure access to
DB2 Universal Database servers (if required), or to Chapter 21, “Getting Started with the DB2
Universal Database” on page 135.
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Chapter 10. Changing Your MVS Password

You can use the Data Sources Setup tool (on Windows 3.1 or Windows for Workgroups
3.11) or the Client Configuration Assistant (on Windows 95, Windows NT, or OS/2) to
change your password on MVS hosts without logging on to the host system, provided
the MVS systems are running either:

e MVS/ESA SP Version 4.2 or higher
e CICS/ESA Version 3.3 or higher

and have IBM Resource Access Control Facility (RACF) 1.9.2 installed.

You need to:

1 Configure the host's transaction program to receive your requests for password
expiration maintenance.

2 Configure your DB2 Connect workstation for communications with the host
transaction program.

Configuring the Host for Password
Expiration Management

Setting up Password Expiration Management facilities on MVS hosts is the
responsibility of MVS system programmers and is beyond the scope of this book. The
following publications provide detailed documentation:

e MVS/ESA SP V5.x Planning: APPC Management, GC28-1503

¢ MVS/ESA SP V5.x APPC/MVS Handbook for the OS/2 Administrator, GC28-1504
e MVS/ESA SP V4.3 Planning: APPC Management, GC28-1110

e MVS/ESA SP V4.2 APPC/MVS Handbook for the OS/2 Administrator, GC28-1133
e CICS/ESA: RACF Security Guide (CICS 4.1), SC33-1185

e CICS/ESA: CICS-APPC Password Expiration Management Guide (CICS 3.3),
SC33-0921

e APPC Security MVS/ESA CICS/ESA 0S/2, GG24-3960.
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Configuring the DB2 Connect Workstation
for Password Expiration Management

How you configure your workstation for password expiration management depends on
the communications subsystem you are using:

e If you are using the Integrated SNA Support, or Communications Server for OS/2
or Communications Manager/2 on OS/2, the only information you need to provide
is the LU of the Password Expiration Management program on the host, which your
VTAM administrator can provide. Enter this as follows:

— On the CCA:

1 Select a database that resides on the host and that you access through
APPC.

The Password button appears.
2 Click the Password button.
3 Fill in the dialog box that appears, then click on OK.

4  Exit from the CCA.

— On the Data Sources Setup tool, select a database that resides on the host
and that you access through APPC. Next, enter the LU of the Password
Expiration Management program in the Password maintenance LU field on the
Server page of the Data Sources Setup tool notebook.

e If you are not using the Integrated SNA Support, Communications Server for OS/2
or Communications Manager/2, you need to define a CPI-C symbolic destination
name. Follow the instructions provided with your communications product
documentation. You will need to provide the following information (get the values
from your VTAM administrator). Enter the following:

— Network name

— LU name

You must use the following values as given:

— TP name: X'06'301. Some products, such as the CCA, require that you enter
this name in its hexadecimal representation: xX'06F3FOF1'

— Security: NONE

After you have defined the CPI-C symbolic destination name for Password
Expiration Management, enter it in the Data Sources Setup tool or the Client
Configuration Assistant.
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Part 4. Configuring Other Connectivity
Options
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Chapter 11.

Configuring Communications

to Host and AS/400 Databases Manually

This section describes how to configure manually the DB2 Connect workstation to use
the following SNA communications subsystems:

e |IBM Communications Server for OS/2 or Communications Manager for OS/2 (see
Chapter 12, “Configuring Communications Server for OS/2 for DB2 Connect for
0S/2” on page 59).

e DB2's integrated SNA (see Chapter 13, “Configuring Integrated SNA Support
Manually on Windows Workstations” on page 75).

e IBM Communications Server for NT (see Chapter 14, “Configuring IBM
Communications Server for Windows NT” on page 81).

¢ |IBM Communications Server for NT SNA Client (see Chapter 15, “Configuring IBM
Communications Server for Windows NT SNA Client” on page 93).

Microsoft SNA Server (see Chapter 16, “Configuring Microsoft SNA Server for DB2

Connect for Windows NT” on page 101).

Microsoft SNA Client (see Chapter 17, “Configuring Microsoft SNA Client” on

page 117).

You can find more information in the following publications:

* For more information about SNA Server for AlX, refer to the IBM SNA Server for
AlX User's Guide.

¢ For information on how to configure DRDA hosts for DB2 Connect, refer to:

Chapter 29, “Configuring DRDA Hosts for DB2 Connect” on page 223 in this
manual

The online DB2 Connectivity Supplement (which is installed with the DB2
Connect software)

The Distributed Relational Database Architecture Connectivity Guide,
SC26-4783.

The DB2 for OS/390 V5 Installation Guide, GC26-8970.
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Chapter 12. Configuring Communications
Server for OS/2 for DB2 Connect for OS/2

Most users will find it easiest to use the DB2 Client Configuration Assistant tool to configure
Communications Server for OS/2 or Communications Manager for OS/2, as described in
Chapter 9, “Configuring DRDA Host Connections on OS/2, Windows 95, or Windows NT
Workstations” on page 49. However, if you need to perform a manual configuration, read this
chapter.

This chapter tells you how to manually configure APPC communications between your
DB2 Connect for OS/2 workstation and DRDA servers. Before you begin, ensure that
your workstation has IBM Communications Server or Communications Manager for
0S/2 installed. (The steps in this section describe how to use Communications Server
Version 4. If you have Communications Manager for OS/2 V.1.x, the steps you perform
are similar, but the interface and menu names are different.) Note that in the examples
in this chapter, a Token Ring network is used as the communications medium.

Fill in the Worksheet

Before you configure the DB2 Connect workstation, have your host-side administrator
and LAN administrator fill in copies of the worksheets that follow for each host to which
you want to connect:

e For OS/390, MVS, VM, and VSE hosts, use Table 5 on page 60
e For AS/400, use Table 6 on page 62

To help you fill in the worksheets, Figure 6 illustrates a sample network that has DB2
Connect running on an OS/2 system and uses APPC to connect to DB2 for OS/390.
The values shown in this diagram correspond to the Sample Value entries in the
worksheet.

After you fill in the Your Value entries, you can use the worksheet to configure IBM
Communications Server. As you configure Communications Server, replace the sample
values that appear in the configuration instructions with your values from the worksheet.
Use the boxed numbers to relate the configuration instructions to the worksheet
values.

In the configuration instructions, the symbol denotes entries that need to be
changed but do not have a representation on the worksheet.
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Node Directory

| Node name DB2NODE
Symbolic dest name DB2CPIC
Security PROGRAM

System Database Directory
»DB alias NYC3
DB name DB2DB —
- Node DB2NODE
Authentication ‘ DCS

DCS Directory

Database DB2DB <+

Target DB name  NEW_YORK3

DB2 CONNECT TO NYC3

Local node characteristics NETID SPIFNET
Network ID SPIFNET APPL NYM2DB2 4
B NYX1
Local node name NYX1 - ] v
Local node ID 05D 27509 ‘ et
ocatnoce > DNUM= 27509
Mode definition IBMRDB
‘ L NYX1GW01
Local LU NYX1GWO01 »S5CP NYX
Connection to a host/ peer node MODEENT IBMRDB
LAN destination addr. 400009451902
Partner node name ~ NYX
Partner LUs NYM2DB2
CPI communications side information LOCADD=
»
» Symbolic dest.name ~ DB2CPIC L i
Qualified partner LU~ SPIFNET.NYM2DB2
Mode name IBMRDB
»OCATION NEW_YORK3 | DB2 for 0S390
LUNAME NYM2DB2

USER <USERID> USING <PASSWORD>
J

Figure 6. Configuration on the DRDA Server and DB2 Connect Workstation

Table 5 (Page 1 of 2). Worksheet for Planning OS/390, MVS, VM, or VSE Host Connections

Ref. | CS/2 Name VTAM Name Sample Value Your Value
Network Elements at the Host
Host Name Network name SPIFNET
2] Partner LU Name Application Name NYM2DB2
Network ID SPIFNET
4] Partner Node Name SSCP Name NYX
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Table 5 (Page 2 of 2). Worksheet for Planning OS/390, MV'S, VM, or VSE Host Connections

Ref. CS/2 Name VTAM Name Sample Value Your Value
a Database name 0S/390 or MVS: NEW_YORK3
Location
Name
VM/VSE: RDB_Name
6 | Mode Name IBMRDB
Network Connection Information
Connection name (Link LINKHOST
name)
8] LAN destination address 400009451902
Network Elements at the DB2 Connect Workstation
ﬂ Network ID or C&SM LAN SPIFNET
ID
Local Node name or Local NYX1
PU Name
(Local) LU name NYX1GWO01
(Local LU) alias NYX1GWO01
Local Node or Node ID ID BLK 05D
ID NUM 27509
Mode name IBMRDB
Symbolic Destination name DB2CPIC
(Remote) Transaction X'07F6C4C2'
program (TP) name (or RDB_NAME
for DB2 for VSE
& VM) (or
DB2DRDA for
DB2 for MVS or
0S/390)
DB2 Directory Entries (at the DB2 Connect workstation)
Node name db2node
Security program
El Database name db2db
Database alias nyc3

Notes:

1. The Local LU NYX1GWO01 should be the LU for the SPM. If you use the SPM with
this LU, you cannot use this LU to be the Control Point LU.

2. For a connection to an 0S/390, MVS, VSE, or VM system, you must know the
local node name of your machine. You can find this by reviewing the Local Node
Characteristics specification in your existing Communications Server configuration.
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Table 6. Worksheet for Planning OS/400 Connections

Ref. | CS/2 Name Network Name Sample Value Your Value

Network Elements at the Host

Host name Local Network ID SPIFNET

2] Partner LU Name Application Name NYM2DB2

Network 1D SPIFNET

4] Partner Node name Local CP Name SYD2101A

5] Database name Relational Database NEW_YORK3

Name

a Link Name or Mode IBMRDB
Name

Network Connection Information

Connection name (Link LINKHOST
name)

B Remote Network Local Adapter Address 400009451902
address

Network Elements at the DB2 Connect Workstation

9] Network ID or C&SM SPIFNET
LAN ID

Local Node Name or NYX1
Local PU Name

(Local) LU name NYX1GWO01

(Local LU) alias NYX1GWO01

Local Node or Node ID ID BLK 05D

ID NUM 27509

Mode name IBMRDB

Symbolic Destination DB2CPIC
name

(Remote) Transaction X'07F6C4C2'
program (TP) name

DB2 Directory Entries (at the DB2 Connect workstation)

Node name db2node

Security program

El Database name db2db

Database alias nyc3

Note:

for AS/400 system:

* To find the values for [, (known at the OS/400 as the local network ID),

 To find the value for ], (known at the OS/400 as the local adapter

You can determine some of the above values by running commands at the DB2

and for ], (the local control point name), enter: DSPNETA

address), enter: WRKLIND *TRLAN

Next, enter option 5 (Display ) at the _ when prompted:
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Opt Line Type Text
TRNLINE ~ *TRLAN

In the screen that appears one of the lines will be similar to this:
Local adapter address ........: 400009451902

To generate a list of mode names for ], enter: WRKMODD
To find the value for [, (known at the OS/400 as the relational database
name), enter: DSPRDBDIRE

Use the RDB name associated with the entry containing *LOCAL in the
Remote Location column. If no *LOCAL entry exists, either have one
created or use the Current System Name displayed when you run the
DSPNETA command. If the user profile under which the initial connect is
made has authority to run the ADDRBDIRE command, the *LOCAL entry
will be created automatically using that user profile's name on the connect
attempt.

Configuring APPC Using Communications

Server

Most users will find it easiest to use the DB2 Client Configuration Assistant tool to configure
Communications Server for OS/2 or Communications Manager for OS/2, as described in
Chapter 9, “Configuring DRDA Host Connections on OS/2, Windows 95, or Windows NT

Workstations” on page 49.

These instructions describe how to create new profiles within a new configuration. If
you are modifying an existing configuration, you may need to delete some profiles
before you can verify the configuration.

Begin to configure your DB2 Connect system with the following steps:

1

2
3
4

Double-click on the Communications Server icon.

Double-click on the Communications Manager Setup icon.

On the Communications Server Setup panel, click on the Setup push button.
On the Open Configuration panel:

a Specify the name of an existing configuration file if you have one, or provide

a name for a new file to be created.

b Click on the OK push button to proceed to the Communications Server

Configuration Definition panel.
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1 The Configuration Definition panel opens.
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a Select the Commonly used definitions  radio button.

b In the Communications Definitions window, select the protocol that you want
to use. These examples use APPC APIs over Token-Ring.

C Click on the Configure push button to proceed.

If this is a new configuration file, the next panel displayed will be the APPC
APIs over Token-Ring panel. Otherwise the next panel displayed will be the
Communications Server Profile List panel.

2 The APPC APIs over Token-Ring panel opens.

a Enter your values for:

» Network ID H
» Local node name

b Click on the End node push button that your network administrator advises
you to use.

You can select either the End node - to a network node server radio
button or the End node - no network node server radio button. A network
node server is used when many users are routed through the same
connection. The example here presumes no network node server is used.

C Click on the Advanced push button. The Communication Manager Profile
List window opens.
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Subsequent steps begin from this panel. You will return to this panel when each
step is complete.

Preparing the LAN DLC Profile

From the Communications Server Profile List panel, prepare a LAN DLC profile as
follows:

1 Select DLC - Token ring or other LAN types ->Configure .
2 Enter your value for Network ID or C&SM LAN ID. H

3 Check that the other values are appropriate for your environment. The values in
the example are default values.

4 Click on OK to return to the Communications Server Profile List panel.

Updating the SNA Local Node Characteristics

Update SNA Local Node Characteristics as follows:

1 On the Communications Server Profile List panel, select SNA local node
characteristics ->Configure . The Local Node Characteristic panel opens.
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Enter your value for Network ID ] .

3 The Local node name was probably set when Communications Server was
installed. If you are not sure, consult your local network administrator.

4 Enter your value for Local node ID (hex) and 3.

The first part should be filled in for you already when you display the profile.
You only need to complete the second part.

5 Click on the Options push button. The Local Node Options panel opens.
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a Verify that the Activate Attach Manager at startup  check box is selected.
b Click on OK to return to the Local Node Characteristics panel.

6 Click on OK to return to the Communications Server Profile List panel.

Preparing the SNA Connection Profiles

Prepare the SNA connection profiles as follows:

1 From the Communications Server Profile List panel, select SNA
Connections ->Configure .

2 On the Connections List panel for Partner Type , select either the To peer node
radio button (normally used for OS/400 connections), or the To host radio button
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(normally used for OS/390, MVS, VSE, and VM connections), and click on the
Create push button.

3 The Adapter List window opens.
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4 Select the Token-ring, or other LAN types adapter type, and specify the same
adapter number that you specified in the DLC profile.

5 Click on the Continue push button to proceed to the Connection to a Peer Node
panel or the Connection to a Host panel.

Connection to a Peer or Host Node

The Connection to a Peer Node or Connection to a Host Node windows opens.
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At the Connection to a Peer Node panel or the Connection to Host panel:

1

~N O O~ W

Specify the Link name value that you wrote in item of the worksheet.

On the Connection to Host panel, select Additional parameters
change the Local PU name field to your value for [ .

Change the node ID field to your values for and .
Change LAN destination address
Change Partner network ID field to your value for [{.

Change Partner node name field to your value for .

push button and

field to your value for FJ .

Select Define Partner LUs push button on either the Connection to a Peer Node

panel or the Connection to Host panel to proceed.

Partner LUs

Create a Partner LUs Profile as follows:

1
2
3

68

Enter your value for Network ID H .

Enter your value for LU name and Alias (use B for both).

Click on the Add push button to add the partner LU profile to the connection

profile.

Click on OK to return to the previous panel.

On the Connection to Host panel, click on the Additional Parameters

button. The Partner LU window opens
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Additional Connection Parameters

If you have selected to configure connections to a host, the following window appears.
Link name HOSTabd]
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1 Verify that the Multiple PU Parameters fields are filled in. This value is the Local
Node ID in hex, items and in the worksheet.

Local node ID 05D 27509
Click on OK to return to the Connection to a Host panel.
Click on OK to return to the Connections List panel.

Click on the Close push button to return to the Communications Server Profile
List panel.
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Setting the SNA Features

On the Communications Server Profile List panel, select SNA features ->Configure .
Subsequent steps begin from the SNA Features List panel that appears, as follows:
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Preparing a Local LU Profile

If the DB2 Connect workstation is defined as an independent LU, prepare a Local LU
Profile as follows. In most cases, a VTAM administrator on OS/390, MVS, VSE, or VM
would define an independent LU for DB2 Connect. For OS/400, the control point would
normally be used instead of an independent LU.

1

o 0o~ WN

On the SNA Features List panel, click on Local LUs ->Create.

Enter your value for LU name [HY.

Enter your value for alias .

For the NAU address box, select the Independent LU radio button.
Click on OK to return to the SNA Features List panel.

In order to use this local LU when the DB2 Connect workstation starts the APPC
connection, select the Use this local LU as your default local LU alias check
box. By default, all APPC connections that are started from this DB2 Connect
workstation will use this local LU.
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Verifying the Partner LU Profile

The partner LU profile was configured in a previous step. To verify, select the Partner
LU Profile option from the SNA Features List panel to see if a partner LU is defined.
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Preparing a Mode Definition

From the SNA Features List panel, prepare a Mode Definition as follows:

1 Select Modes->Create.
2 Define your mode profile as follows:

a Enter your value for mode name . It must also match item .
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b On the other lines, you can either specify values that match the mode
profile defined on your DRDA server systems, or tune the parameters.

3 Click on OK to finish the creation of the mode and to return to the SNA Features
List panel.

Creating the CPIC Side Information

On the SNA Features List panel, select CPI Communications Side
Information ->Create. The CPI Communications Side Information opens.
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Complete the CPlI Communications Side Information panel as follows:
1 Enter your value for Symbolic destination name .

2 Select the Alias radio button. Click on the Alias drop down box to view a list of
all defined aliases and choose the alias that corresponds to item [H].

3 Inthe Partner TP box, specify the remote Transaction Program (TP) name [ .

Select the None radio button as the Security type .

This does not mean that you will have no security, you will specify the
security type later when you update the DB2 directories.

Enter your value for the Mode name field [J.

Click on OK to save the CPI side information profile and return to the SNA
Features List panel.

6 Click on Close to return to the Communications Server Profile List panel.
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Save Your Configuration

You are now ready to save your Communications Server configuration file:

1 Click on Close to return to the Communications Server Configuration Definition
panel.

2 Click on Close to automatically verify and save the new configuration file, and
leave the configuration panels.

3 Stop and start Communications Server. Click on Stop Communications
Normally ->Start Communications

Update the DBZ2 Directories

To configure the DB2 directories, enter the following commands in the DB2 Connect
command line processor:

1 catalog the DRDA server as an APPC node. The syntax of the command is:
catalog appc node node_name remote sym_dest_name security program
For example:

catalog appc node DB2NODE remote DB2CPIC security program

2 Catalog the remote database as a Data Connection Services (DCS) database.
The syntax of the command is:

catalog dcs Database local dbname as real _host_dbname
For example:
catalog dcs Database NYC3 as NEW_YORK3
3 Catalog a database alias for the remote database. The syntax of the command is:
catalog db local_dbname as db_alias at node node_name authentication dcs
For example:
catalog db DB2DB as NYC3 at node DB2NODE authentication dcs

In the DB2 commands above:
e node_name can be any valid eight-character name
» sym_dest_name is the name of your Side Information Profile ().

e Jocal_dbname can be any valid eight-character name
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e db_alias can be any valid eight-character name

e real _host _dbname is the name of the database you want to connect to at the
DRDA server (H).

Test the Connection

Issue the following command from the command line processor window at the DB2
Connect server, remembering to substitute your db_alias value from the previous step:

connect to db_alias user userid using password

For example:

connect to nyc3 user userid using password

The user ID and password values required are those defined at the host or AS/400,
and must be provided to you by your DB2 Administrator.

Complete the Configuration

The steps you have just completed set up the DB2 Connect workstation to
communicate with the host. You must now bind the utilities and applications to the
DRDA server.

To bind the utilities and applications to the DRDA server, connect to the DRDA server
and use commands similar to the following:

connect to dbalias user userid using password

bind path@ddcsmvs.lst blocking all sqlerror continue

messages mvs.msg grant public
connect reset

These commands are described in detail in the DB2 Connect User's Guide.

Once you have completed these steps, see Chapter 21, “Getting Started with the DB2 Universal
Database” on page 135 for details on the many functions that are available to use with DB2.
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Chapter 13. Configuring Integrated SNA
Support Manually on Windows Workstations

Read this chapter if you have a Windows NT, Windows 95, or Windows 3.1 workstation
and you have installed the Integrated SNA Support option.

Although you should use the Data Sources Setup tool or the Client Configuration
Assistant wherever possible in order to configure communications with a host or AS/400
server, there are situations where the these tools will perform only a portion of the
required configuration (for example, to configure an SDLC or twinax connection). This
chapter describes how you manually configure an SNA connection between a DB2
Connect Personal Edition using Integrated SNA Support and a remote DRDA server in
such situations.

The example values used in this chapter are based on the scenario in Figure 6 on
page 60, except that Integrated SNA Support replaces Microsoft SNA Server as the
SNA subsystem at the DB2 Connect workstation.

Step 1. Start the APPC Configuration Ultility

1 To start the APPC configuration utility:

e For 32-bit Windows, run the config program. For example, if DB2 Connect
Personal Edition is installed in c:\sqllib, run:

c:\sql1ib\sna\system\config.exe

e For 16-bit Windows, From the Program Manager select File->Run. In the
command window, enter:

c:\sqlTib\win\sna\system\config.exe
The APPC Configuration Utility panel appears.
2 Enter the Network Name for the DB2 Connect Workstation.
3 Enter the Control Point Name for the DB2 Connect Workstation.
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Step 2. Add a Connection

=

From the Action Bar, select Add.
Select Connections .

3 From the Select a Connection pop-up menu, select the type of connection (for
example, Token Ring).

4 At the Token Ring Connection pop-up:
a Enter a Link Name .
b Assign values to the Options parameters:

N

1 Enter Block ID .

2 Enter Node ID (if provided by your VTAM or AS/400 administrator).
3 Enter Destination Address
4

Both the Local and the Remote SAP Addresses can default to 4.
You may need to change this at a later stage, for example if you are
using another SNA application and you get a message indicating that
the Service Access Point (SAP) address is not available, either to DB2
Connect or to the other application.

Select a choice from the Link Options .

Click on the Advanced button.

Confirm that the Adapter Selection is correct (usually the primary).
Leave the Link Parameters at the default value.

5 Click on OK.

- D 20

Step 3. Add a Mode

1 From the Action Bar, select Add.
2 Select the Mode button.
3 At the Configure Modes pop-up, set the values as shown in the example:

e On the Basic window, set the Mode name to be used (same as at the host of
AS/400 server).

e On the Limits window, set:
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Session limit 30
Automatic Activation Limit 0

Minimum Contention Winners 15

¢ On the Send window, set:

RU Length 4096

Pacing Count 0
¢ On the Receive window, set:

RU Length 4096

Pacing Count 0

Notes:

a. The RU Lengths given above assume a Token Ring LAN. For Ethernet, the
values must be no larger than 1517.

b. Check with your VTAM or AS/400 Administrator that the values you set are
compatible with those set at the host.

4 Click on OK.

Step 4. Add a Remote LU

1 From the Action Bar, select Add.
Select Remote LU .
3 At the Configure Remote LU's pop-up, enter:

¢ The LU Alias
¢ The LU Name

N

¢ The name of the Connection to be used.

e The Network Name .

4 Click on OK.
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Step 5. Add a Local LU

=

From the Action Bar, select Add.

Select Local LU .

3 At the Configure Local LU's pop-up, enter:
e The LU Alias

e The LU Name

N

N

Click on Advanced .
Ensure the LU Address is 00 (for an independent LU).
6 Click on OK.

ol

Step 6. Define Side Information

1 Access the Side Info panel:
e On a Windows 3.1 or Windows for Workgroups 3.11 system:
a From the Action Bar, select Sidelnfo .

b Select New.
C Click on Edit.

e On a Windows NT or Windows 95 system:

a From the Action Bar, select Add.
b Select Side Info .

N

Type in the SymDestName .

w

For Partner LU , select the Alias radio button, and the name you defined for the
Remote LU Alias.

For Local LU , select the name you defined for the Local LU name.
For Mode Name, select the name you defined.

For Security , select None.

For Partner TP Name , use:

e X'O7F6CA4C2' for DB2 for MVS/ESA or DB2 for AS/400. (You can also use
DB2DRDA for DB2 for OS/390 or DB2 for MVS.)

¢ The remote database name for DB2/VM or DB2/VSE (the default is
RDB_NAME. Ask your database administrator for the value you should use).

~N o oA~
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8 If the Partner TP Name is specified in Hex, select Hex TP Name.
9 If you want to review the options on the Advanced CPI-C Side Information panel:

a Click on the Advanced push button.
b Click on the Cancel push button.

10 Click on OK to save the Side Information profile.

Step 7. Save the Configuration

At the main Configuration Utility panel,

1 From the Action Bar, select File.
2 Select Save As.

3 Provide a name you will recognize later: for example, a name of the form
111111xx, where 111111 is the CP Name, and xx is an alphabetic or numeric
sequence, such as "AA" for the first, "BB" for the next, and so on.

4 Click on OK.

Step 8. Update the DBZ2 Directories

To configure the DB2 directories, enter the following commands in the DB2 Connect
command line processor:

1 catalog the DRDA server as an APPC node. The syntax of the command is:
catalog appc node node_name remote sym_dest_name security program
For example:
catalog appc node DB2NODE remote DB2CPIC security program

Note: The case of the sym_dest_name (DB2CPIC in this example) must match
the case of the SymDestName in the Side Information definition.

2 Catalog the remote database as a Data Connection Services (DCS) database.
The syntax of the command is:
catalog dcs Database local dbname as real host dbname
For example:
catalog dcs Database NYC3 as NEW_YORK3
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3 Catalog a Database alias for the remote database. The syntax of the command is:
catalog db local_dbname as Db_alias at node node_name authentication dcs
For example:

catalog db DB2DB as NYC3 at node DB2NODE authentication dcs

In the DB2 commands above:
e node_name can be any valid eight-character name
e sym dest_name is the name of your Side Information Profile.
e Jocal_dbname can be any valid eight-character name
e Db alias can be any valid eight-character name

e real_host_dbname is the name of the database you want to connect to at the
DRDA server.

Step 9. Test the Connection

Issue the following command from the command line processor window, remembering
to substitute your Db_alias value from the previous step:

connect to Db_alias user userid using password

For example:

connect to nyc3 user userid using password

The user ID and password values required are those defined at the host or AS/400,
and must be provided to you by your DB2 Administrator.
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Chapter 14. Configuring IBM
Communications Server for Windows NT

Read this chapter if you have a Windows NT workstation that has IBM Communications
Server for Windows NT installed.

Before you begin, ensure that the IBM Communications Server for Windows NT you
installed:
e Is Version 5.0 or higher

¢ Has the IBM Communications Server IEEE 802.2 LAN interface (this is an
installation option for Communications Server)

e Has the LLC2 driver installed from the IBM Communications Server installation
directory. To confirm this:
1 Click on the Start button, then select Settings ->Control Panel .

2 Double-click on the Network icon.

3 On the Network window, click on the Protocols tab. IBM LLC2 Protocol
must be one of the protocols listed. If it is not, you need to install this protocol
from your IBM Communications Server for Windows NT software. Refer to its
documentation for instructions.

Step 1. Fill In the Worksheet

Before you configure the DB2 Connect workstation, have your host-side administrator
and LAN administrator fill in copies of the following worksheet for each host to which
you want to connect (see Table 7 on page 83).

To help you fill in the worksheets, Figure 7 illustrates a sample network that has DB2
Connect using APPC to connect to DB2 for OS/390. The values shown in this diagram
correspond to the Sample Value entries in the worksheet.

After you fill in the Your Value entries, you can use the worksheet to configure IBM
Communications Server for Windows NT. As you perform the configuration, replace the
sample values that appear in the configuration instructions with your values from the
worksheet. Use the boxed numbers to relate the configuration instructions to the
worksheet values.
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Node Directory

| Node name DB2NODE
Symbolic dest name DB2CPIC
Security PROGRAM

System Database Directory
»DB alias NYC3
DB name DB2DB —
— Node DB2NODE
Authentication ‘ DCS

DCS Directory

Database DB2DB <+

Destination addr.

Partner LU name

Local node characteristics NETID SPIFNET
Network ID SPIFNET APPL NYM2DB2 4
PU NYX1
Local CP name NYX1 - ]
‘ > |DBLK= 05D
Local node ID 05D 27509 » IDNUM= 27509
Mode definition IBMRDB
J L NYX1GW01
Local LU name NYX1GW01 ———
MODEENT IBMRDB
LAN connection to a host

400009451902

NYM2DB2

Target DB name  NEW_YORK3

DB2 CONNECT TO NYC3

LOCADD=
CPI communications side information » 400009451902
i Symbolic dest. name DB2CPIC
Qualified partner LU~ SPIFNET.NYM2DB2
Mode name IBMRDB
»OCATION NEW_YORK3 | DB2 for 0S390
LUNAME NYM2DB2

USER <USERID> USING <PASSWORD>

Figure 7. Configuration on the DRDA Server and DB2 Connect Workstation

Figure 7 illustrates the correspondences between information specified on the DRDA
server system, information specified in Communications Server, and information

specified in DB2 directories. The values shown in the diagram are the example values
used in the instructions in this chapter.
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Table 7. Worksheet for Planning OS/390, MVS, VM, VSE, or OS/400 Connections

Ref.

SNA Server Admin
Name

VTAM Name

Sample Value

Your Value

Network Elements at the Host

Host Name Network name SPIFNET
2] Partner LU Name Application Name NYM2DB2
Network 1D SPIFNET
ﬂ Control Point Name 0S/390, MVS, VM, VSE: NYX

SSCP Name

0S/400: Local Control

Point Name
a Database name 0S/390 or MVS: NEW_YORK3

Location

Name

VM/VSE: RDB_Name
6| Mode Name IBMRDB
Link Station Name LINKHOST
Network Connection Information
8] | Destination address 400009451902
Network Elements at the DB2 Connect Workstation
9] Network Name SPIFNET
Local Control Point NYX1
Name
Local LU name NYX1GWO01
Local LU alias NYX1GWO01
Local Node ID Block ID 05D
Physical Unit ID 27509
Mode name IBMRDB
Symbolic Destination DB2CPIC
name

(Remote) Transaction X'07F6C4C2' (or

program (TP) name

RDB_NAME for
DB2 for VSE &
VM) (or
DB2DRDA for
DB2 for OS/390
or DB2 for MVS)

DB2 Directory Entries (at the DB2 Con

nect workstation)

Node name db2node
Security Program
El Database name db2db
Database alias nyc3
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Step 2. Configure the SNA Node

To start IBM Communications Server for NT, click on the Start button, then select
Programs ->IBM Communications Server ->SNA Node Configuration . The IBM
Communications Server SNA Node Configuration screen appears.

From the File button on the menu bar, select New->Advanced . The Configuration
options field appears.

To configure the DB2 Connect workstation, you need to configure the following
Configuration options

e “Configure Node” on page 85

e “Configure Devices” on page 86

e “Configure the Gateway” on page 86 (used with Communications Server for
Windows NT SNA Client only)

e “Configure Connections” on page 86

e “Configure Partner LU 6.2" on page 87

e “Configure Modes” on page 87

e “Configure Local LU 6.2” on page 88

e “Configure CPI-C Side Information” on page 88

After each step, you return to the window that has the Configuration options field.
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il Untitled - Communications Server SNA Node Configuration

File Scenaros Optionz  Help

— Configuration options:

(Confiqure HMode

Configure Devices

Configure the & ateway

Configure Connections

Configure DLUR PUs=

Configure Partrer LU 6.2 j

— Description:

Click. an the Mew button ta define the node. You can then view and
change itz parameters or delste it

— Mode:
| Mew...
wiew i Ehanmedsdd..
[lelete
Feady

Configure Node

To configure the node:

1 In the Configuration options

New

2 In the Fully qualified CP name fields, type in the network name [E] and the

local

3 Optionally, in the CP alias field, type in a CP alias. If you leave this blank the

local

4 In the Local Node ID fields, type in the block ID and the physical unit ID

Ensure that the End Node radio button is selected (this is the default).

Click

button. The Define the Node window appears.
control point name (SPIFNET.NYX1).
control point name will be used (NYX1).

(65D.27509).

on OK.
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Configure Devices

To configure the device:
In the Configuration options field, select Configure devices .

2 Ensure that in the DLCs field, the appropriate DLC is highlighted. For example,
LAN.

3 Click on the New button. The appropriate window appears with default values
displayed. For example, the Define a LAN device window.

4 Click on OK to accept the default values.

Configure the Gateway

You need to perform this step only if you are setting up Communications Server to
accept requests from Communications Server for Windows NT SNA Client, as
described in Chapter 15, “Configuring IBM Communications Server for Windows NT
SNA Client” on page 93. To configure the gateway:

1 In the Configuration options field, select Configure the Gateway , then click on
the New button. The Define Gateway window appears.

Click on the Select SNA Clients tab.

3 Ensure that there is a check mark in the Enable SNA API Client Services check
box.

4 Click on OK to accept the default values.

Configure Connections

To configure the connections:
In the Configuration options field, select Configure connections
Ensure that in the DLCs field, LAN is highlighted.

Click on the New button. The Define a LAN connection window appears.

A W N P

On the Basic tab panel:

a In the Link station name field, type in the name from the worksheet
(LINKHOST).

b In the Destination address field, type in the address [ from the
worksheet (400009451902).

5 On the Security tab panel:
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a In the Adjacent CP name fields, type in the network ID ] and the Control
Point name ] (SPIFNET.NYX).

b In the Adjacent CP type field, select Back-level LEN .
Ensure that TG number is set to 0 (the default).

Click on OK.

Configure Partner LU 6.2

To configure the partner LU:

1

In the Configuration options field, select Configure partner LU , then click on
the New button. The Define a partner LU 6.2 window appears.

In the Partner LU name fields, type in the network ID [E] and the partner LU
name B (SPIFNET.NYM2DB2).

In the Partner LU alias field, type in the partner LU name [ from the
worksheet (NYM2DB2).

If you are configuring Communications Server for SNA Clients, in the
Fully-qualified CP name fields, type in the network ID and the adjacent
control point SSCP name ] (SPIFNET.NYX).

Leave the other fields blank.

Click on OK.

Configure Modes

To configure the mode:

1

In the Configuration options field, select Configure modes , then click on the
New button. The Define a mode window appears.

In the Mode name field [J, type in the mode name (IBMRDB).

Click on the Advanced tab and ensure that the Class of Service Name is set to
#CONNECT.

Accept the defaults for the other fields.

Click on OK.
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Configure Local LU 6.2

To configure the local LU 6.2:

1

In the Configuration options field, select Configure local LU 6.2 , then click on
the New button. The Define a local LU 6.2 window appears.

In the Local LU name field, type in the name from the worksheet
(NYX1GWO1).

Type in a value for the LU session limit field. The default, 0, specifies the
maximum allowed value.

Accept the defaults for the other fields.

Click on OK.

Configure CPI-C Side Information

To configure the CPI-C side information:

88

1

In the Configuration options  field, select Configure CPI-C side information
then click on the New button. The Define CPI-C side information window appears.

In the Symbolic destination name field, type in the name from the
worksheet (DB2CPIC).

In the Mode name field, type in the name from the worksheet (IBMRDB).

Click on the radio button beside Use Partner LU alias and select a Partner LU
alias.

Specify the TP name. In the TP name field:

¢ To specify a non-service TP, in the TP name field, type in the name of the
non-service TP, for example DB2DRDA, and ensure that there is no check mark
in the Service TP check box.

e To specify a service TP, in the TP name field, type in the name of the
service TP, for example 076DB, and ensure that there is a check mark in the
Service TP check box.

Accept the defaults for the other fields.

Click on OK.
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Save the Configuration

To save the configuration:

1 From the File button on the menu bar, select Save As. The Save As window
appears.

Type in a file name, for example ny3.acg, then click on OK.

3 In the dialog box that appears, you are asked if you want this configuration to be
the default. Click on the Yes button.

You now need to update the DB2 directories, test the connection, and bind utilities and
applications to the server. The easiest way to do this is to use the CCA as described in

Chapter 9, “Configuring DRDA Host Connections on 0S/2, Windows 95, or Windows NT
Workstations” on page 49. However, you can also perform these steps manually as described in
the sections that follow.

Step 3. Update the DBZ2 Directories

To configure the DB2 directories, do the following at the DB2 Connect workstation:

1 catalog the DRDA server as an APPC node. The syntax of the command is:
catalog appc node node_name remote sym _dest _name security program
For example:
catalog appc node DB2NODE remote DB2CPIC security program
Note: The case of the sym_dest_name (DB2CPIC in this example) must match
the case of the Symbolic Destination Name in the CPI-C Symbolic
Destination Name Properties definition.
2 Catalog a database alias for the remote database. The syntax of the command is:
catalog db local _dbname as db_alias at node node_name authentication dcs
For example:
catalog db NYC3 as DB2DB at node DB2NODE authentication dcs
3 Catalog the remote database as a Data Connection Services (DCS) database.
The syntax of the command is:
catalog dcs db local_dbname as real_host_dbname
For example:
catalog dcs db NYC3 as NEW_YORK3
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In the DB2 commands above:
e node_name can be any valid eight-character name
» sym _dest_name is the name of your Side Information Profile ()
e Jocal_dbname can be any valid eight-character name
e db_alias can be any valid eight-character name

e real_host_dbname is the name of the database you want to connect to at the
DRDA server (H).

Step 4.

Test the Connection

Issue the following command from the command line processor window at the DB2
Connect server, remembering to substitute your db_alias value from the previous step:

connect to db_alias user userid using password

For example:

connect to nyc3 user userid using password

The user ID and password values required are those defined at the host or AS/400,
and must be provided to you by your DB2 Administrator.

Step 5.

Bind the Utilities and Applications

The steps you have just completed set up the DB2 Connect workstation to
communicate with the host. You must now bind the utilities and applications to the
DRDA server.

To bind the utilities and applications to the DRDA server, connect to the DRDA server
and use commands similar to the following:

connect to dbalias user userid using password

bind path@ddcsmvs.lst blocking all sqlerror continue
messages mvs.msg grant public

connect reset

These commands are described in detail in the DB2 Connect User's Guide.
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Once you have completed these steps, see Chapter 21, “Getting Started with the DB2 Universal
Database” on page 135 for details on the many functions that are available to use with DB2.
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Chapter 15. Configuring IBM
Communications Server for Windows NT
SNA Client

Read this chapter if you have a Windows NT workstation that has IBM Communications
Server for Windows NT SNA Client Version 5.0 or higher installed and you want to
connect to an IBM Communications Server for Windows NT server.

The Communications Server for Windows NT server and its SNA Client act as a split
client. This configuration requires that you have an APPC-enabled application (such as
DB2 Connect) running on the SNA Client workstation.

Note: The instructions in this chapter describe how to configure the SNA Client portion
of the split client. See Chapter 14, “Configuring IBM Communications Server for
Windows NT” on page 81 to configure the server portion of the split client.

The instructions in this chapter use a Windows NT client. The instructions for
other supported operating systems are similar; refer to your Communications
Server for Windows NT documentation for more information.

Step 1.

Fill In the Worksheet

Before you configure the DB2 Connect workstation, have your host-side administrator
and LAN administrator fill in copies of the following worksheet for each host to which
you want to connect (see Table 8 on page 94).

After you fill in the Your Value entries, you can use the worksheet to configure IBM
Communications Server for Windows NT SNA Client. As you perform the configuration,
replace the sample values that appear in the configuration instructions with your values
from the worksheet. Use the boxed numbers [ to relate the configuration instructions
to the worksheet values.
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Table 8. Worksheet for Planning SNA Client Connections to Communications Server/NT

Ref. | SNA Client Name

Sample Value

Your Value

Network Elements at the Host

Host Name SPIFNET

2] Partner LU Name NYM2DB2

Network 1D SPIFNET

4] Control Point Name NYX

5] Database name NEW_YORK3

6| Mode Name IBMRDB

Link Station Name LINKHOST

Network Connection Information

8] | Destination address 400009451902

Network Elements at the DB2 Connect Workstation

9] Network Name SPIFNET

Local Control Point Name NYX1

Local LU name NYX1GWO01

Local LU alias NYX1GWO01

Block ID 05D

Physical Unit ID 27509

Mode name IBMRDB

Symbolic Destination DB2CPIC

name
(Remote) Transaction X'07F6C4C2" (or
program (TP) name RDB_NAME for

DB2 for VSE &
VM) (or DB2DRDA
for DB2 for
0S/390 or DB2 for
MVS)

DB2 Directory Entries (at the DB2 Connect workstation)

Node name db2node

Security Program

El | Database name db2db

Database alias nyc3

Elements at the Communications Server

E3 | User name CSNTUS1

E | Password i

E3 | P address 123.123.123.123
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Step 2. Create a User Name on the
Communications Server for Windows NT

Server

On the Communications Server for Windows NT server, you need to create a user
name that permits the SNA client to access the server. To create a user name:

1

Click on the Start button, then select Programs ->Administrative Tools
(Common) ->User Manager . The User Manager window appears.

On the User Manager's menu bar, select Users->New User. The New User
window appears.

Type in values for the following fields:

User Name CSNTUS1

Full Name CSI/NT Client 1
Description optional
Password ikl

Confirm Password Sk kkkkkk

Click on the Groups button. The Group Memberships window appears. By
default, the user name you are defining is a member of only the Users group.

Make your new user name a member of each of the following groups by selecting
the group name, then clicking on the Add button:

¢ The Administrators group
e The IBMCSADMIN group
e The IBMCSAPI group.

Click on OK.

Step 3. Configure the SNA Client

To configure the IBM Communications Server for Windows NT SNA Client, at the client
workstation click on the Start button, then select Programs ->IBM Communications
Server SNA Client ->Configuration . The Configuration File (*.ini) — CS/NT SNA Client
Configuration window appears.

To configure the client workstation, you need to configure the following options:
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e “Configure Global Data” on page 96

e “Configure APPC Server List” on page 97

¢ “Configure CPI-C Side Information” on page 97
e “Configure Transaction Programs” on page 97

After each step, you return to the CS/NT SNA Client Configuration window.
#! Configuration File [*.ini] - CS5/NT SNA Client Configuration !EIE

File “iew Help

— Configuration Optians:

i Conhigure Global [ ata
Configure APPC Server List
Configure CPI-C Side Information
Configure Tranzaction Programs
Configure LA Seszions
Configure EHMAPPC

— Dezcrption:

Click on the Mew button to define the Uzer D, pazzword and Tranzlation
table name. vou can then view and change ite parameters or delete it

— Global Data:

| Mew...

e dEhangessdd

[Ielete

Ready ] |

Configure Global Data

To configure the global data:

1 In the Configuration options field, select Configure Global Data , then click on
the New button. The Define Global Data window appears.

2 In the User name field, type in the name ] from the worksheet (CSNTUS1). This
is the user name that was defined in “Step 2. Create a User Name on the
Communications Server for Windows NT Server” on page 95.
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3 In the Password and Confirm Password fields, type in the password that
was defined in “Step 2. Create a User Name on the Communications Server for
Windows NT Server” on page 95.

4 Click on OK.

Configure APPC Server List

To configure the APPC Server list:

1 In the Configuration options field, select Configure APPC Server List , then
click on the New button. The Define APPC Server list window appears.

Type in the IP address I of the server (123.123.123.123).

Click on OK.

Configure CPI-C Side Information

To configure the CPI-C side information:

1 In the Configuration options field, select Configure CPI-C side information
then click on the New button. The Define CPI-C side information window appears.

2 In the Symbolic destination name field, type in the name from the
worksheet (DB2CPIC).

3 Inthe Local LU alias field, type in the name [ from the worksheet (NYX1GWO1).

Note: Ensure that this Transaction Program has a check mark in the For SNA
API Client use check box.

In the Mode name field, type in the name [ from the worksheet (IBMRDB).
In the TP name field, type in the name from the worksheet (DB2DRDA).

In the Partner LU name field, type in the network ID [E] and the partner LU
name [ from the worksheet (SPIFNET.NYM2DB2), or type in the Partner LU alias .

7 Click on OK.

Configure Transaction Programs

To configure a transaction program:

1 In the Configuration options field, select Configure Transaction Programs
then click on the New button. The Define a Transaction Program window appears.
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2 In the Transaction Program field, type in the name from the worksheet
(DB2DRDA).

In the Local LU alias field, type in from the worksheet (NYX1GWO1).

If the Transaction Program you specified is a service TP, ensure that there is a
check mark in the Service TP check box. The example TP DB2DRDA is not a
service TP.

Ensure that there is no check mark in the Attach Manager started check box.

Click on OK.

Save the Configuration

To save the configuration:

1 From the File button on the menu bar, select Save As. The Save As window
appears.

2 Type in a file name, then click on Save.

Step 4. Update the DBZ2 Directories

To configure the DB2 directories, do the following at the SNA client workstation:

1 catalog the DRDA server as an APPC node. The syntax of the command is:
catalog appc node node_name remote sym_dest_name security program
For example:
catalog appc node DB2NODE remote DB2CPIC security program

Note: The case of the sym_dest_name (DB2CPIC in this example) must match
the case of the Symbolic Destination Name in the CPI-C Symbolic
Destination Name Properties definition.

2 Catalog a database alias for the remote database. The syntax of the command is:
catalog db local_dbname as db_alias at node node_name authentication dcs

For example:

catalog db NYC3 as DB2DB at node DB2NODE authentication dcs
3 Catalog the remote database as a Data Connection Services (DCS) database.
The syntax of the command is:

catalog dcs db local dbname as real _host_dbname
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For example:
catalog dcs db NYC3 as NEW_YORK3

In the DB2 commands above:
e node_name can be any valid eight-character name
* sym_dest_name is the name of your Side Information Profile ().
e Jocal_dbname can be any valid eight-character name
e db_alias can be any valid eight-character name

e real_host_dbname is the name of the database you want to connect to at the
DRDA server (B).

You now need to update the DB2 directories, test the connection, and bind utilities and
applications to the server. The easiest way to do this is to use the CCA as described in

Chapter 8, “Configuring Host Connections on Windows 3.1 or 3.11 Workstations” on page 45 or
Chapter 9, “Configuring DRDA Host Connections on OS/2, Windows 95, or Windows NT
Workstations” on page 49. However, you can also perform these steps manually as described in
the sections that follow.

Step 5. Test the Connection

Issue the following command from the command line processor window at the SNA
Client, remembering to substitute your db_alias value from the previous step:

connect to db_alias user userid using password

For example:

connect to nyc3 user CSNTUS1 using password

The user ID and password values required are those defined at the host or AS/400,
and must be provided to you by your DB2 Administrator.
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Step 6. Bind the Ultilities and Applications

The steps you have just completed set up the DB2 Connect workstation to
communicate with the host. You must now bind the utilities and applications to the
DRDA server.

To bind the utilities and applications to the DRDA server, connect to the DRDA server
and use commands similar to the following:

connect to dbalias user userid using password

bind path@ddcsmvs.lst blocking all sqlerror continue
messages mvs.msg grant public

connect reset

These commands are described in detail in the DB2 Connect User's Guide.

Once you have completed these steps, see Chapter 21, “Getting Started with the DB2 Universal
Database” on page 135 for details on the many functions that are available to use with DB2.
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Chapter 16. Configuring Microsoft SNA
Server for DB2 Connect for Windows NT

Read this chapter if you have a Windows NT workstation that has Microsoft SNA
Server installed. Before you begin, ensure that your Microsoft SNA Server is Version
2.11 or higher.

Step 1.

Fill In the Worksheet

Before you configure the DB2 Connect workstation, have your host-side administrator
and LAN administrator fill in copies of the following worksheet for each host to which
you want to connect (see Table 9 on page 102).

To help you fill in the worksheets, Figure 6 illustrates a sample network that has DB2
Connect running on an OS/2 system and uses APPC to connect to DB2 for OS/390.
The values shown in this diagram correspond to the Sample Value entries in the
worksheet.

After you fill in the Your Value entries, you can use the worksheet to configure IBM
Communications Server. As you configure Communications Server, replace the sample
values that appear in the configuration instructions with your values from the worksheet.
Use the boxed numbers to relate the configuration instructions to the worksheet
values.

In the configuration instructions, the symbol denotes entries that need to be
changed but do not have a representation on the worksheet.
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Table 9. Worksheet for Planning OS/390, MVS, VM, VSE, or OS/400 Connections

Ref.

SNA Server Admin
Name

VTAM Name

Sample Value

Your Value

Network Elements at the Host

program (TP) name

Host Name Network name SPIFNET
2] Remote LU Name Application Name NYM2DB2
Network ID SPIFNET
ﬂ Control Point Name 0S/390, MVS, VM, VSE: NYX
SSCP Name
0OS/400: Local Control
Point Name
a Database name 0S/390 or MVS: NEW_YORK3
Location
Name
VM/VSE: RDB_Name
6| Mode Name IBMRDB
Connection Name LINKHOST
Network Connection Information
8] Remote Network 400009451902
address
Network Elements at the DB2 Connect Workstation
9] Network Name SPIFNET
Local Control Point NYX1
Name
(Local) LU name NYX1GWO01
(Local) LU alias NYX1GWO01
Local Node ID ID BLK 05D
ID NUM 27509
Mode name IBMRDB
Symbolic Destination DB2CPIC
name
(Remote) Transaction X'07F6C4C2" (or

RDB_NAME for
DB2 for VSE &
VM) (or
DB2DRDA for
DB2 for OS/390
or DB2 for MVS)

DB2 Directory Entries (at the DB2 Con

nect workstation)

Node name db2node

Security Program

El Database name db2db

Database alias nyc3
For an OS/390, MVS, VSE, or VM connection, you need the control point name of your
DB2 Connect workstation. Your network administrator can provide you with this
information.
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Figure 6 on page 60 illustrates the correspondences between information specified on
the DRDA server system, information specified in SNA Server Administration, and
information specified in DB2 directories. The values shown in the diagram are the
example values used in the instructions in this chapter.

Step 2. Define SNA Properties

The DB2 Connect workstation needs the following SNA information:

e Server properties
e APPC local LU properties
e APPC mode properties

To begin, perform the following steps:
1 Click on the Start push button, and select Program ->SNA

2 Double-click on the SNA Server Admin icon. The SNA Server Admin window
opens.

By default, the Servers and Connections window opens. If it does not,
double-click on the Servers and Connections icon.

Setting Server Properties

To specify parameters for an SNA Server that will be used for LU 6.2 (APPC), do the
following:

1 In the Servers and Connections window, select the server (named SERVER in the
example).

2 Select Services ->Properties . The Server Properties window opens.
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= Seiver Properties
Server Name: SERVER
Service Name: SNASERVR
Version: 2.11
Comment

— SNA Network Control Point Name
Network Name: SPIFNET
Control Point Name: NYX1

Status: INACTIVE

Active Users: 0 3270 Sessions: 0

Active Sessions: 0 APPC Sessions: 0
LUA Sessions: 0

3 Enter the values you filled in on Table 9 on page 102 as follows:

Network Name 9]
Control Point Name

Setting APPC Local LU Properties

To assign a local APPC LU to the Server, perform the following steps:
1 In the Servers and Connections window, select the server.

2 Select Services ->Assign LUs . The Insert LU window opens.
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3

X = Enable Automatic Partnering
X = Member of Default Outgoing Local APPC LU Pool
Implicit Incoming Remote LU: (None)

Timeout for Starting Invokable TPs: 60 seconds

=1 New APPC LU Properties

LU 6.2 Type

(®) Independent

() Dependent
LU Alias: NYXIGWOL
Network Name: SPIFNET
LU Name: NYX1GWO01
LU Number:
Comment:

|«

In the Insert LU window, select APPC (Local) .

4 Click on OK. The New APPC LU Properties window opens.

X = Enable Automatic Partnering
X = Member of Default Outgoing Local APPC LU Pool
Implicit Incoming Remote LU: (None)

Timeout for Starting Invokable TPs: 60 seconds

= New ARPPC LU Properties

LU 6.2 Type

(® Independent

() Dependent
LU Alias: NYXIGWOL |
Network Name:  SPIFNET
LU Name: NYX1GWO01
LU Number:
Comment:

|
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5 Make sure that the Independent radio button is selected.

Enter the values you entered in on Table 9 on page 102 as follows:

LU Alias
Network Name 9]
LU Name

Select the Enable Automatic Partnering check box, if it is not already selected.

Select the Member of Default Outgoing Local APPC LU Pool  check box, if it is
not already selected.

9 Click on OK. The new LU is added to the window.

Setting APPC Mode Properties

You can use an IBM-defined mode, or add a new mode that is appropriate for the
application. Ensure that the values match between your client and server.

To configure a mode for the APPC LU, perform the following steps:

1 In the Servers and Connections window, select the local LU with which the mode
will be associated.

2 Click on Services ->Properties .

Based on whether the LU is local or remote, either the APPC LU Properties
window or the New APPC LU Properties window opens.
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=1 New APPC LU Properties

LU 6.2 Type

(®) Independent

() Dependent
LU Alias: NYXIGWOL
Network Name: SPIFNET
LU Name: NYX1GWO01
LU Number:
Comment:

X = Enable Automatic Partnering
X = Member of Default Outgoing Local APPC LU Pool
Implicit Incoming Remote LU: (None)

|«

Timeout for Starting Invokable TPs: 60 seconds

3 Click on the Partners... push button. The LU 6.2 Partner LUs window opens.

4 Click on the Modes... push button. The APPC Mode Properties window opens.

= APPC Mode Propeities

Mode Name: |IBMRDB
Comment: Add...

Parallel Session Limit 30
Minimum Contention Winner Limit: 15
Partner Min Contention Winner Limit: 0

Automatic Activation Limit:
X Enable Automatic Partnering

High Priority Mode

Pacing Send Count: 7 Max Send RU Size: 4096
Pacing Receive Count: 7 Max Receive RU Size: 4096

5 Use the following suggested value:
Mode Name IBMRDB

6 Select the Enable Automatic Partnering  check box, if it is not already selected.
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7 Ensure that the High Priority Mode check box is not selected; if it is, clear the
check box.

The rest of the values in our example are arbitrary. The values for items
such as Parallel Session Limit and Minimum Contention Winner Limit

are for tuning purposes. See the online help for SNA Server for guidance on
setting these values.

Click on the Add push button to add the mode.

Click on the Close push buttons until you return to the APPC LU Properties
window.

10 cClick on the Cancel push button to return to the Servers and Connections
window.

Step 3. Define Server Connection Properties

The DB2 Connect workstation needs the following information about each server
connection that you want to use:

e Connection properties
e APPC remote LU properties
¢ CPI-C symbolic destination name properties

Setting Connection Properties

To configure settings for a new connection, do the following:
In the Servers and Connections window, select the server that you want.
Select Services ->New Connection . The Insert Connection window opens.

3 In the Insert Connection window, select the type of connection you want. Our
example uses 802.2. See the online help for information on the other available
choices.

4 Click on OK. The Connection Properties window opens.
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= Connection Properties

Connection Name:

LINKHOST
Comment
LnkSewvice: < SnaDlcl
Remote End  Activaon | - Allowed Directions
(@) Host System () On Server Setup Outgoing Calls
() Peersystem  (® OnDemand ‘Incoming Calls
O Downstream O By Administrator

Use the following values:

Connection Name ~ LINKHOST

Link Service SnaD1cl
Remote End Peer System radio button
Activation On Demand radio button

Allowed Directions Outgoing Calls  check box.

5 The following is an example of an 0S/390, MVS, VM, or VSE connection:

= Connection Properties

Connection Name:

LINKHOST
Comment
Link Service: ©sSnaDlcl | ¥
Remote End —  Activation —— | Allowed Directions
@ Host System O On Server Setup Outgoing Calls
() Peer System (® On Demand Incoming Calls
O Downstream O By Administrator

Use the following values:
For a connection to OS/390, MVS, VM, or VSE:
Connection Name ~ LINKHOST ()

Link Service SnaDl1cl
Remote End Host system radio button
Activation On Demand radio button

Allowed Directions Outgoing Calls  check box.
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Note: The Link Service Name may be None unless the link was added from the

MS SNA setup icon.
For a connection to OS/400:
Connection Name ~ LINKHOST

Link Service SnaDlcl
Remote End Peer System radio button
Activation On Demand radio button

Allowed Directions Outgoing Calls  check box.

6 Click on the Setup push button.
The 802.2 Setup window opens.

7 Use the following values:
Remote Network Address 400009451902 H

Local Node ID 05D 27509 plus E4
Network Name SPIFNET
Control Point Name NYX

The window would appear as follows:

= 802.2 Setup

Remote Network Address: | OK |
400009451902 | [ cancel |
~ Local Node Name ~ Retry Timers |
Local Node ID: 05D | 27509 | [ Advanced>> |

- Remote Node Name |

Help

Network Name: ' SPIFNET |

Control Point Name: NYX
Remote Node ID: | |

8 Use the following values:
¢ For a connection to 0S/390, MVS, VM or VSE, use:

Remote Network Address 400009451902 (H)
Network Name SPIFNET
Control Point Name N\O 4 |

The window would appear as follows:
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= 802.2 Setup

Remote Node ID:

Remote Network Address: | OK |
400009451902 | " Cancel |
-~ Local Node Name ‘ Retry Timers ‘

Local Node ID: 05D | 27509 | [ Advanced>> |
- Remote Node Name | Help |

Network Name: SPIFNET |

Control Point Name: NYX |

e For a connection to OS/400:

Remote Network Address
Local Node ID

Network Name

Control Point Name

400009451902 B

05D 27509 plus A

SPIFNET

SYD2101A (the LU name of the AS/400)

In this case, the window would appear as follows:

= 802.2 Setup

Remote Node ID:

Remote Network Address: | OK |
400009451902 [ cancel |
— Local Node Name ‘ Retry Timers ‘

Local Node ID: 05D | 27509 [ Aoenes |
- Remote Node Name ~ Help |

Network Name: SPIFNET |

Control Point Name: SYD2101A |

9 Click on OK to save your work and return to the Connection Properties window.

10 Click on OK.
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Setting APPC Remote LU Properties

To assign a remote APPC LU to a connection do the following:
In the Servers and Connections window, select the connection that you want.

2 Select Services ->Assign LUs .

The Insert LU window opens.
3 In the Insert LU window, select APPC Remote .
Click on OK. The New APPC Remote LU Properties window opens.

Fill in the values for your system. For example.

LU Alias NYM2DB2
Network name SPIFNET
Remote LU name NyM20B2 H

6 Make sure the Supports Parallel Sessions and the Enable Automatic
Partnering check boxes are selected.

The window would appear as follows:

= New APRPC Remote LU Properties

LU Alias: ' NYM2DB2 N OK |

Ol Network Name: SPIFNET |  Cancel

LU Name: 'NYM2DB2 |  Pariners.. |
Uninterpreted LU Name: |
Comment: |

Supports Parallel Sessions
Enable Automatic Partnering

Implicit Incoming Mode: ~ (None) H

7 Click on OK.

Setting CPI-C Symbolic Destination Name
Properties

To configure the properties for CPI-C, do the following:

1 Select Options ->CPI-C. The Configure CPI-C Names window opens.
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2 Click on the Add push button. The CPI-C Symbolic Destination Name Properties
window opens.

CPI-C Symbolic Destination Name Properties

Name: DB2CPIC OK

Comment: Cancel
Partner TP Name
O Application TP:
(® SNA Service TP (in hex): | o7F6C4C2

Help

Partner LU Name

O Alias:

@ Fully Qualified: | SPIFNET NYM2DB2
Conversation Security Mode Name:

@® None IBMRDB v
() Same

(O Program User ID

3 Use the values that you recorded on your worksheet. For example:

Name DB2CPIC 16 ]

SNA Service TP 07F6C4C2

Fully Qualified SPIFNET.NYM2DB2

Mode Name IBMRDB

Conversation Security By default, None is selected. You will specify the

conversation security type later.
Click on OK to save your work and return to the Connection Properties window.

Click on the Close push button to close the Configure CPI-C Names window and
return to the Servers and Connections window.

Step 4. Update the DBZ2 Directories

To configure the DB2 directories, do the following at the DB2 Connect workstation:

1 catalog the DRDA server as an APPC node. The syntax of the command is:
catalog appc node node_name remote sym_dest name security program

For example:

Chapter 16. Configuring Microsoft SNA Server for DB2 Connect for Windows NT 113



catalog appc node DB2NODE remote DB2CPIC security program

Note: The case of the sym_dest name (DB2CPIC in this example) must match
the case of the Symbolic Destination Name in the CPI-C Symbolic
Destination Name Properties definition.

2 Catalog the remote database as a Data Connection Services (DCS) database.
The syntax of the command is:

catalog dcs db local_dbname as real_host_dbname
For example:
catalog dcs db NYC3 as NEW_YORK3
3 Catalog a Database alias for the remote database. The syntax of the command is:
catalog db local dbname as Db_alias at node node_name authentication dcs
For example:
catalog db DB2DB as NYC3 at node DB2NODE authentication dcs

In the DB2 commands above:
e node_name can be any valid eight-character name
» sym_dest_name is the name of your Side Information Profile ().
e Jocal_dbname can be any valid eight-character name
e Db _alias can be any valid eight-character name

e real_host_dbname is the name of the database you want to connect to at the
DRDA server (H).

Step 5. Test the Connection

Issue the following command from the command line processor window at the DB2
Connect server, remembering to substitute your Db_alias value from the previous step:

connect to Db_alias user userid using password

For example:

connect to nyc3 user userid using password

The user ID and password values required are those defined at the host or AS/400,
and must be provided to you by your DB2 Administrator.
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Step 6. Bind the Ultilities and Applications

The steps you have just completed set up the DB2 Connect workstation to
communicate with the host. You must now bind the utilities and applications to the
DRDA server.

To bind the utilities and applications to the DRDA server, connect to the DRDA server
and use commands similar to the following:

connect to dbalias user userid using password

bind path@ddcsmvs.lst blocking all sqlerror continue
messages mvs.msg grant public

connect reset

These commands are described in detail in the DB2 Connect User's Guide.

Once you have completed these steps, see Chapter 21, “Getting Started with the DB2 Universal
Database” on page 135 for details on the many functions that are available to use with DB2.
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Chapter 17. Configuring Microsoft SNA
Client

Read this chapter if you have a Windows 3.1, Windows NT or Windows 95 workstation
that has DB2 Connect installed. This chapter provides step-by-step instructions for
setting up the communications between your DB2 Connect workstation and a Windows
NT workstation that has Microsoft SNA Server V2.11 (or later) installed.

Figure 8 on page 118 illustrates the example DB2 Connect Server scenario.

Assumptions

The rest of this chapter assumes:

1 The Microsoft SNA Server has already been configured for APPC
communications with the host, and is enabled for ODBC and DRDA. Refer to the
Microsoft SNA Server documentation for further information.

2 Microsoft SNA Client Version 2.11 is not already installed on your DB2 Connect
workstation.

Step 1. Obtain Required Information

For your Microsoft SNA client software to function properly you must have access to a
properly-configured Microsoft SNA Server. Request that your SNA Server administrator:

1 Obtain the proper license for you to use Microsoft SNA Client on your workstation.
2 Define a user ID for you on the SNA Server domain.

3 Define connections to the host and AS/400 databases that you need to access,
as described in Chapter 16, “Configuring Microsoft SNA Server for DB2 Connect
for Windows NT” on page 101.

4 Provide you with the symbolic destination name to use for each database
connection defined in the previous step.
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* Requires DB2 for OS/390 V5.1.
** For AS/400 only.

*** For host connections only.

Windows NT with
Microsoft SNA Server

DB2 Connect Personal Edition
with Microsoft SNA Client

Figure 8. DB2 Connect Server Scenario Using DB2 Connect, MS SNA Client, and MS SNA Server

If you plan to change host passwords, the SNA administrator will also need to
provide you with symbolic destination names for password management tasks on
each host. See Chapter 10, “Changing Your MVS Password” on page 53 for
more information on changing host passwords.

Your host or AS/400 database administrator will need to:

1 Define a user ID and password on the host or AS/400 security system for you to
use.

2 Make sure that your user ID is granted proper access to database objects that
you will be working with.

3 Provide you with the database name:

118 DB2 Connect Personal Edition Quick Beginnings



Location name on DB2/MVS or DB2 for OS/390
RDB on AS/400
DBNAME on DB2 for VM/VSE (SQL/DS)

Step 2. Install SNA Client on the DB2
Connect Workstation

1 Obtain the Microsoft SNA Client software, and follow the instructions provided
with it to start the installation program. For example, if you are installing from a
Microsoft SNA Server V2.11 CD-ROM, you will need to execute setup.exe in the
sna/clients/win3x subdirectory to install on a Windows 3.1 or Windows for
Workgroups 3.11 workstation.

2 Follow the instructions on the screen to complete the installation. Choose your
SNA Server domain name and communication protocol according to the
instructions provided by your SNA Server administrator.

3 When you reach the Optional Components panel deselect Install ODBC/DRDA
driver so that it will not be installed.

Step 3. Install DB2 Connect for Windows

1 |Install DB2 Connect Personal Edition, without selecting DB2 Connect Integrated
SNA Support.

When the installation is completed, reboot.

Open the DB2 Folder, and click on the Client Configuration Assistant  (or, on
Windows 3.1, the Data Sources Setup tool) to start the configuration dialog.

4 You need to provide the following information:

a The Symbolic Destination Name defined at the Microsoft SNA Server for the
Partner LU of the target DRDA host. This is on the example worksheet
for this configuration (Table 10 on page 120), and [ on the worksheet
provided for use with SNA Server (Table 9 on page 102).

b The real database name, for example the DB2 for 0S/390 or DB2 for
MVS/ESA “LOCATION NAME.” This is on both worksheets.
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Table 10. Example Worksheet for Microsoft SNA Client Users

No. | Description Sample Value Your Value

User Information

User Name A.D.B.User
2] Contact Info (123)-456-7890
Location

MS SNA Server Information (provided by SNA Server administrator)

MS SNA Server domain name ACCOUNTS

4] Protocol used for communicating with SNA NetBEUI
Server (TCP/IP, NetBEUI, IPX/SPX)

5] User ID used to login to the MS SNA Server ADBUSER
domain

6| Password used to login to the MS SNA XXXXXXX
Server domain

Database CPI-C symbolic destination name DB2CPIC
(defined to MS SNA Server).

8] Password management CPI-C symbolic DB2PEM

destination name

Database Information (provided by host or AS/400 administrator)

a Alias NYC3

Description New York DB
#3

Database Type DB2 for
MVS/ESA or
DB2 for
0S/390

Host database name NEW_YORK3

User ID assigned to you on your host or ADBUSER

AS/400 system

Password to be used to connect to your host XXXXXXXX
or AS/400 system

Update the DBZ2 Directories

To configure the DB2 directories, enter the following commands in the command line
processor:

1 catalog the DRDA server as an APPC node. The syntax of the command is:
catalog appc node node_name remote sym dest name security program
For example:
catalog appc node DB2NODE remote DB2CPIC security program

Note: The case of the sym_dest_name (DB2CPIC in this example) must match
the case of the Symbolic Destination Name that you defined when you
installed MS Client.
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2 Catalog the remote database as a Data Connection Services (DCS) database.
The syntax of the command is:

catalog dcs db local_dbname as real_host_dbname
For example:
catalog dcs db NYC3 as NEW_YORK3
3 Catalog a Database alias for the remote database. The syntax of the command is:
catalog db local_dbname as Db_alias at node node_name authentication dcs
For example:
catalog db DB2DB as NYC3 at node DB2NODE authentication dcs

In the DB2 commands above:
e node_name can be any valid eight-character name
e sym dest_name is the name of your Side Information Profile.
e Jocal_dbname can be any valid eight-character name
e Db_alias can be any valid eight-character name

e real_host _dbname is the name of the database you want to connect to at the
DRDA server.

Test the Connection

Issue the following command from the command line processor window, remembering
to substitute your Db_alias value from the previous step:

connect to Db_alias user userid using password

For example:

connect to nyc3 user userid using password

The user ID and password values required are those defined at the host or AS/400,
and must be provided to you by your DB2 Administrator.
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Chapter 18. Setting up Two-phase Commit
using TCP/IP

This chapter tells you how to set up two-phase commit using TCP/IP connections
between DB2 Connect Personal Edition Version 5 and DB2 for OS/390 Version 5.1.

Overview

If your application programs have been pre-compiled with both the CONNECT 2 and
SYNCPOINT TWOPHASE options, you can use DB2 Connect Personal Edition to
update multiple DB2 for OS/390 Version 5.1 databases over TCP/IP connections using
two-phase commit.

Note: For ODBC applications, use the ODBC Manager to set the DSN two-phase
option ON for the database.

Any TCP/IP connection between your two-phase commit application and a DB2 for
0S/390 Version 5.1 database can also participate with DB2 Universal Database
Version 5 database servers in the same transaction.

Additionally, when using DB2 Connect Personal Edition Version 5, DB2 for OS/390
Version 5.1 can act as the TM_DATABASE for the entire two-phase commit transaction
providing that all the databases participating in the unit of work are either:

e DB2 Universal Database Version 5.0 (Workgroup Edition or Enterprise Edition
only), or

¢ DB2 for OS/390 Version 5.1.

You can set the TM_DATABASE database manager configuration parameter using the
following CLP command:

update dbm cfg using tm_database 1ST_CONN

What to Do

Follow these steps:

1 Choose your setting for TM_DATABASE. We recommend 1ST_CONN, especially
if the first database connected to will be a DB2 for OS/390 Version 5.1 database.
Set TM_DATABASE as indicated above.
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2 Ensure that those databases to be updated by your DUOW transaction over
TCP/IP connections will be accessible READ-WRITE if required. See “Limitations
on page 124.

3 CLP users must turn off autocommit and use the following set client command
prior issuing connect commands:

set db2options=+c
set client connect 2 syncpoint twophase

Limitations

The following limitations apply when using two-phase commit with DB2 Connect
Personal Edition Version 5.0:

e |f DB2 for OS/390 owns the TM_DATABASE, then DB2 Connect Personal Edition
must specify 1ST_CONN for TM_DATABASE.

e DB2 for OS/390 Version 5.1 cannot act as a TM_DATABASE if any of the
databases participating in the transaction is either:

— DB2 Common Server Version 2.1 or earlier
— DB2 for MVS/ESA Version 3.1 or earlier.
e You can mix connections to different database levels, including
— DB2 for OS/390 Version 5.1 over TCP/IP
— DB2 Common Server Version 2.1
— DB2 Universal Database Version 5.0 databases

To do so, you must use a DB2 Universal Database Version 5 client, and DB2
Universal Database Version 5.0 must provide the TM_DATABASE for the
transaction. When using DB2 Connect Personal Edition this database must be
remote.

¢ All database connections must be TCP/IP.
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Part 5. Configuring Access to DB2
Universal Database Servers

© Copyright IBM Corp. 1993, 1997 125



126 DB2 Connect Personal Edition Quick Beginnings



Chapter 19. Configuring Your DB2 Connect
Personal Edition to Access a Remote DB2
Server

Use the information in this section to use the Client Configuration Assistant to configure OS/2,
Windows 95, and Windows NT workstations to access remote DB2 Universal Database servers.

To configure communications to remote DB2 Universal Database servers without using the Client
Configuration Assistant, refer to the online Installing and Configuring DB2 Clients manual located
in x:\\doc\language\htmI\db2iyx50.htm, where x is the letter that designates your CD-ROM and
language is the two-character country code that represents your language (for example, EN for
English). For more information on country codes, see Table 16 on page 256.

Use the Client Configuration Assistant to configure your OS/2, Windows 95, or
Windows NT client workstation to access remote DB2 Universal Database servers. The
Client Configuration Assistant provides three configuration methods: one makes use of
a server's access profile, one searches the network for databases, and the other
requires that you enter the database name and the communication protocol values of
the DB2 server.

Perform the following steps to configure your workstation to access remote servers:

1 start the Client Configuration Assistant (CCA).

For OS/2:
Double-click on the Client Configuration Assistant  icon, located in the DB2 for

0S/2 folder.

For Windows 95 or Windows NT:

Click on Start and select Programs ->DB2 for Windows ->Client Configuration
Assistant .

The Welcome panel opens each time you start the CCA, until you have added at
least one database to your client.

2 Click on the Add Database or Add push button to configure connections using
the Add Database SmartGuide. Choose one of the following configuration
methods:

e |If your administrator provided you with a file containing database access
information, select the Use an access profile radio button and click on the
Next push button.

a Click on the Browse push button to select an access profile, or enter
the path and name of the file in the File field.
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b Youare presented with a list of systems, instances, and databases.
Select the database that you want to use and proceed to Step 3.

e If you want to search the network for databases, select the Search the
network radio button and click on the Next push button.

The Other Systems (Search the network) icon will only appear if the
client's discover parameter is set to SEARCH.

a Click on the [+] sign beside the Known Systems icon to list all the
systems known to your workstation.

b Click on the [+] sign beside the system to get a list of the instances and
databases on it. Select the database that you want to add and proceed
to Step 3.

C If the system that contains the database that you want is not listed,
click on the [+] sign beside the Other Systems (Search the network)
icon to search the network for additional systems. Click on the [+] sign
beside the system to get a list of the instances and databases on it.
Select the database that you want to add and proceed to Step 3.

d If the system you want is still not listed, it can be added to the list of
systems by clicking on the Add Systems push button. Enter the
required communication protocol parameters and click on the Next
push button. For more information, click on the Help push button.

Select the database that you want to add and proceed to Step 3.

e If you have the protocol information for the database that you want to connect
to, select the Manually configure a connection to a DB2 database radio
button and click on the Next push button.

a Select the radio button that corresponds to the protocol that you want to
use from the Protocol list. Click on the Next push button.

b Enter the required communication protocol parameters and click on the
Next push button. For more information, click on the Help push button.

C Specify the name of the database that you want to connect to in the
Target database field and proceed to Step 3.

3 To specify the database alias name or to add a description, click on the Next
push button. If you do not specify a database alias name, the default will be the
same as the database name.

4 1f you want to run ODBC-enabled applications, click on the Next push button. If
you do not plan to use ODBC, click on the Done push button to finish using the
Add Database SmartGuide and proceed to Step 6.
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5 If you are using ODBC applications, select the Register this database for ODBC
check box, select the radio button that describes the type of data source that you
want to register this database as, and select the application that you want to use
from the Application drop down box. Click on the Done push button to finish
using the Add Database SmartGuide.

6 The Confirmation window opens. Click on the Test Connection push button to
test the connection to the specified database.

7 Enter your user ID and password to access the database and click on OK. If the
connection is successful, a message confirming the connection appears. If the
connection fails, click on the Help push button for more information. If you require
additional information, refer to the Troubleshooting Guide.

8 You are now able to use the database. If you want to access another database,
select the Add Another push button. To finish using the Add Database
SmartGuide, click on the Close push button.
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Part 6. Using DBZ2 Universal Database
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Chapter 20. Sending Accounting
Information to a DB2 for OS/390 Server

Many mainframe customers consider detailed accounting for resources used by
different applications to be an important part of their operational procedures. DB2 for
0S/390 provides extensive facilities for producing accounting reports that allow
information systems departments to charge individual user departments for the
mainframe resources they use. This is often called "charge-back accounting." DB2
Connect products allow for accurate accounting for the host resources used by the PC
and UNIX applications using existing accounting reports and procedures.

DB2 Connect implements this feature in a flexible way by providing:

¢ A default accounting string for all usage generated by a particular DB2 Connect
Enterprise Edition server.

¢ Two mechanisms for individual users or applications to specify the account to
which their usage should be charged.

Setting the Accounting String

The default accounting string is set by the DB2 Connect workstation's dft_account_str
configuration parameter. This default mechanism is useful for database clients that do
not have the capability to forward an accounting string to DB2 Connect (for example,
applications developed prior to Version 2 products). See the DB2 Connect User's
Guide for additional information on accounting strings.

There are two ways for client applications to override the default accounting string set
at the DB2 Connect server:

¢ Using the Set Accounting String API: sglesact()

The SQLESACT() APl is called before the application connects to a database.
You should use this method because:

— Calling an API does not incur the cost of reading a registry value.

— You do not need to call this API again unless you want to use a new
accounting string for future connect requests. If you are using the registry
value, you need to end the application process, redefine DB2ACCOUNT, and
then restart the process.

Refer to the API Reference for details on using this API.
¢ Using the DB2ACCOUNT registry value at the client workstation.

© Copyright IBM Corp. 1993, 1997 133



If the sqglesact() API is not called prior to the first database connect request, the
DB2ACCOUNT registry value is read. The accounting string is used for all
subsequent database connect requests. See Chapter 24, “Controlling Your DB2
Environment” on page 157 for information on setting registry values.

Note: When defining the accounting string, you should observe the following rules:

1. Use the characters A-Z, 0-9, or '_' (underscore).
2. Limit the accounting string to 199 bytes—longer strings are truncated.
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Chapter 21. Getting Started with the DB2
Universal Database

This section describes how to use the DB2 Universal Database in a variety of ways.

Go to the section that gives instructions for the tasks that you want to perform.

e “Logging on to the System.”

e “Connecting to a Database” on page 136.

e “Changing Default Privileges for Users” on page 137.
e “Software Registration” on page 139.

e “Upgrading from a Try-and-Buy License” on page 139.

Logging on to the System

To use DB2, log on with a valid user ID that has the appropriate authority level for the
commands you want to execute. If the SYSADM_GROUP parameter is defined in the
database manager configuration file, the user performing administration tasks (such as
cataloging, starting the database manger, or creating the sample database) must
belong to the System Administrative group. The SYSADM_GROUP parameter is not set
when DB?2 is first installed; therefore, the following criteria are used to determine
SYSADM authority:

0S/2 A valid DB2 user ID which belongs to the UPM Administrator or Local
Administrator group.

Windows 95  Any Windows 95 user.

Windows NT A valid DB2 username which belongs to Administrators group.

You can override this default case by explicitly providing a group name for
the SYSADM_GROUP parameter. If you do this, the only way to assign
SYSADM authority is by membership to this group.

See “Changing Default Privileges for Users” on page 137 for more
information

See Appendix C, “Naming Rules” on page 265 for a list of restrictions on valid
usernames.
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To log in from OS/2 locally, use UPM.

Note: If you are using OS/2 Warp Version 4, OS/2 Warp Connect, or OS/2 Warp
Server, an administrative user ID was created during installation. Use this user
ID to perform the steps that require administrative authority or to create
additional users with the correct authority. Previous versions of OS/2 are initially
set up with a default user ID (USERID) and password (PASSWORD). Try
logging on with the defaults if you are unsure of any other administrative user
on your system.

As well as using the local operating system security to authenticate users, there is also
the option of using DCE security. Refer to the Administration Guide for information on
DCE security.

Connecting to a Database

You need to connect to the database before you can use SQL statements to query or
update it. The CONNECT statement associates a database connection with a user ID.

A database is created in an instance using one of three different authentication types:
CLIENT, SERVER, or DCS. If an authentication type is not specified when the instance
is created, the default SERVER authentication is used. You connect to a database
differently depending on the authentication type and where the database resides.

Connecting to a local database
To connect to a local database called SAMPLE, type the following command in the
Command Center or the command line processor:

connect to sample
Connecting to a remote database

e To connect a client to a database called SAMPLE, using SERVER authentication,
type the following command in the Command Center or the command line
processor:

connect to sample user userid using password

(Be sure to choose values for userid and password that are valid on the server
system.)

e To connect a client to a database called SAMPLE, using CLIENT authentication, type
the following command in the Command Center or the command line processor:

connect to sample
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If you are connecting to the database from an OS/2 system, and are not
currently logged on, you will be prompted to log on using a user ID and
password.

If you are connecting to a database, from a Windows NT client using
CLIENT authentication and you are providing a user ID and password on
the CONNECT command, you must start the DB2 for Windows NT Security
Service on the system. The Security Service is installed by DB2 and set up
as a Windows NT service; however, it is not started automatically.

To start the DB2 Security Service, double-click on the Services icon in the
Control Panel folder. Select the DB2 Security Server option and click on
the Start push button.

When a successful connection is made, a message similar to the following is displayed:

Database product = DB2/NT 5.0.0
SQL authorization ID = USERID
Local database alias = SAMPLE

If you receive an error message, make sure that the SAMPLE database exists on the
server and the database manager was started on the server.

For more information on authentication, refer to the Administration Guide.

Changing Default Privileges for Users

By default, System Administrative (SYSADM) privileges are granted to the following:

0s/2 A valid DB2 user ID which belongs to the UPM Administrator or Local
Administrator group.

Windows 95  Any Windows 95 user.
Windows NT A valid DB2 username which belongs to Administrators group.
You can change the users who have administrator privileges for each DB2 instance by

changing the SYSADM_GROUP parameter; but before you do, ensure that the group
exists. To check to see if this group exists, do the following:

e Use the Windows NT User Manager Administrative Tool.

e Use a UPM administrator user ID to create groups and assign membership. For
information on using UPM, see Chapter 25, “Administering and Using OS/2 User
Profile Management on OS/2 Systems” on page 169.

To use another group as the System Administrative group (SYSADM_GROUP), update
the database manager configuration file.
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The SYSADM_GROUP parameter is not used for the Windows 95 operating
system.

e To change the System Administrative group (SYSADM_GROUP) on the server
instance:

1 Start the Control Center.

2 Click on the [+] sign beside the Systems icon to list all the systems known to
your workstation.

3 Click on the [+] sign for the system that contains the instance you want to
update.

4 Select the instance that you want to change the SYSADM_GROUP
parameter for and click on the right mouse button.

Select the Configure option.
Select the Administration tab.

Select the System Administration Authority Group parameter and enter the
name of an existing group that you want to assign this privilege to in the
Value box.

Click on OK.

Stop and Start the database instance.

e To change the System Administrative group (SYSADM_GROUP) on the client
instance:

1 start the Client Configuration Assistant (CCA).
2 Click on the Client Settings push button.

3 Select the Administration tab.
4

Select the parameter you want to change and enter the name of an existing
group that you want to assign this privilege to in the Value box.

Click on OK.

Stop all applications that are using DB2, including the CCA. When restarted
they will be using the new value for SYSADM_GROUP.
e Using the command line processor:

To change the System Administrative group (SYSADM_GROUP) parameter to
dbadmin on the server instance, use:

update dbm cfg using SYSADM_GROUP dbadmin
db2stop
db2start
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To change the System Administrative group (SYSADM_GROUP) parameter to
dbadmin on the client instance, use:

update dbm cfg using SYSADM_GROUP dbadmin
terminate

Stop all applications that are using DB2. When restarted they will be using the new
value for SYSADM_GROUP.

Software Registration

The Registration icon, located in the DB2 folder, is used to access and update the IBM
Software Customer Profile and to register IBM Software with IBM. The customer profile
contains identification and demographic information about the user of each IBM
software product. The IBM software registration contains the information and the
instructions on how to register IBM software by modem, telephone, Internet, FAX, or
postal service.

Upgrading from a Try-and-Buy License

To upgrade your DB2 product from a demonstration license to a product license, you
simply need to copy the license file from the DB2 CD-ROM to the system where DB2 is
installed; you do not need to reinstall the product.

Note: Your Proof of Entittement  and License Information booklets identify the
products for which you are licensed.

The following steps describe how to upgrade the license:

If you have purchased a product, other than the one that you have installed
from the Try-and-Buy CD-ROM, you must first uninstall this product and
install the one you have purchased. The install program will automatically
install the required license.

1 Put the product CD-ROM in the CD-ROM drive.

2 Double-click on the Nodelock Administration Tool icon in the License Use
Runtime - Client folder to start the Nodelock Administration Tool.

Select Products ->New from the menu bar.

Click on the Import push button.
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5 In the Import window, locate the db2\license directory on your CD-ROM. A list of
files is shown.

6 Select the license file that corresponds to the specific product that you have
purchased and installed on your system:

db2conpr.lic DB2 Connect Personal Edition

7 Click on OK.
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Chapter 22. Running Your Own
Applications

Various types of applications can access DB2 databases:

¢ Applications developed using the DB2 SDK that include embedded SQL, APIs,
stored procedures, user-defined functions or calls to the DB2 CLI.

e ODBC applications such as Lotus Approach.
e JDBC applications and applets.
¢ Net.Data macros containing HTML and SQL.
An application on a DB2 client can access a remote database without knowing its

physical location. The DB2 client determines the location of the database, manages the
transmission of the requests to the database server, and returns the results.

In general, to run a database client application, use the following steps:

1 Ensure the server is configured and running.

Be sure that the database manager is started on the database server to which the
application program is connecting. If it is not, you must issue the db2start
command at the server before starting the application.

Ensure that you can connect to the database that the application uses.

3 Bind the utilities and the applications to the database. See Binding Database
Utilities for information about binding the utilities.

4 Run the application program.

Binding Database Utilities

You must bind the database utilities (import, export, reorg, the command line processor,
and DB2 CLI) to each database before they can be used with that database. In a
network environment, if you are using multiple clients that run on different operating
systems or are at different versions of DB2, you must bind the utilities once for each
operating system/DB2-version combination.

Binding a utility creates a package, which is an object that includes all of the
information that is needed to process specific SQL statements from a single source file.
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The bind files are grouped together in different .1st files in the bnd directory under the
installation directory (typically sqllib\win on Windows 3.1 systems and sqllib for OS/2,
Windows 95 and Windows NT operating systems). Each file is specific to a server.

Binding to Host Databases

To bind the utilities and applications to the DRDA server, connect to the DRDA server
and use commands similar to the following:

connect to dbalias user userid using password

bind path@ddcsmvs.lst blocking all sqlerror continue
messages mvs.msg grant public

connect reset

These commands are described in detail in the DB2 Connect User's Guide.

Binding to DB2 Universal Databases

How you bind the database utilities to a database depends on your workstation's
operating system:

e On 0S/2, Windows 95, and Windows NT operating systems, you can use the
Client Configuration Assistant:

1 start the Client Configuration Assistant (CCA).

Select the database to which you want to bind the utilities.
Click on the Bind push button.

Select the Bind DB2 Utilities radio button.

Click on the Continue push button.

o 01~ WN

Enter a user ID and password to connect to the database. The user ID must
have the authority to bind new packages against the database.

7 Select the utilities you want to bind and click on OK.

e On all operating systems, you can use the command line processor:

1 cChange to the bnd directory, which is x:\sgllib\bnd, where x: is the drive
where you installed DB2.

2 Connect to the database using the command:
connect to database_alias

where database_alias is the name of the database to which you want to
connect.

3 Issue the following commands in the Command Center or the command line
processor:
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"bind @db2ubind.lst messages bind.msg grant public"
"bind @db2c1i.Tst messages clibind.msg grant public"

In this example, bind.msg and c1ibind.msg are the output message files, and
EXECUTE and BIND privileges are granted to public.

4 Reset the connection to the database by issuing the following command:
connect reset
For more information on the bind command, refer to the Command
Reference.
Notes:

1. The db2ubind.Ist file contains the list of bind (.bnd) files required to create the
packages for the database utilities. The db2cli.Ist file contains the list of bind (.bnd)
files required to create packages for the DB2 CLI and the DB2 ODBC driver.

2. Binding may take a few minutes to complete.

If the applications that you are using require binding to the database, you
can use the Client Configuration Assistant's Bind facility, or the command
line processor, to perform the bind action.

Running CLI/ODBC Programs

The DB2 Call Level Interface (CLI) run-time environment and the ODBC driver are
included with the DB2 Client Application Enabler. This is contained on the DB2 Client
Pack CD-ROM or can be downloaded from the Web page at
http://www.software.ibm.com/data/db2.

This support enables applications developed using ODBC and DB2 CLI APIs to work
with any DB2 server. DB2 CLI application development support is provided by the DB2
Software Developer's Kit (DB2 SDK) which is part of the separately orderable DB2
Application Development Kit product.

Before DB2 CLI or ODBC applications can access DB2, the DB2 CLI packages must
be bound on the server. Although this will occur automatically on the first connection if
the user has the required authority to bind the packages, it is recommended that the
administrator do this first with each version of the client on each platform that will
access the server. See “Binding Database Utilities” on page 141 for specific details.

The following general steps are required on the client system to give DB2 CLI and

ODBC applications access to DB2 databases. These instructions assume that you have
successfully connected to DB2 using a valid user ID and password. Depending on the
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platform many of these steps are automatic. For complete details, see the section that
deals specifically with your platform.

1 Use the CCA to add the remote system (if you have separate client and server
machines) so that its instances and databases can be made known to the Control
Center, then add the instances and databases for that system. (Your local system
is represented by the icon labelled Local .) If you do not have access to this
program you can use the catalog command in the command line processor.

2 On all platforms other than OS/2 and Windows 3.1, the DB2 CLI/ODBC driver is
automatically installed when the DB2 Client Application Enabler is installed, and
therefore nothing needs to be done. On OS/2 and Windows 3.1 you must use the
Install ODBC Driver icon to install both the DB2 CLI/ODBC driver and the ODBC
driver manager.

3 To access the DB2 database from ODBC:

a The Microsoft, Visigenic, or other ODBC Driver Manager must already be
installed (this is done by default during the installation of DB2).

b The DB2 databases must be registered as ODBC data sources. The ODBC
driver manager does not read the DB2 catalog information; instead it
references its own list of data sources.

C If a DB2 table does not have a unique index then many ODBC applications
will open it as read-only. Create a unique index for each DB2 table that is to
be updated by an ODBC application. Refer to the CREATE INDEX
statement in the SQL Reference. Using the Control Center you would alter
the settings of the table, then click on the Primary Key tab and move one
or more columns from the available columns list over to the primary key
columns list. Any column you select as part of the primary key must be
defined as NOT NULL.

4 Vvarious CLI/ODBC Configuration Keywords can be set to modify the behavior of
DB2 CLI/ODBC and the applications using it.

5 If you followed the above steps to install ODBC support, and added DB2
databases as ODBC data sources, your ODBC applications will now be able to
access them.

Platform Specific Details for CLI/ODBC Access

The platform specific details on how to give DB2 CLI and ODBC applications access to DB2 are
divided into the following categories:

¢ “Windows 3.1, Windows 95 and Windows NT Client Access to DB2 using CLI/ODBC” on
page 145
e “0OS/2 Client Access to DB2 using CLI/ODBC” on page 147
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Windows 3.1, Windows 95 and Windows NT
Client Access to DB2 using CLI/ODBC

Before DB2 CLI and ODBC applications can successfully access a DB2 database from
a Windows 3.1, Windows 95, or Windows NT client, perform the following steps on the
client system:

1 The DB2 database (and node if the database is remote) must be cataloged. To
do so, use the CCA (or the command line processor). See “Configuring Database
Connections” on page 210 for more details.

For more information refer to the on-line help in the CCA (or the catalog
command in the Command Reference).

2 Verify that the Microsoft ODBC Driver Manager and the DB2 CLI/ODBC driver are
installed. On Windows 95 and Windows NT they are both installed with DB2
unless the ODBC component is manually unselected during the install. On
Windows 3.1 you must use the Install ODBC Driver icon to install the Microsoft
ODBC Driver Manager and the DB2 CLI/ODBC driver.

To verify that they both exist on the machine:

a Run the Microsoft ODBC Administrator from the icon in the Control Panel,
or issue the appropriate command from the command line: odbcad32.exe
for Windows 95 or Windows NT operating systems, odbcadm.exe on
Windows 3.1.

b Click on the Drivers push button, or the ODBC Drivers tab (depending on
the platform).
C Verify that "IBM DB2 ODBC Driver" is shown in the list.

If either the Microsoft ODBC Driver Manager or the IBM DB2 CLI/ODBC driver is
not installed, then rerun the DB2 install and select the ODBC component in
Windows 95 or Windows NT, or double-click on the Install ODBC Driver icon in
the DB2 program group in Windows 3.1.

3 Register the DB2 database with the ODBC driver manager as a data source. On
Windows 95 and Windows NT you can make the data source available to all
users of the system (a system data source), or only the current user (a user data
source). Use either of these methods to add the data source:

e Using the CCA:
a Select the DB2 database alias that you want to add as a data source.

b Click on the Properties push button. The Database Properties window
opens.

Select the Register this database for ODBC check box.

On Windows 95 and Windows NT you can use the radio buttons to add
the data source as either a user or system data source.
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e Using the Microsoft 32bit ODBC Administration tool , which you can access
from the icon in the Control Panel or by running odbcad32.exe from the
command line:

a On Windows 95 and Windows NT the list of user data sources appears
by default. If you want to add a system data source click on the
System DSN button, or the System DSN tab (depending on the
platform).

b Click on the Add push button.
C Double-click on the IBM DB2 ODBC Driver in the list.

d Select the DB2 database to add and click on OK.

e On Windows 95 and Windows NT there is a command that can be issued in
the command line processor to register the DB2 database with the ODBC
driver manager as a data source. An administrator could create a command
line processor script to register the required databases. This script could then
be run on all of the machines that require access to the DB2 databases
through ODBC.

See the
CATALOG [ user | system ] ODBC DATA SOURCE

command in the Command Reference for more information.
4 Optional: Configure the DB2 CLI/ODBC driver using the CCA:
a Select the DB2 database alias you want to configure.

b Click on the Properties push button. The Database Properties window
opens.

Click on the Settings push button. The CLI/ODBC Settings window opens.

d Click on the Advanced push button. You can set the configuration
keywords in the window that opens. These keywords are associated with
the database alias name, and affect all DB2 CLI/ODBC applications that
access the database. The online help explains all of the keywords, as does
an appendix in the Installing and Configuring DB2 Clients manual.

5 Optional: Using 16-bit ODBC applications:

Although not directly related to DB2, some users have experienced problems
when running 16-bit ODBC applications on Windows 95 or Windows NT.

Both 16- and 32-bit applications use the same 32-bit IBM DB2 CLI/ODBC Driver.
The Microsoft ODBC Driver Manager takes care of the conversion between the
16-bit application and the 32-bit ODBC driver.

Some 16-bit applications were shipped with an old set of 16-bit Driver Manager
DLLs (that is, before 1995). These DLLs do not function well in the 32-bit
environment. The following symptoms may occur when running the old DLLs:
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e Traps occur in odbc.dll or other ODBC related DLLs.
e 16-bit applications do not see data sources cataloged using the 32-bit ODBC
Administrator (from the Control Panel).

If (and only if) you are experiencing these problems you may want to update the
Microsoft 16-bit ODBC Driver Manager DLLs. These files are provided with DB2
in the SQLLIB\MSODBC16 subdirectory. Use these new DLLs to replace the older
versions that are located in the system subdirectory of the Windows operating
system directory.

6 If you have installed ODBC access (as described above), you can now access
DB2 data using ODBC applications. Start the ODBC application and go to the
Open window. Select the ODBC databases file type. The DB2 databases that
you added as ODBC data sources will be selectable from the list. Many ODBC
applications will open the table as read-only unless a unique index exists.

OS/2 Client Access to DB2 using CLI/ODBC

Before DB2 CLI and ODBC applications can successfully access a DB2 database from
an OS/2 client, perform the following steps on the client system:

1 The DB2 database (and node if the database is remote) must be cataloged. To
do so, use the CCA (or the command line processor).

For more information see the on-line help in the CCA or “Configuring Database
Connections” on page 210.

2 If you are using ODBC applications to access DB2 data, perform the following
steps. (If you are using only CLI applications, skip this step and go to the next
step.)

a Check that the ODBC Driver Manager (Visigenic or Intersolv) and the DB2
CLI/ODBC driver are installed:

1 Run the ODBC Administration tool in one of two ways:

¢ Double-click on the Control Panel icon from the Main Folder in
WIN-OS/2 or the ODBC Folder in OS/2, and double-click on the
ODBC Administrator icon.

¢ Run odbcadm.exe from the command line.

The Data Sources window opens.
2 Click on the Drivers push button. The Drivers window opens.

3 Verify that "IBM DB2 ODBC Driver" is shown in the list.

If either the ODBC Driver Manager or the IBM DB2 CLI/ODBC driver is not
installed then double-click on the Install ODBC Driver icon in the DB2
folder to install both the DB2 CLI/ODBC driver and the ODBC driver
manager.
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b Register the DB2 database with the ODBC driver manager as a data source
using either of these methods:

¢ Using the CCA:

1 Select the DB2 database alias that you want to add as a data
source.

2 Click on the Properties push button.

3 Select the Register this database for ODBC check box.

¢ Using the Visigenic ODBC Administration tool , which you can access
from the ODBC folder or by running odbcadm.exe from the command
line:

1 Click on the Add push button from the Data Sources window. The
Add Data Source Window opens.

2 Double-click on the IBM DB2 ODBC Driver in the list.
3 Select the DB2 database to add and click on OK.
3 Optional: Configure the DB2 CLI/ODBC driver using the CCA:
a Select the DB2 database alias you want to configure.

b Click on the Properties push button. The Database Properties window
opens.

C Click on the Settings push button. The CLI/ODBC Settings window opens.

d Click on the Advanced push button. You can set the configuration
keywords in the window that appears. These keywords are associated with
the database alias name, and affect all DB2 CLI/ODBC applications that
access the database. The online help explains all of the keywords, as does
an appendix in the Installing and Configuring DB2 Clients manual.

4 If you have installed ODBC access (as described above), you can now access
DB2 data using ODBC applications. Start the ODBC application and go to the
Open window. Select the ODBC databases file type. The DB2 databases that
you added as ODBC data sources will be selectable from the list. Many ODBC
applications will open the table as read-only unless a unique index exists.

Detailed Configuration Information

The section “Platform Specific Details for CLI/ODBC Access” on page 144 should
provide you with all of the information you require. Installing and Configuring DB2
Clients includes additional information on setting up and using DB2 CLI and ODBC
applications. (The online Installing and Configuring DB2 Clients manual is located in the
directory x:\doc\US\html, where x is the letter that designates your CD-ROM and US is
the two-character country code that represents your language, for example US for

148 DB2 Connect Personal Edition Quick Beginnings



English.) This information is useful where DB2 tool support is not available, and for
administrators who require more detailed information.

The following topics are covered:

¢ How to Bind the DB2 CLI/ODBC Driver to the Database
¢ How to Set CLI/ODBC Configuration Keywords
¢ Configuring db2cli.ini

Running Java Programs

You can use DB2 Java Database Connectivity (JDBC) support to run the following
types of Java programs:

e Java applications, which rely on the DB2 Client Application Enabler to connect to
DB2.

e Java applets, that do not require any other DB2 component code on the client.

Java can also be used on the server to write user-defined functions, stored procedures,
and table functions.

For further information on developing Java applications that access DB2 databases
refer to the Web page located at http://www.software.ibm.com/data/db2/java/ and the
Road Map to DB2 Programming.

Configuring the Environment

The following environment variables must be set to run Java programs:
0S/2, Windows 95 and Windows NT

e CLASSPATH includes "." and the file sqgllib\java\db2java.zip

e PATH includes the directory sqllib\bin

e LIBPATH includes the directory sqllib\dIl (OS/2 only)

Java Applications

Start your application from the desktop or command line, like any other application. The
DB2 JDBC driver handles the JDBC API calls from your application and uses the DB2
Client Application Enabler to communicate the requests to the server and receive the
results.
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Java Applets

150

Because Java applets are delivered over the Web, you treat them a bit differently than
Java applications. You must install DB2 (server or client) on the same machine as your
Web server, then install the Java Development Kit (JDK) Version 1.1 from Sun
Microsystems on the server as well (refer to http://www.software.ibm.com/data/db2/java
for details).

To run your applet, you need only a Java-enabled Web browser on the client machine.
When you load your HTML page, the applet tag downloads the Java applet to your
machine, which then downloads the Java class files, including the
COM.ibm.db2.java.sql and COM.ibm.db2.jdbc.net classes and DB2's JDBC driver.
When your applet calls the JDBC API to connect to DB2, the JDBC driver establishes
separate communications with the DB2 database through the JDBC applet server
residing on the DB2 server.

To run your applets, do the following:

1 start the DB2 JDBC applet server on your Web server by entering:
db2jstrt portno

where portno is the number of the unused TCP/IP port that you specified in the
DB2Applt.java file.

2 On your client system, start your Web browser and load the HTML file that
imbeds your applet.
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Chapter 23. Entering DB2 Commands and
SQL Statements

You can use the Command Center to enter DB2 commands and SQL statements if you
are working with DB2 on an OS/2, Windows 95, or Windows NT workstation.
Otherwise, you can issue commands in the command line processor or a system
command prompt.

Task: Entering DB2 commands, SQL statements, and operating system commands

Operating System Tools

0S/2 ¢ Command Center

e command line processor

¢ command prompt

Windows 95 or Windows ¢ Command Center
NT

¢ command line processor

¢ Command Window

Windows 3.1 ¢ command line processor

Using the Command Center

On 0OS/2, Windows 95 and Windows NT operating systems, the Command Center
provides an interactive window that allows you to:

Run SQL statements, DB2 commands, and operating system commands.

See the execution result of one or many SQL statements and DB2 commands in a
result window. You can scroll through the results and save the output to a file.

Save a sequence of SQL statements and DB2 commands to a script file. You can
then schedule the script to run as a job. When a saved script is modified, all jobs
dependent on the saved script inherit the new modified behavior.

Recall and run a script file.

See the execution plan and statistics associated with a SQL statement before
execution. You do this by invoking Visual Explain in the interactive window.

Get quick access to database administrative tools such as the Control Center and
the Journal from the main tool bar.
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¢ Display all the command scripts known to the system through the Script Center,
with summary information listed for each.

To invoke the Command Center on OS/2 operating systems:
1 Double-click the DB2 for OS/2 folder.

2 Double-click on the Command Center icon.

To invoke the Command Center on Windows 95 and Windows NT:
1 Click on Start.

2 Select Programs ->DB2 for Windows ->Command Center .

The Command Center contains a large input area in which you type your commands.
To start a command on a new line use the Enter key. To run the commands you have
entered, select the Start or stop execution icon from the menu bar, or use
CTRL+Enter.

Do not type the commands with a db2 prefix; instead, enter the command as follows:
1ist node directory;

If you want to run multiple commands, you must end each command with a semicolon,

then press Enter to start the next command on a new line.

Note: The semicolon is optional at the end of a single quick command, and at the end

of the final command in a series.

After you run a command, the Command Center displays the Results window, which
informs you how the commands are proceeding.

To recall commands that you have typed in interactive mode, click on the arrow beside
the narrow input window. To save commands entered in interactive mode as scripts,
select Script ->Save as from the menu bar.

If you want to store commonly used SQL statements or DB2 commands as
scripts, select the Script icon from the main tool bar.
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Using the Command Line Processor

You can use the command line processor to enter SQL statements and DB2
commands. It operates in the following modes:

Interactive Input Mode You can enter DB2 commands or SQL statements
and view their output.

Command Line Mode The DB2 command line processor behaves like a
command window from your operating system.
You can enter DB2 commands or SQL statements
and view their output.

File Input Mode Refer to the Command Reference for information
on the file input mode.

Interactive Input Mode

To invoke the command line processor in interactive input mode, do the following:
¢ On 0OS/2:
1 Double-click the DB2 for OS/2 folder.
2 Double-click on the Command Line Processor icon.
¢ On Windows 95 and Windows NT operating systems:
1 Click on Start.
2 Select Programs ->DB2 for Windows ->Command Line Processor
e On Windows 3.1, use one of the following methods:
— From a DOS full screen, enter the win db2clpw command.
— From Windows:

1 Double-click the DB2 folder.

2 Double-click on the Command Line Processor icon.

You can also invoke the command line processor in interactive input mode, by entering
the following command at a command prompt:
e On 0OS/2 enter db2.

e On Windows 95 and Windows NT, enter db2cmd , then enter db2.

In interactive input mode, the prompt looks like this:
db2 =>

Chapter 23. Entering DB2 Commands and SQL Statements 153



This prompt indicates that you do not type DB2 commands with a db2 prefix; instead,
you just type the DB2 command. For example:

list node directory
To run operating system commands in interactive mode, precede the operating-system
command with an exclamation mark (!). For example:

Idir db2*.Tog

Note: Windows 3.1x does not support this method of running operating-system
commands.

If you need to enter a long command that does not fit on one line, use the line
continuation character, \. For example:

db2 => select firstname, lastname, dateofbirth, from \
db2 (cont.) => staff where height=123, order by \
db2 (cont.) => lastname

Note: You do not need to use a line continuation character when entering long
commands in interactive input mode on Windows 3.1 workstations.

To end interactive input mode, type terminate .

Command Line Mode
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On 0OS/2, you can issue DB2 commands from a command prompt. You must include
the db2 prefix. For example:

db2 Tist node directory

To invoke the command line processor in command line mode on Windows 95 and
Windows NT operating systems, use one of the following methods:

e Click on Start and select Programs ->DB2 for Windows ->Command Window .

e Enter the db2cmd command at a command prompt.
After you invoke the DB2 command environment, you can enter DB2 commands at the
command prompt. You must include the db2 prefix.
Notes:

1. If the DB2 command contains characters that have special meanings on the
operating system you are using, you will need to enter the command in quotation
marks to ensure that it is run properly. For example, the following command will
successfully retrieve all information from the employee table, even if the * character
has a special meaning on the operating system:

db2 "select * from employee"

2. Command line mode is not available on Windows 3.1x systems.
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For further information on using the command line processor, refer to the Command Reference.
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Chapter 24. Controlling Your DB2
Environment

Registry values, environment variables, and configuration parameters control your
database environment.

¢ To set registry values through the DB2 profile registry, see “Controlling the DB2 Profile
Registry” on page 158.

¢ To set DB2 environment variables, see:

— “Setting Your Environment on OS/2” on page 159.
— “Setting Your Environment on Windows 95 and Windows NT” on page 160.
— “Setting Your Environment on Windows 3.1" on page 161.

¢ To set database manager configuration parameters on a client instance, see “Configuration
Parameters” on page 167.

Prior to the introduction of the DB2 profile registry in Version 5, changing your DB2
environment on OS/2, Windows 95 or Windows NT workstations required you to
change your system's environment variables and reboot.

With Version 5, almost all of the environment variables have been moved to the DB2
profile registry. Users with system administrative (SYSADM) authority for a given
instance can update registry values for that instance. Use the db2set command to
update DB2 registry values without rebooting your system. The DB2 registry applies the
updated information to DB2 server instances and DB2 applications started after the
changes are made.

Note: The concept of the DB2 profile registry is not supported on Windows 3.1. See
“Setting Your Environment on Windows 3.1" on page 161 for more information.

DB2 configures its operating parameters by checking for variable values according to
the following search order:

e The environment variable settings.

¢ Profile registry values set with the db2set command in the instance-level profile.

e Profile registry values set with the db2set command in the global-level profile.
See “DB2 Registry Values and Environment Variables” on page 162 for descriptions of
the subset of registry values and environment variables that you may want to adjust to

get DB2 up and running. For more detailed information about all registry values and
environment variables, refer to the Administration Guide.
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Controlling the DB2 Profile Registry
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The DB2 profile registry stores DB2 registry values. The "levels" of registry values are
as follows:

DB2 instance-level profile:

This profile contains instance level variable settings and overrides. Values
defined in this level will override their settings in the global level.

DB2 global-level profile:

This profile contains system-wide variable settings. Any variable not
defined in the node or instance levels will be evaluated at this level.

To modify registry variable values, use the db2set command. The syntax of the db2set
command is as follows:

To set a parameter for the current instance, type:
db2set parameter=value
To set a parameter's value for a specific instance, type:
db2set parameter=value -i instance-name
To set a parameter's value for a specific DB2 instance and node, type:
db2set parameter=value -i instance-name node-number
To set a parameter at the global profile level, type:
db2set parameter=value -g
Notes:

1. Some parameters will always default to the global level profile. They cannot be
set at the instance or node level profiles. Examples of this are DB2SYSTEM
and DB2INSTDEF.

To delete a parameter's value at a specified level, you can use the same command
syntax to set the parameter but specify nothing for the parameter value. For
example, to delete the parameter's setting at the node level, type:

db2set parameter= -i instance-name

To explicitly unset a parameter's value at a specified level and prevent evaluating
the parameter at the next level, use the -null option. To use the parameter's
setting at the instance level, type:

db2set parameter= -null -i instance-name

The -null option allows you to set the value of a parameter globally, but unset the
value for a specific instance. For example, you can set DB2COMM to TCPIP at the
global level, and if you have four instances on your system, you can set three of
the instances to default to the global setting, but use the -null option to unset
DB2COMM on the fourth instance.
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¢ To evaluate the current session's parameter's value, type:
db2set parameter

¢ To evaluate the parameter's value at all levels, type:
db2set parameter -all

e To view a list of all values defined in the profile registry, type:
db2set -all

For more information on the db2set command and remote administering of the DB2
profile registry, refer to the Command Reference.

Setting

Your Environment on OS/2

It is strongly recommended that all DB2 specific registry values be defined in the DB2
profile registry. If DB2 variables are set outside of the registry, remote administration of
those variables will not be possible, and the workstation will have to be rebooted in
order for the variable values to take effect.

On OS/2 operating systems there are three system environment variables,
DB2INSTANCE, DB2PATH, and DB2INSTPROF, that are not stored in the DB2 profile
registry. DB2INSTANCE and DB2PATH are set when DB2 is installed; DB2INSTPROF
can be set after installation. On OS/2, the environment variable DB2PATH must be set;
normally it is set during install and you should not modify it. Setting DB2INSTANCE
and DB2INSTPROF is optional. Because the system environment variables are not set
in the profile registry, you will need to reboot if you change their settings.

To change the setting of an environment variable, enter the following command:

set parameter = value

To determine the setting of an environment variable, enter:

echo %variable-name%

To modify system environment variables you must edit the config.sys file, then reboot to
make the changes take effect.
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Setting Your Environment on Windows 95
and Windows NT

It is strongly recommended that all DB2 specific registry values be defined in the DB2
profile registry. If DB2 variables are set outside of the registry, remote administration of
those variables will not be possible, and the workstation will have to be rebooted in
order for the variable values to take effect.

Windows 95 and Windows NT have one system environment variable, DB2INSTANCE,
that can only be set outside the profile registry. However, you are not required to set
DB2INSTANCE; the DB2 profile registry variable db2instdef may be set in the global
level profile to specify the instance name to use if DB2INSTANCE is not defined.

To determine the setting of an environment variable, enter:

echo %variable-name%

To set system environment variables, do the following:

On Windows 95:
Edit the file and reboot to make the change take effect.

On Windows NT:
Set environment variables as follows:

1 Click on Start and select Settings ->Control Panel .
2 Double-click on the System icon.

3 In the System Properties panel, select the Environment tab and do the
following:

a If the variable does not exist:
1 Select any environment variable in the System Variables window.

2 Change the name in the Variable field to the name of the environment
variable you want to set, for example DB2INSTANCE.

3 Change the Value field to the instance name, for example, db2inst.

b If the variable already exists in the System Variables window, you can set a
new value:

1 Select the environment variable you want to append, for example
DB2INSTANCE.

2 Change the Value field to the instance name, for example, db2inst.

C Click on the Set push button.
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d Click on OK.

€ You may have to reboot your system for these changes to take effect.

Note: The environment variable DB2INSTANCE can also be set at the session
(process) level. For example, if you want to start a second DB2 instance called
TEST, issue the following commands in a command window.

set db2instance=TEST
db2start

Setting Your Environment on Windows 3.1

The DB2 environment on Windows 3.1 is not controlled by profile registries. Instead,
Windows 3.1 clients define environment keywords in the file db2.ini (typically found in
c:\windows directory).

On Windows 3.1, the parameters that control the DB2 environment are
called environment keywords. However, because many Windows 3.1
keywords are also used on operating systems that use the DB2 profile
registries, environment keywords may also be referred to as registry values
in this manual.

The db2.ini initialization file is an ASCII file that stores values for the Windows 3.1 client
environment keywords. Within the file, there is just one section header titled [DB2
Client Application Enabler].

The parameters are set by specifying a keyword with its associated keyword value in
the form:

Keyword=keywordValue

Notes:

1. All the keywords and their associated values must be located below the section
header.

2. The keywords are not case sensitive; however, their values can be if the values
are character based.

3. Comment lines use a semi-colon in the first position of a new line.

4. Blank lines are permitted. If duplicate entries for a keyword exist, the first entry is
used (and no warning is given).

The following is a sample db2.ini file:
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[DB2 Client Application Enabler]
DB2PATH=C:\SQLLIB\WIN
DB2INSTANCE=DB2
DB2INSTPROF=C:\SQLLIB
DB2TRACEON=N

This file is located in the Windows product directory. For example, it would typically be
found in c:\windows directory in a native Windows environment.

On Windows 3.1, Client Application Enabler for DB2 Version 2.1 and Version 5 must
set this information only in the db2.ini file.

DB2 Registry Values and Environment
Variables

The following subset of the DB2 registry values and environment variables are those
that you may need to know about to get up and running. Each has a brief description;
some may not apply to your environment.

You can view a list of all supported variables for your platform. On all operating
systems except Windows 3.1, enter the following db2set command:
db2set -1r

Note: Windows 3.1 clients define environment variables in the file db2.ini. See “Setting
Your Environment on Windows 3.1” on page 161 for details.

Parameter Operating Values Description
System
General
DB2ACCOUNT All Default: (not set) The accounting string that is sent to the

remote host. Refer to the DB2 Connect
User's Guide for details.

DB2CODEPAGE All Default: derived from Specifies the code page of the data
the language ID, as presented to DB2 for database client
specified by the application. The user should not set
operating system. db2codepage unless explicitly stated in

DB2 documents, or asked to do so by DB2
service. Setting db2codepage to a value
not supported by the operating system can
produce unexpected results. Normally, you
do not need to set db2codepage because
DB2 automatically derives the code page
information from the operating system.
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Parameter Operating Values Description
System
DB2COUNTRY All Default: derived from Specifies the country code of the client
the language ID, as application, which influences date and time
specified by the formats.
operating system.

DB2DBDFT All Default: (not set) Specifies the database alias name of the
database that will be implicitly connected
to when applications are started and no
implicit connect has been done. This
keyword is ignored if it is set.

DB2DISCOVERYTIME | 0S/2, Default=40 seconds, Specifies the amount of time that SEARCH

Windows minimum=20 seconds discovery will search for DB2 systems.
95, and
Windows
NT
DB2INCLUDE All Default=current Specifies a path to be used during the
directory processing of the SQL INCLUDE text-file
statement during DB2 PREP processing. It
provides a list of directories where the
INCLUDE file might be found. Refer to the
Embedded SQL Programming Guide for
descriptions of how dbZ2include is used in
the different precompiled languages.
DB2INSTDEF 0S/2, Default=DB2 (on 0S/2, Sets the value to be used if
Windows 95 Windows 95 and DB2INSTANCE is not defined.
and Windows NT)
Windows
NT
DB20OPTIONS All except Default=null Sets command line processor options.
Windows
3.1 and
Macintosh
DB2SLOGON Windows Default: NO Enables a secure logon in DB2 for
3.1 Windows 3.1. If db2slogon=YES DB2 does

not write user IDs and passwords to a file,
but instead uses a segment of memory to
maintain them. When db2slogon is
enabled, the user must logon each time
Windows 3.1 is started.
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Parameter

Operating
System

Values

Description

DB2TIMEOUT

Windows
3.1 and
Macintosh

Default: (not set)

Used to control the timeout period for
Windows 3.1 and Macintosh clients during
long SQL queries. After the timeout period
has expired a dialog box pops up asking if
the query should be interrupted or allowed
to continue. The minimum value for this
variable is 30 seconds. If db2timeout is set
to a value between 1 and 30, the default
minimum value will be used. If db2timeout
is set to a value of 0, or a negative value,
the timeout feature is disabled. This
feature is disabled by default.

DB2TRACENAME

Windows
3.1 and
Macintosh

Default=DB2WIN.TRC

On Windows 3.1 and Macintosh, specifies
the name of the file where trace
information is stored. The default is
db2tracename=DB2WIN.TRC, and is saved
in your current instance directory (for
example, \sqllib\db2). We strongly
recommend that you specify the full path
name when naming the trace file.

DB2TRACEON

Windows
3.1 and
Macintosh

Default=N, values: Y,
N

On Windows 3.1 and Macintosh, turns
trace on to provide information to IBM in
case of a problem. (It is not recommended
that you turn trace on unless you
encounter a problem you cannot resolve.)
Refer to the Troubleshooting Guide for
information on using the trace facility with
DB2 Client Application Enabler.

DB2TRCFLUSH

Windows
3.1 and
Macintosh

Default=N, values: Y,
N

On Windows 3.1 and Macintosh,
db2trcflush can be used in conjunction
with db2traceon = Y. db2trcflush = Y will
cause each trace record to be written
immediately into the trace file. Setting this
will slow down your DB2 system
considerably, so the default setting is
db2trcflush = N. This setting is useful in
cases where an application hangs the
system and therefore needs to be
rebooted. Setting this keyword guarantees
that the trace file and trace entries are not
lost by the reboot.

DB2TRCSYSERR

Default=1, values: 1 -
32767

Specifies the number of system errors to
trace before the client turns off tracing.
The default value traces one system error,
after which, trace is turned off.
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Parameter Operating Values Description
System

DB2YIELD Windows Default=N, values: Y, Specifies the behavior of the Windows 3.1
3.1 N client while communicating with a remote

server. When N is set, the client will not
yield the CPU to other Windows 3.1
applications, and the Windows
environment is halted while the client
application is communicating with the
remote server. You must wait for the
communications operation to complete
before you can resume any other tasks.
When set to Y, your system functions as
normal. It is recommended that you try to
run your application with db2yield=YES. If
your system crashes, you will need to set
db2yield=N0. For application development,
ensure your application is written to accept
and handle Windows messages while
waiting for a communications operation to
complete.
System Environment
DB2INSTANCE All Default=db2instdef on The environment variable used to specify

0OS/2, Windows 95, the instance that is active by default. On

and Windows NT UNIX, users must set the environment
variable DB2INSTANCE.

DB2INSTPROF 0S/2, The environment variable used to specify
Windows the location of the instance directory on
95, and 0S/2, Windows 95 and Windows NT
Windows operating systems, if different than
NT DB2PATH.

DB2PATH 0S/2, The environment variable used to specify
Windows 95 the directory where the product is installed
and on 0S/2, Windows 95 and Windows NT
Windows operating systems. By default it is set to
NT x:\sgllib\win on Windows 95 and Windows

NT.
Communications

DB2COMM All, server Default= null, values: Specifies the communication managers

only any combination of that are started when the database
APPC,IPXSPX, manager is started. If this is not set, no
NETBIOS, DB2 communications managers are
NPIPE, TCPIP started at the server.

DB2NBADAPTERS 0S/2, Default=0, Range: Used to specify which local adapters to
Windows 0-15, Multiple values use for DB2 NetBIOS LAN
95, and should be separated communications. Each local adapter is
Windows by commas specified using its logical adapter number.
NT, server
only
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Parameter

Operating
System

Values

Description

DB2NETREQ

Windows
3.1

Default=3, Range: 0-25

Specifies the number of NetBIOS requests
that can be run concurrently on Windows
3.1 clients. The default value is 3. The
number can range from 0 to 25. The
higher you set this value, the more
memory below the 1MB level will be used.
When the concurrent number of requests
to use NetBIOS services reaches the
number you have set, subsequent
incoming requests for NetBIOS services
are held in a queue and become active as
the current requests complete. If you enter
0 (zero) for db2netreq, the Windows
database client issues NetBIOS calls in
synchronous mode using the NetBIOS wait
option. In this mode, the database client
allows only the current NetBIOS request to
be active and does not process another
one until the current request has
completed. This can affect other
application programs. The 0 value is
provided for backwards compatibility only.
It is strongly recommended that O not be
used.

DCE Directories

DB2DIRPATHNAME

0S/2 and
UNIX

Specifies a temporary override of the
DIR_PATH_NAME parameter value in the
database manager configuration file. If a
directory server is used and the target of a
CONNECT statement or ATTACH
command is not explicitly cataloged, then
the target is concatenated with
DB2DIRPATHNAME (if specified) to form
the fully qualified DCE name.

Note: The dbZ2dirpathname value has no
effect on the instance's global
name, which is always identified by
the database manager
configuration parameters
DIR_PATH_NAME and
DIR_OBJ_NAME.
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Parameter Operating Values Description
System

DB2CLIENTCOMM 0S/2 and Specifies a temporary override of the
UNIX DFT_CLIENT_COMM parameter value in
the database manager configuration file. If
both DFT_CLIENT_COMM and
db2clientcomm are not specified, then the
first protocol found in the object is used. If
either one or both of them are specified,
then only the first matching protocol will be
used. In either case, no retry is attempted
if the first connect fails.

DB2CLIENTADPT 0Ss/2 Default= null, range: Specifies the client adapter number for
0-15 NETBIOS protocol on OS/2 operating
systems. The db2clientadpt value
overrides the DFT_CLIENT_ADPT
parameter value in the database manager
configuration file.

DB2ROUTE 0S/2 and Default Specifies the name of the Routing

UNIX Information Object the client uses when it
connects to a database with a different
database protocol. The dbZroute value
overrides the ROUTE_OBJ_NAME
parameter value in the database manager
configuration file.

Configuration Parameters

Configuration parameters are values that affect the operating characteristics of a
database or database management system.

Database management configuration parameters exist on servers and clients.
However, only certain database management configuration parameters can be set on
the client. These parameters are a subset of the database management configuration
parameters that can be set on the server.

Database configuration parameters can be set only on the server.

For information on setting server database or database management configuration parameters,
refer to the Administration Guide.
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Setting Database Manager Configuration
Parameters on a Client Instance

To control database management configuration parameters on a client instance on
0S/2, Windows 95, or Windows NT, use the Client Configuration Assistant (CCA).

e On 0S/2:

1 Double-click on the Client Configuration Assistant  icon in the DB2 for
0sS/2 folder.

2 Click on the Client Settings push button.
e On Windows 95 and Windows NT:

1 Click on Start and select Programs ->DB2 for Windows ->Client
Configuration Assistant . The Client Configuration window opens.

2 Click on the Client Settings push button.

Follow the hints and online help to modify configuration parameter values.

¢ For information on using Client Configuration Assistant, see Chapter 28, “Administering
Clients Using the CCA” on page 209.
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Chapter 25. Administering and Using OS/2
User Profile Management on OS/2 Systems

User Profile Management (UPM) provides access control to workstation resources
through a set of user ID validation and user and group ID management functions. UPM
is installed with the DB2 products.

Three icons appear in the UPM Services folder:

¢ Logoff
e Logon
e User Account Management

Special Note for Users of Warp Connect and
Warp Server

DB2 for OS/2 Version 5 includes UPM Version 4.0. Peer Services ships as a part of
0OS/2 Warp Connect and Warp Server includes a later version of UPM.

If DB2 for OS/2 detects that UPM is already installed it does not attempt to re-install it.
Note that Version 4.06 of UPM does not include default user ID USERID with password
PASSWORD defined. For DB2 for OS/2 Version 5 local logon, either:

e Use your Peer Services user ID, or

e Create a new user ID called USERID with password PASSWORD in UPM when
logged on with your Peer Services user ID, which is an Administrator by default.

Using UPM for the First Time

The first time you use UPM, you have to use a default user ID. Your first task is to
establish a permanent user ID and delete the default ID:

1 Make a backup copy of the net.acc file. This is stored on your workstation as
c:\muglib\accounts\net.acc and contains the UPM defaults.
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Note: If IBMLAN is also installed, you will find net.acc under
x:\ibmlan\accounts.

You may use the backacc.exe and restacc.exe commands to backup and restore
the net.acc file. Refer to your operating system or LAN documentation for further
information.

Log on to UPM, following the procedure in “Logging on to UPM” on page 171.
Use the default user ID, USERID, and the default password, PASSWORD.

Establish a permanent user ID, following the procedures in “Adding a New User
ID and Password” on page 172. Select the:

e Administrator radio button in the User type box
e Allowed radio button in the Logon box
e Password Required radio button in the Options box.
Note: Use a password that is not trivial.
Log off from UPM, following the procedures in “Logging Off” on page 174.

Log on to UPM again. Use the user ID you established in step 3.

Delete the default user ID, USERID, following the procedure in “Changing or
Deleting a User ID” on page 173. This is a safeguard against unauthorized use of
your workstation.

Do other work in UPM, as required.

When you are finished, log off from UPM.

Using UPM Every Day

This section covers everyday usage of UPM.

“Logging on to UPM” on page 171

“Logging On at the Command Prompt” on page 171
“Adding a New User ID and Password” on page 172
“Changing or Deleting a User ID” on page 173
“Logging Off” on page 174

“Managing UPM Groups” on page 174
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Logging on to UPM

To log on to UPM, follow these steps:
1 Double-click on the UPM Services folder on the desktop.
2 Double-click on the Logon icon.

3 In the Logon window, type your user ID and password. (The password does not
display.)

4 Click on OK.

Logging on to UPM with Multiple IDs

Logging

You can log on to UPM with multiple user IDs. You can use this feature to start several
application programs under different user IDs. There are two ways to enable multiple
logons at your workstation (and control selective logoffs). Use either of these methods:

e Type LOGON /0=MULTI at the OS/2 prompt and press Enter. As each application
starts, the UPM logon window appears.

¢ Embed UPM logon and logoff commands in each application program you want to
start with its own user ID. UPM provides two application programming interfaces
(APIs), one for logon and one for logoff.

On at the Command Prompt

You may also log on at the command prompt using the following syntax:

»»—Ilogon—userid—/P:—password—/N:—node—/D:—domain—/L:———— >«

userid Identifies the user logging on. If userid is not specified, the Logon
window is displayed so you can enter the user ID.

/P: password Allows you to specify a password. If you enter a password, UPM tries
to log on using the password specified. If no password is specified,
UPM tries to log on without a password. If a password is required, the
Logon window is displayed so you can enter it.

/P is ignored if userid was not specified.

IN:node Specifies the node to be used the next time a node must be
accessed. If you use /N, the user ID and password are not validated
until the program attempts to connect to the node.

If no node is specified, the Logon window for Remote Node Access is
displayed so you can enter the node name.
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/D:domain

/L

If only /N is specified, the Logon window for Remote Node Access is
displayed so you can enter the user ID, password, and node name.

Specifies the domain on which a logon is to be attempted. An attempt
to start a LAN requester is issued and, if successful, the domain
logon completes.

If a LAN requester cannot be started, then a local logon is attempted.

If only /D is specified, the Logon window for a domain logon is
displayed. If the workstation is a server, the default domain name is
displayed on the domain logon window and you cannot change this
domain name. If the workstation is a requester, the default domain
name is displayed and you can use the default domain name or type
a new domain name.

If you do not specify any parameters with the LOGON command,
domain logon is the default if you are not already logged on to a
domain. If you are already logged on to a domain, and you want to
log on to another domain, specify the logon command, user ID, and
password with the new domain name. You are logged off the old
domain and logged on to the new domain without windows being
displayed.

Forces a local logon. If you issue the LOGON command with no
parameters, a domain logon is automatically attempted. To force a
local logon, you must use the /L parameter.

Adding a New User ID and Password

172

To add a new UPM user ID and password, follow these steps:

1
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Double-click on the User Account Management icon in the UPM Services
folder. You must logon to UPM with a user ID that has Administrator authority.

If you are currently logged on to a domain and want to Manage Users locally, to
use a local logon you must:

¢ Click on Actions in the User Profile window.
e Select Use domain from the pulldown menu.
e Select the Local radio button.

¢ Click on OK.
Select Manage-> Manage Users from the menu bar.
Select —NEW— from the list.

Select Actions -> Add a new user ID from the menu bar.

Type a new user ID and an optional comment. The user ID can be 1-8 characters

and must comply with the guidelines in “Naming Rules” on page 175.
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Select the values you want for User type and Logon . For most users, use the
defaults, User and Allowed .

In the Confirmation box, type a password in the first Type password twice field,
and type the password again in the second field for verification. The password
must comply with the guidelines in “Naming Rules” on page 175.

Select the value you want for Options . For most users, use the default,
Required .

Click OK. You are returned to the User Profile Management—User Management
window.

Changing or Deleting a User ID

To change or delete a UPM user ID, follow these steps:

1
2

Log on to UPM.

Double-click on the User Account Management icon in the UPM Services
folder.

Select Manage-> Manage Users from the menu bar.
Select the user ID you want from the list.

Select Actions from the menu bar; then select one of the following:

Update user information
To change a user's attributes, such as authorization level and
password

View user profile...
To see a user's profile information

Select groups for user ID...
To add a user to, or remove the user ID from, groups

Erase user ID...
To delete a user ID

Add/Change user logon profile...
To add a new logon profile for a user, change an existing logon
profile, or delete a logon profile

Erase user logon profile...
To delete a user's logon profile

When you return to the User Profile Management - User Management window,
select Exit-> Exit user management from the menu bar.
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Logging Off
To log off from UPM, follow these steps:

1 Display the User Profile Services window, either by exiting the UPM window in
which you are working or by selecting User Profile Management from the
desktop.

Double-click on the UPM Services folder.
Double-click on the Logoff icon.

Select a user ID from the list; then click on the Logoff push button. To log off all
the user IDs from UPM, click on the Logoff all push button.

Managing UPM Groups

With administrator authority, you can put user IDs into groups and perform the following
tasks:

e Create a new group
e Add or delete users in a group
e Delete a group.

All of the procedures below begin at the User Profile Management - Group
Management window. To get there, follow these steps:

e Double-click on the User Account Management icon in the UPM Services folder.

e Select Manage-> Manage Groups from the menu bar.

Creating a New Group

To create a new group, follow these steps:
Select —NEW— from the list in the window.
Select Actions -> Add a new group from the menu bar.

In the Group ID field, type the name of the new group. Group IDs follow the
same naming conventions as user IDs (see “Naming Rules” on page 175).

Type an optional comment in the Group comment field.
In the User ID list, select the user IDs for membership in the group.

Click on OK.
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Adding and Deleting Users in a Group

To add or delete users in a group, follow these steps:

Select the group ID you want from the list in the window.
Select Actions -> Update group from the menu bar.
Update the Group comment field by typing new text.
Select the user IDs you want to add to the group.

Deselect the user IDs you want to delete from the group.
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Click on OK.

Deleting a Group

To delete a group, follow these steps:
1 Select the group ID you want from the list in the window.
2 Select Actions -> Erase group from the menu bar.

3 Click on Erase ID push button to confirm the request.

Naming Rules

The user ID must conform to the following rules:
¢ Cannot start with a digit (0 to 9) or end with a dollar sign ($).
e Can be 1 to 8 characters long and may contain the following characters:

— Upper or lower case letters A to Z
— Special characters #, @, or $
— Digits 0 to 9.

e Cannot be PUBLIC, USERS, ADMINS, LOCAL, or GUESTS, or a name that starts
with IBM, SYS, or SQL.
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User Profile Management Passwords

UPM provides default values for user ID and password; some countries have translated
these values as shown in Table 11.

Table 11. Default UPM User IDs and Passwords

Country USERID Password
<default> USERID PASSWORD
Denmark BRUGERID KODEORD
Finland OMATUNN TUNNSANA
France IDUTIL MOTDEPAS
Germany BENUTZER KENNWORT
Italy ID CHIAVE
Norway BRUKER PASSORD
Portugal IDUTIL PASSE
Spain IDUSUAR CONTRASE

Note: If your country does not appear in the list, assume USERID and PASSWORD are used. If
this fails, see the README file.
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Part 7. Advanced Installation and
Configuration
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Chapter 26. Unattended DBZ2 Installation on
OS/2 or Windows 3.x Workstations

During a regular installation, you interact with the install program, filling in a series of
panels to set up and configure the DB2 product.

In an unattended installation, these tasks run automatically without any intervention by
you. The setup and configuration data is supplied by response files you set in place
beforehand.

You can use this feature to install DB2 products on OS/2 or Windows 3.x operating
systems:

e Locally, from a CD-ROM (refer to “Installing DB2 Products from a Code Server
Hard Disk or CD-ROM”).

¢ Remotely, across a network connection from a code server hard disk/CD-ROM
(refer to “Installing DB2 Products from a Code Server Hard Disk or CD-ROM”).

¢ Remotely, using SystemView LAN if it is installed on your system (refer to
“Installing DB2 Products Remotely Using SystemView LAN” on page 185).

If you need to install the same DB2 product on several machines, you can
use unattended installation's "response file" feature to create a customized
configuration, save the customized response file, then reuse it as a template
for each installation.

Installing DB2 Products from a Code Server
Hard Disk or CD-ROM

To install DB2 products for OS/2 or Windows 3.x, from a code server hard disk or
CD-ROM, on local or remote workstations, perform the steps in the following sections:

e “Step 1. Make DB2 Files Available for Installation” on page 180
e “Step 2. Create a Response File for Unattended Installation” on page 181

e “Step 3. Run the CMD/BAT File from the Remote Workstation” on page 183

You can also use the following procedure to remove all DB2 products from
a target workstation. Simply follow the instructions below, but when editing
the command file, specify D (Delete) instead of | (Install).
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Step 1. Make DBZ2 Files Available for Installation

In this section, you make the DB2 install files accessible to the client machine where
DB2 will be installed.

¢ If performing remote installs directly from the CD-ROM:
1 Insert the appropriate CD-ROM into the drive.

2 Ensure that the CD-ROM will remain in the drive for as long as it is needed
for the install. If the drive is often used for other tasks as well, consider
installing from the code server hard disk instead.

¢ If installing from a code server hard disk, you must copy the required files from the
CD-ROM directories to the code server's hard disk. At the command prompt, use
the xcopy command with the /s option.

— For 0S/2, the syntax for the two commands required is:

xcopy x:\db2\os2\language e:\clients\language /s
xcopy x:\db2\os2\common e:\clients\common /s

where:

- X s the letter that designates the CD-ROM drive

- eis the letter that designates the code server's hard disk

- language is the two-character code that represents your language (for
example, EN for English). Table 16 on page 256 lists the code for each
available language.

— For Windows 3.x, the command syntax is:
xcopy x:\windows\language\client\x.* e:\ins /s
where:

- X s the letter that designates the CD-ROM drive

- els the letter that designates the code server's hard disk

- language is the two-character code that represents your language (for
example, EN for English). Table 16 on page 256 lists the code for each
available language.

If performing a remote installation, you must enable your network clients to access the
DB2 install files.

Grant shared access authority to the directory that you just created, or to the CD-ROM
drive if installing directly from CD-ROM.
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Step 2. Create a Response File for Unattended
Installation

During an interactive installation, you provide the information needed to install DB2 and
configure its environment. During an unattended installation, this information is provided
as keywords and values in a response file. DB2's install package includes a
ready-to-use sample response file, with default entries already in place.

If you intend to use the sample response file provided, without making any changes to its values,
you can skip this step and go to “Step 3. Run the CMD/BAT File from the Remote Workstation” on
page 183.

To edit the sample response file:

1 Find the correct sample response files for the platform you are installing to, and
for the product you want to install.

If installing directly from the CD-ROM, substitute x:\os2 or x:\windows (depending

on the target workstation's operating system) for e:\clients in the directory names
below.

e For 0OS/2, edit
— e:\clients\language\db2conpr.rsp for DB2 Connect Personal Edition

where language is the two-character country code that represents your
language (for example, EN for English). Table 16 on page 256 lists the code
for each available language.

e For Windows 3.x, use :
— e:\clients\db2pconw.rsp for DB2 Connect Personal Edition
2 The response file contains:
¢ Keywords unique to installation
e Environment variable settings

e Configuration parameter settings.

For more information on:

¢ DB2 environment variables, see “DB2 Registry Values and Environment
Variables” on page 162, or refer to the Administration Guide.

e Configuration parameters, refer to the Administration Guide.

3 To activate an item in the response file, remove the asterisk (*) to the left of the
keyword/registry value, erase the current setting to the right of the value and type
in a new setting. The possible settings are listed to the right of the current setting.

An example section of a response file appears below:
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FILE

= c:\sqllib
Comp = Client Application Enabler
*DB2ACCOUNT = BLANK or char(199)

= BLANK or 1 - MAX

*DB2BQTIME

Keywords unique to installation are parameters that are only specified in a
response file during an unattended installation. The following is a list of keywords
unique to OS/2 and Windows 3.1 unattended installation:

e FILE

Specifies the destination directory for DB2. If you do not change this value, it
defaults to x:\sqllib where x is the drive on which your operating system is
installed.

¢ Install DB2 products only on a drive which is local to the target
workstation. Installing on a non-local drive can cause performance and
availability problems.

e COMP

Specifies the components you want installed. By default, all components of
the DB2 product are installed. If you do not want to install a component, add
an asterisk (*) to the left of the COMP line for that component in the
response file.

e OVERWRITE

Specifies whether to automatically overwrite files during installation. Valid
values for this keyword are YES and NO.

e CFGUPDATE

Specifies whether the CONFIG.SYS file is automatically updated. Valid
values for this keyword are:

— AUTO
Automatically updates CONFIG.SYS.
— MANUAL
Does not update CONFIG.SYS.
e SAVEBACKUP

Specifies whether to save a backup version of the product when it is updated.
Valid values for this keyword are YES and NO.

e DB2SYSTEM
On 0S/2, specifies a name for the system which is unique within a network.

Note: This parameter must be specified.
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e AUTO_CTRL_CENTER

On OS/2, specifies whether or not to automatically start the Control Center
each time the system is rebooted.

Note: By default the Control Center will be automatically started unless this
parameter is set to NO.

e DB2.AUTOSTART

On 0OS/2, specifies whether or not to automatically start the DB2 instance
each time the system is rebooted.

Note: By default the DB2 instance will be automatically started unless this
parameter is set to NO.

¢ ADMIN.USERID and ADMIN.PASSWORD

On 0OS/2, specifies the user ID and password that will be used to log on and
start the Administration Server each time your system is started. If UPM
already exists on your system, the user ID and password you provide must
exist and have one of the following:

— UPM administrator authority on your system.
— UPM local administrator authority on your system.

If UPM is not on your system, it will be installed as part of the DB2
installation and the user ID and password you provide will be set up with the
appropriate authority.

4 Exit the file. If you have made any changes, save the file under a new file name
to preserve the original sample response file.

If you are installing directly from the CD-ROM, you must store the renamed
response file on another drive.

Step 3. Run the CMD/BAT File from the Remote
Workstation

A command (CMD) or batch (BAT) file contains the commands which will start the
installation program. You must edit this file before running the installation.

1 Find and open the correct CMD or BAT file.

If installing directly from the CD-ROM, substitute x:\os2 or x:\windows (depending
on the target workstation's operating system) for e:\clients in the directory names
below.

e For OS/2, the CMD files are available in the e:\clients\language directory
where language is the two-character country code that represents your
language (for example, EN for English). Table 16 on page 256 lists the code
for each available language. For example:

— db2conpr.cmd for DB2 Connect Personal Edition
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e For Windows 3.x, the BAT file is:
— e:\clients\db2pconw.bat for DB2 Connect Personal Edition

2 Edit the command in the file, to fill in the information needed for the installation.
e For OS/2:
a In the command file, you must specify the location of the install files.
Use the following command:
set beginlibpath=drive:\db2path

For example, if you are installing from the code server's hard drive,
specify the directory created in Step 1:

set beginlibpath=x:\clients\language\install

where x is the letter that designates the CD-ROM drive and language is
the two-character country code that represents your language (for
example, EN for English). See Table 16 on page 256

b You must also specify the complete install command. A complete
command requires the following syntax:

Winstaﬂ /A:actionﬁ/P:"product"4>
d:\path /X

»———/R:response

L/Ll:er‘ror‘J L/LZ:histor‘yJ

The following is an example of a complete command in the sample command
files:

e:\clients\language\install\install /A:1 /X
/P:"IBM DB2 Client Application Enabler"
/R:e:\clients\language\db2cae.rsp /L1:d:\error.log
/L2:d:\history.log

where:

/d:\path Specifies the location of the install files. If installing from the code
server's hard drive, specify the directory created in Step 1.

/A Specifies the action to be performed.
I Specifies install.

Note: If you want to remove all DB2 products from a
target workstation, specify D (Delete) instead of |

(Install).
/X Specifies that the installation will run in unattended mode.
P Specifies the name of the product you want to install.
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/R Specifies the fully qualified response file name. If you changed
and renamed the sample response file provided, make sure this
parameter matches the new name.

/L1 Specifies the fully qualified log file name, where setup
information and any errors occurring during setup are logged.

/L2 Specifies the fully qualified history log name, where all the files
processed by the installation program are listed.

3 Save and exit the CMD or BAT file.

If you are installing directly from the CD-ROM, you must rename the CMD or BAT
file, store it on another drive, and use that file name in the next step.

Start the installation by typing the CMD or BAT file's name on the command line.

When installation is complete, check the error and history logs for any errors or
problems.

To configure your client to access remote servers, go to Chapter 19, “Configuring Your DB2
Connect Personal Edition to Access a Remote DB2 Server” on page 127.

Installing DB2 Products Remotely Using
SystemView LAN

To install a DB2 product in a TME10 SystemView LAN environment, perform the steps
in the following sections:

e “Step 1. Copy the DB2 Install Files to the Code Server”

e “Step 2. Add the DB2 Product to the Software Library” on page 186

e “Step 3. Configure the DB2 Product” on page 187

e “Step 4. Install DB2 Products on the Remote Workstation” on page 187

Note: SystemView LAN cannot be used for Windows 3.x workstations.

Step 1. Copy the DBZ2 Install Files to the Code
Server

1 Insert the appropriate CD-ROM into the drive.
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3

Copy the required files from the CD-ROM directories to the code server's hard
drive. At the command prompt, use the xcopy command with the /s option.

The syntax for the two commands required is:

xcopy x:\db2\os2\language e:\cid\img\language /s
xcopy x:\db2\os2\common e:\cid\img\common /s

where

e X is the letter that designates the CD-ROM drive

e Janguage is the two-character code that represents your language (for
example, EN for English. Table 16 on page 256 lists the code for each
available language.

e eis the letter that designates the code server's hard disk

Leave the CD-ROM in the drive; it is required for the next step.

Step 2. Add the DBZ2 Product to the Software

Library

Once you have added a particular DB2 product to the software library, you
can omit this step for later installations of that product.

To add a DB2 product to the software library:
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Start SystemView LAN.

Double-click on the SystemView LAN Service Manager icon.
Double-click on the CID Software Preparation icon.

Double-click on the Software Library icon.

Select Software ->New from the menu bar on the Software Library window.
Enter the name of the product you are adding.

Select the Find push button.

In the Find definition file window, select:

¢ The CD-ROM drive letter in the Drive list
e en\install\x.adf in the Directory list
¢ The appropriate .adf file name in the File list:

— db2conpr.adf for DB2 Connect Personal Edition

Click on OK.

Select the Add push button to associate the application definition file with DB2.
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This copies the remote installation files (.adf, .var, .cmd and .mrf) from the
CD-ROM to the subdirectory where SystemView LAN resides (\sysview?2).

An icon is created in the Software Library folder, representing the DB2 product you
have just added.

Step 3. Configure the DB2 Product

In this step, you configure the DB2 product for the target workstation, just as you would
during a standard interactive installation. To perform this task:

1 Double-click on the DB2 product icon in the Software Library window.

2 Select Configuration ->New.

The Settings notebook opens.
Enter a unique identifier to define this configuration.

On each page of the notebook, select each of the items in the Variables list and
choose the setting. A description of each variable is displayed in the Explanation
field of the notebook page.

5 When you have completed all of the pages of the notebook, click on OK.

When the message Do you want to catalog the database? appears, click on the
Yes push button.

The values entered in the notebook are used to create a response file which will
supply the information needed to run the installation.

Step 4. Install DB2 Products on the Remote
Workstation

To install DB2 products on the remote workstation, you can use either the Event
Scheduler or the Remote System Manager. For information on how to use these tools,
refer to the SystemView LAN documentation.

After installation, you must reboot the workstation before using DB2.

To configure your client to access remote servers, go to Chapter 28, “Administering Clients Using
the CCA” on page 209.
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Chapter 27. Unattended DBZ2 Installation on
Windows 95 or Windows NT Workstations

During a regular installation, you interact with the install program, filling in a series of
panels to set up and configure the DB2 product.

In an unattended installation, these tasks run automatically without any intervention by
you. The setup and configuration data is supplied by response files you set in place
beforehand.

You can use this feature to install DB2 products on Windows 95 or Windows NT
operating systems:

e Locally, from a CD-ROM (refer to “Installing DB2 Products from a Code Server
Hard Disk or CD-ROM”)

¢ Remotely, across a network connection from a code server hard disk or CD-ROM
(refer to “Installing DB2 Products from a Code Server Hard Disk or CD-ROM”)

¢ Remotely, across a network connection to target workstations, using Microsoft
Systems Management Server (SMS) if it is installed on your Windows NT system
(refer to “Installing DB2 Products Remotely Using SMS” on page 198).

If you need to install the same DB2 product on several machines, you can
use unattended installation's "response file" feature to create a customized
configuration, save the customized response file, then reuse it as a template
for each installation.

Installing DBZ2 Products from a Code Server
Hard Disk or CD-ROM

To install DB2 products for Windows 95 or Windows NT, from a code server hard disk
or CD-ROM to local or remote workstations, perform the steps in the following sections:

e “Step 1. Make DB2 Files Available for Installation” on page 190
e “Step 2. Create a Response File for Unattended Installation” on page 192
e “Step 3. Run Setup from the Workstation” on page 196

You can also use this procedure to perform an interactive remote install instead of an
unattended remote one. Follow the instructions below.
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Before You Begin

Read and perform the steps in this section before you begin the installation to ensure
that you have the required items and information you will need.

Creating Usernames for DB2 Installation and
Operation

This section describes usernames required to install the DB2 product and its
components.

Creating a Username for Installing DB2 Products:
Windows 95 The username must be a valid DB2 username.

A valid DB2 username is eight characters or less, and complies with
DB2's naming rules. For more information on DB2's naming rules, see
Appendix C, “Naming Rules” on page 265.

Windows NT You need to have a username that will be used to install DB2. The
username must belong to the Administrators group, and also be a valid
DB2 username or have the "Act as part of the operating system"
advanced user right.

A valid DB2 username is eight characters or less, and complies with
DB2's naming rules. For more information on DB2's naming rules, see
Appendix C, “Naming Rules” on page 265.

If this username does not comply with DB2's naming rules, but has the
"Act as part of the operating system" advanced user right, the setup
program will create the username DB2ADMIN to perform the installation.

On clients, this username will be removed from the system when the
installation is complete.

Step 1. Make DBZ2 Files Available for Installation
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To make the DB2 install files accessible to the machine where DB2 will be installed:

e If performing remote installs directly from the CD-ROM:
1 Insert the appropriate CD-ROM into the drive.

2 Ensure that the CD-ROM will remain in the drive for as long as it is needed
for the install. If the drive is often used for other tasks as well, consider
installing from the code server hard disk instead.
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¢ |[f installing from a code server, you must copy the required files from the CD-ROM

directories to the code server's hard disk:
1 Insert the appropriate CD-ROM into the drive.

2 Create a directory on the code server, for example, g:\db2prods.

3 At the command prompt, use the cpysetup.bat command to copy the files

necessary for a particular language install to a code server.
The command syntax is:

x:\db2\winnt95\common\cpysetup.bat g:\db2prods language
where:

— x s the letter that designates your CD-ROM drive

— @ is the letter that designates the code server's disk.

— language is the two-character country code that represents your
language (for example, EN for English). Table 16 on page 256

If performing a remote installation, you must enable your network clients to access the

DB2 install files.

Grant shared access to the directory that you just created, or to the CD-ROM drive.

To set up a share:
Click on Start and select Programs ->Windows Explorer .
Select the directory that you want to share, for example g:\db2prods.

3 Select Files->Properties from the menu bar. The properties window for the
directory will open. Click on the Sharing tab.

Select the Shared As radio button.
In the Share Name field type a share name. For example, type db2nt.
To specify read access for everyone on Windows NT:

a Select the Permissions push button. The Access Through Share
Permissions window opens.

b In the Name box, make sure that Everyone is selected.
C In the Type of Access box, select Read.

d Click on OK.

On Windows 95, you do not need to specify type of access when you set up a

share. By default, everyone is allowed read access.

In our example scenario, g:\db2prods uses a share name of db2nt. We will use this

value in the examples that follow.
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Step 2. Create a Response File for Unattended
Installation

During an interactive installation, you provide the information needed to install DB2 and
configure its environment. During an unattended installation, this information is provided
as keywords and values in a response file. DB2's install package includes a number of
ready-to-use sample response files, with default entries already in place.

The sample response files are located in the x:\\db2\winnt95\common directory,in:
where x is the letter that designates the CD-ROM drive. There is a different response

file for each product on the CD, so that the user has a valid list of parameters for each
product.

If you intend to use the sample response file provided, without making any changes to its values,
you can skip this step and go to “Step 3. Run Setup from the Workstation” on page 196.
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Edit the sample response file using your favorite editor. For example, you can use
Notepad or WordPad.

1 Open the sample response file for the package you want to install.

e db2conpr.rsp for DB2 Connect Personal Edition

2 The response file contains:
¢ Keywords unique to installation
¢ Registry value/environment variable settings

¢ Database manager configuration parameter settings.

For more information on:

¢ DB2 environment variables and registry values, see “DB2 Registry
Values and Environment Variables” on page 162, or refer to the
Administration Guide.

¢ Database manager configuration parameters, refer to the Administration
Guide.

3 To activate an item in the response file, remove the asterisk (*) to the left of the
keyword/registry value, erase the current setting to the right of the value and type
in a new setting. The possible settings are listed to the right of the current setting.

An example section of a response file appears below:
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FILE
REBO
*COM

= c:\sqllib
0T = No
p = Control Center

Keywords unique to installation are parameters that are only specified in a
response file during an unattended installation. The following is a list of keywords
unique to installation for Windows 95 and Windows NT unattended installation:

FILE
Specifies the destination directory for DB2.

Note: Check the value for the FILE keyword. FILE specifies where to install
the product. If you do not change this value, it defaults to x:\sqllib
where x is the drive on which your operating system is installed.

REBOOT

Specifies whether to reboot the system following installation.
TYPE

Specifies the type of install. The options are:

0=Compact
1=Typical (default)
2=Custom

For 0 and 1 (compact and typical), any COMP value will be ignored.

For all types, default communication values will be used where applicable, as
follows:

a DB2.DB2COMM and ADMIN.DB2COMM will be set for the protocols detected
on your system.

b If a protocol is detected on the system, or if you have specified values
for DB2.DB2COMM or ADMIN.DB2COMM, values for its parameters will be
generated so that the protocol will be enabled for DB2's use at the end
of the install. Checks are made to ensure that the generated values are
not duplicates, and that they conform to the protocols set up on your
system. Default values will be generated for the following:

— For NetBIOS:
DB2.DB2NBADAPTERS ADMIN.DB2NBADAPTERS
DB2 .NNAME ADMIN.NNAME

— For TCP/IP:
DB2.PORTNUMBER ADMIN.PORTNUMBER
DB2.SVCENAME ADMIN.SVCENAME

— For IPX/SPX:
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DB2.FILESERVER ADMIN.FILESERVER

DB2.0BJECTNAME ADMIN.OBJECTNAME

DB2.IPX_SOCKET ADMIN.IPX_SOCKET
— For APPC:

DB2.TPNAME ADMIN. TPNAME

Note: You may override these values; however, if the associated
protocol has not been detected or specified, the values will not
be used.

¢ PROD
Specifies the product you want installed. The options are:
— CONNECT_PERSONAL for DB2 Connect Personal Edition
Note: This parameter can be used more than once.
e COMP

Specifies the components you want installed. Components required for a
product are installed automatically. Components that are not available are
ignored.

Note: Component selections have no effect unless you specify a custom
installation.

The following table lists COMP keywords and the components they represent.

Table 12 (Page 1 of 2). Component Keywords for Windows 95 and Windows NT
Unattended Install

Keyword Component

Product Components

GRAPHICAL_TOOLS Graphical Tools
CLIENT_CONFIGURATION_ASSISTANT Client Configuration Assistant
CONTROL_CENTER Control Center
PERFORMANCE_MONITOR Performance Monitor
VISUAL_EXPLAIN Visual Explain
ODBC-DRIVER DB2 ODBC Driver
SAMPLE_APPLICATIONS Sample Applications
CONNECT_SUPPORT Connect Support
SNA_SUPPORT Integrated SNA Support
JAPANESE_CONVERSION Japanese Conversion Support
KOREAN_CONVERSION Korean Conversion Support
T_CHINESE_CONVERSION Traditional Chinese Conversion Support
S_CHINESE_CONVERSION Simplified Chinese Conversion Support
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Table 12 (Page 2 of 2). Component Keywords for Windows 95 and Windows NT

Unattended Install

Keyword

Component

DB2 Books

API_REFERENCE

API| Reference

ADMINISTRATION_GUIDE

Administration Guide

ADMINISTRATION_GETTING_STARTED

Administration Getting Started

DB2_PROGRAMMING_GETTING_STARTED

Road Map to DB2 Programming

BUILDING_OS2_WIN_APPLICATIONS

Building Applications for Windows and
0S/2 Environments

CLI_GUIDE_REFERENCE

CLI Guide and Reference

COMMAND_REFERENCE

Command Reference

CONNECT_PERSONAL_QUICK

DB2 Connect Personal Edition Quick
Beginnings

CONNECT_USERS_GUIDE

DB2 Connect User's Guide

UNIVERSAL_DB_QUICK

DB2 Universal Database Quick
Beginnings

SQL_PROGRAMMING_GUIDE

Embedded SQL Programming Guide

GLOSSARY

Glossary

MASTER_INDEX

Master Index

MESSAGES_REFERENCE

Message Reference

SQL_GETTING_STARTED

SQL Getting Started

SQL_REFERENCE

SQL Reference

SYSTEM_MONITOR_GUIDE

System Monitor Guide and Reference

CONNECT_ENTERPRISE_QUICK

DB2 Connect Enterprise Edition Quick
Beginnings

TROUBLE_SHOOTING_GUIDE

Troubleshooting Guide

CONNECTIVITY_SUPPLEMENT

DB2 Connectivity Supplement

UNIVERSAL_DB_PERSONAL_QUICK

DB2 Universal Database Personal
Edition Quick Beginnings

REPLICATION-GUIDE

Replication Guide and Reference

INSTALLING_CONFIGURING_CLIENTS

Installing and Configuring DB2 Clients

e AUTO _CTRL_CENTER

Specifies whether or not to automatically start the Control Center each time

the system is rebooted.

Note:
parameter is set to NO.

e AUTOSTART_CCA
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Specifies whether or not to automatically start the Client Configuration
Assistant each time the system is rebooted.

Note: By default the Client Configuration Assistant will be automatically
started unless this parameter is set to NO.

¢ Install DB2 products only on a drive which is local to the target
workstation. Installing on a non-local drive can cause performance and
availability problems.

¢ By default, the name of the response file will be used to determine the
products to be installed. You can override this setting by providing one
or more PROD parameter values in the response file.

4 Exit the file. If you have made any changes, save the file under a new file name
to preserve the original sample response file.

If you are installing directly from the CD-ROM, you must store the renamed
response file on another drive.

Step 3. Run Setup from the Workstation

To perform the installation:

1 At the workstation where DB2 will be installed, logon as a username that meets
the requirements for installing DB2. See “Creating Usernames for DB2 Installation
and Operation” on page 190 for more information.

2 If performing a remote install, connect to the shared directory of the code server
hard disk, or to the CD-ROM drive, using a command similar to the following:

net use e: \\machine\directory
where:

e eis the drive letter used to connect to the shared directory on the server's
hard disk or CD-ROM drive.

e machine is the machine name of the code server.

e directory is the share name of the code server or CD-ROM drive.

For example, type:
net use e: \\codeserv\db2nt

Based on the example set up in previous steps, this points to g:\db2prods on the
code server.

3 Run the setup program:
a Click on Start and select Run.

b In the Open Window, type the path to the setup program. The path accepts
the following command line arguments:
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»—ﬁi setup— /U drive:path\responsefile ———»
drive:\path

A\
\
A

L/L dr‘1’ve:path\1ogf1’1eJ L/I 1anguageJ

Specify the fully qualified path to invoke the program. For example:
e:\setup /U d:\db2\common\db2setup.rsp /L db2log.log /I language
where:

/U Specifies the fully qualified response file name. If you changed and
renamed the sample response file provided, make sure this parameter
matches the new name.

/L Specifies the fully qualified log file name, where setup information and
any errors occurring during setup are logged.

If you do not specify the log file's name, DB2 names it db2.log, and
stores it in a directory called db2log, on the drive on which your
operating system is installed.

/l Specifies the two-character country code that represents your
language (for example, EN for English). Table 16 on page 256 lists
the code for each available language.

If you do not specify the language, setup will determine the system
language, and launch the appropriate DB2 install for that language.

C Click on OK to start the setup program.
d The installation proceeds without further action on your part.

4 Check the messages in the log file when the installation finishes.

For information on errors encountered during product installation, see the
db2.log file. The db2.log file stores general information and error messages
resulting from installation and uninstall activities. By default, the db2.log is
located in the x:\db2log directory; where x: is the drive on which your
operating system is installed.

5 Following installation, you must reboot the workstation before using DB2.

Note: If you specified REBOOT=yes in your response file, the workstation will
reboot automatically.

To configure your client to access remote servers, go to Chapter 28, “Administering Clients Using
the CCA” on page 209.
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Installing DB2 Products Remotely Using
SMS

With Microsoft Systems Management Server (SMS), you can install DB2 products
across a network onto remote Windows NT systems, setting up the installation from a
central location.

You can also use SMS to remove all DB2 products from a target
workstation. Simply follow the instructions below, but when creating the
SMS package, select Uninstall DB2 Products instead of selecting the
packages to be installed.

To install DB2 products via SMS, perform the steps in the following sections:
e “Step 1. Make DB2 Files Available for Installation” on page 199
e “Step 2. Create a Response File for Unattended Installation” on page 201
e “Step 3. Import the DB2 Install Files into SMS” on page 205
e “Step 4. Distribute the DB2 Installation Package Using SMS” on page 205
e “Step 5. Run the Installation on the SMS Client” on page 206

Before You Begin

Read and perform the steps in this section before you begin the installation to ensure
that you have the required items and information you will need.

Creating Usernames for DB2 Installation and
Operation

This section describes usernames required to install the DB2 product and its
components.

Creating a Username for Installing DB2 Products:

Windows 95 The username must be a valid DB2 username.

A valid DB2 username is eight characters or less, and complies with
DB2's naming rules. For more information on DB2's naming rules, see
Appendix C, “Naming Rules” on page 265.
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Windows NT You need to have a username that will be used to install DB2. The
username must belong to the Administrators group, and also be a valid
DB2 username or have the "Act as part of the operating system"
advanced user right.

A valid DB2 username is eight characters or less, and complies with
DB2's naming rules. For more information on DB2's naming rules, see
Appendix C, “Naming Rules” on page 265.

If this username does not comply with DB2's naming rules, but has the
"Act as part of the operating system" advanced user right, the setup
program will create the username DB2ADMIN to perform the installation.

On clients, this username will be removed from the system when the
installation is complete.

SMS Requirements

SMS must already be installed and configured on your network. Refer to Microsoft's
Systems Management Server for Windows NT Administrator's Guide for information on
how to:

e Set up SMS (including setting up primary and secondary sites).
e Add clients to the SMS system.
e Set up inventory collection for clients.

To create an SMS package that copies the required files directly from the CD-ROM, insert the
appropriate CD-ROM into the drive and go to “Step 2. Create a Response File for Unattended
Installation” on page 201.

Step 1. Make DBZ2 Files Available for Installation

To make the DB2 install files accessible to the machine where DB2 will be installed:

¢ If performing remote installs directly from the CD-ROM:
1 Insert the appropriate CD-ROM into the drive.

2 Ensure that the CD-ROM will remain in the drive for as long as it is needed
for the install. If the drive is often used for other tasks as well, consider
installing from the code server hard disk instead.

e If installing from a code server, you must copy the required files from the CD-ROM
directories to the code server's hard disk:

1 Insert the appropriate CD-ROM into the drive.
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2 Create a directory on the code server, for example, g:\db2prods.

3 At the command prompt, use the cpysetup.bat command to copy the files
necessary for a particular language install to a code server.

The command syntax is:
x:\db2\winnt95\common\cpysetup.bat g:\db2prods language

where:

— x s the letter that designates your CD-ROM drive

— g s the letter that designates the code server's disk.

— language is the two-character country code that represents your
language (for example, EN for English). Table 16 on page 256

If performing a remote installation, you must enable your network clients to access the
DB2 install files.

Grant shared access to the directory that you just created, or to the CD-ROM drive.

To set up a share:
Click on Start and select Programs ->Windows Explorer .
Select the directory that you want to share, for example g:\db2prods.

Select Files ->Properties from the menu bar. The properties window for the
directory will open. Click on the Sharing tab.

Select the Shared As radio button.
In the Share Name field type a share name. For example, type db2nt.
To specify read access for everyone on Windows NT:

a Select the Permissions push button. The Access Through Share
Permissions window opens.

b In the Name box, make sure that Everyone is selected.
C In the Type of Access box, select Read.

d Click on OK.

On Windows 95, you do not need to specify type of access when you set up a
share. By default, everyone is allowed read access.

In our example scenario, g:\db2prods uses a share name of db2nt. We will use this
value in the examples that follow.
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Step 2. Create a Response File for Unattended
Installation

During an interactive installation, you provide the information needed to install the DB2
product and configure its environment. During an unattended installation, this
information is provided as keywords and values in a response file. DB2's install
package includes a number of ready-to-use sample response files, with default entries
already in place.

The sample response files are located in the x:\\db2\winnt95\common directory,

where x is the letter that designates the CD-ROM drive. There is a different response
file for each product on the CD, so that the user has a valid list of parameters for each
product.

If you intend to use the sample response file provided, without making any changes to its values,
you can skip this step and go to “Step 4. Distribute the DB2 Installation Package Using SMS” on
page 205.

Edit the sample response file using your favorite editor. For example, you can use
Notepad or WordPad.

1 Open the sample response file for the package you want to install.

e db2conpr.rsp for DB2 Connect Personal Edition

2 The response file contains:
¢ Keywords unique to installation
e Environment variable/registry value settings

e Database manager configuration parameter settings.

For more information on:

¢ DB2 environment variables and registry values, see “DB2 Registry
Values and Environment Variables” on page 162, or refer to the
Administration Guide.

¢ Database manager configuration parameters, refer to the Administration
Guide.

3 To activate an item in the response file, remove the asterisk (*) to the left of the
keyword/registry value, erase the current setting to the right of the value and type
in a new setting. The possible settings are listed to the right of the current setting.

An example section of a response file appears below:
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FILE

= c:\sqllib
REBOOT = No
*COMP = Control Center

Keywords unique to installation are parameters that are only specified in a
response file during an unattended installation. The following is a list of keywords
unique to installation for Windows 95 and Windows NT unattended installation:

e FILE
Specifies the destination directory for DB2.

Note: Check the value for the FILE keyword. FILE specifies where to install
the product. If you do not change this value, it defaults to x:\sqllib
where x is the drive on which your operating system is installed.

e REBOOT

Specifies whether to reboot the system following installation.
e TYPE

Specifies the type of install. The options are:

0=Compact
1=Typical (default)
2=Custom

For 0 and 1 (compact and typical), any COMP value will be ignored.

For all types, default communication values will be used where applicable, as
follows:

a DB2.DB2COMM and ADMIN.DB2COMM will be set for the protocols detected
on your system.

b If a protocol is detected on the system, or if you have specified values
for DB2.DB2COMM or ADMIN.DB2COMM, values for its parameters will be
generated so that the protocol will be enabled for DB2's use at the end
of the install. Checks are made to ensure that the generated values are
not duplicates, and that they conform to the protocols set up on your
system. Default values will be generated for the following:

— For NetBIOS:
DB2.DB2NBADAPTERS ADMIN.DB2NBADAPTERS
DB2 .NNAME ADMIN.NNAME

— For TCPI/IP:
DB2.PORTNUMBER ADMIN.PORTNUMBER
DB2.SVCENAME ADMIN.SVCENAME

— For IPX/SPX:
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DB2.FILESERVER
DB2.0BJECTNAME
DB2.IPX_SOCKET

— For APPC:
DB2.TPNAME

ADMIN.FILESERVER
ADMIN.OBJECTNAME
ADMIN.IPX_SOCKET

ADMIN. TPNAME

Note: You may override these values; however, if the associated
protocol has not been detected or specified, the values will not

be used.
s PROD

Specifies the product you want installed. The options are:
— CONNECT_PERSONAL for DB2 Connect Personal Edition

Note: This parameter can be used more than once.

* COMP

Specifies the components you want installed. Components required for a
product are installed automatically. Components that are not available are

ignored.

Note: Component selections have no effect unless you specify a custom

installation.

The following table lists COMP keywords and the components they represent.

Table 13 (Page 1 of 2). Component Keywords for Windows 95 and Windows NT

Unattended Install

Keyword

Component

Product Components

GRAPHICAL_TOOLS

Graphical Tools

CLIENT_CONFIGURATION_ASSISTANT

Client Configuration Assistant

CONTROL_CENTER

Control Center

PERFORMANCE_MONITOR

Performance Monitor

VISUAL_EXPLAIN

Visual Explain

ODBC-DRIVER

DB2 ODBC Driver

SAMPLE_APPLICATIONS

Sample Applications

CONNECT_SUPPORT

Connect Support

SNA_SUPPORT

Integrated SNA Support

JAPANESE_CONVERSION

Japanese Conversion Support

KOREAN_CONVERSION

Korean Conversion Support

T_CHINESE_CONVERSION

Traditional Chinese Conversion Support

S_CHINESE_CONVERSION

Simplified Chinese Conversion Support
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Table 13 (Page 2 of 2). Component Keywords for Windows 95 and Windows NT

Unattended Install

Keyword

Component

DB2 Books

API_REFERENCE

API Reference

ADMINISTRATION_GUIDE

Administration Guide

ADMINISTRATION_GETTING_STARTED

Administration Getting Started

DB2_PROGRAMMING_GETTING_STARTED

Road Map to DB2 Programming

BUILDING_OS2_WIN_APPLICATIONS

Building Applications for Windows and
0S/2 Environments

CLI_GUIDE_REFERENCE

CLI Guide and Reference

COMMAND_REFERENCE

Command Reference

CONNECT_PERSONAL_QUICK

DB2 Connect Personal Edition Quick
Beginnings

CONNECT_USERS_GUIDE

DB2 Connect User's Guide

UNIVERSAL_DB_QUICK

DB2 Universal Database Quick
Beginnings

SQL_PROGRAMMING_GUIDE

Embedded SQL Programming Guide

GLOSSARY

Glossary

MASTER_INDEX

Master Index

MESSAGES_REFERENCE

Message Reference

SQL_GETTING_STARTED

SQL Getting Started

SQL_REFERENCE

SQL Reference

SYSTEM_MONITOR_GUIDE

System Monitor Guide and Reference

CONNECT_ENTERPRISE_QUICK

DB2 Connect Enterprise Edition Quick
Beginnings

TROUBLE_SHOOTING_GUIDE

Troubleshooting Guide

CONNECTIVITY_SUPPLEMENT

DB2 Connectivity Supplement

UNIVERSAL_DB_PERSONAL_QUICK

DB2 Universal Database Personal
Edition Quick Beginnings

REPLICATION-GUIDE

Replication Guide and Reference

INSTALLING_CONFIGURING_CLIENTS

Installing and Configuring DB2 Clients

e AUTO _CTRL_CENTER

Specifies whether or not to automatically start the Control Center each time

the system is rebooted.

Note:
parameter is set to NO.

e AUTOSTART_CCA
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Specifies whether or not to automatically start the Client Configuration
Assistant each time the system is rebooted.

Note: By default the Client Configuration Assistant will be automatically
started unless this parameter is set to NO.

¢ Install DB2 products only on a drive which is local to the target
workstation. Installing on a non-local drive can cause performance and
availability problems.

¢ By default, the name of the response file will be used to determine the
products to be installed. You can override this setting by providing one
or more PROD parameter values in the response file.

4 Exit the file. If you have made any changes, save the file under a new file name
to preserve the original sample response file.

If you are installing directly from the CD-ROM, you must store the renamed
response file on another drive.

Step 3. Import the DBZ2 Install Files into SMS

To import the DB2 install files into SMS:
1 Insert the appropriate CD-ROM into the drive.
2 Double-click on the Systems Management Server folder.

3 Double-click on the SMS Administrator icon. The SMS Administrator window
opens.

Select File->New from the menu bar. The Package Properties window opens.
Click on the Import push button. The File Browser opens.

In the File Name field, select the db2.pdf file located in the
x:\db2\winnt95\common directory,where x is the letter that designates your
CD-ROM drive.

Step 4. Distribute the DBZ2 Installation Package
Using SMS

In this step, you create an SMS package and send it to the SMS client where you want
to install DB2.

To create the SMS package:
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1 From the Package Properties window, click on the Workstations push button.
The Setup Package For Workstations window opens, showing a list of predefined
DB2 installation packages that you can use.

2 In the Source Directory field, type the name of the parent directory where you
put the copied DB2 files (q:\db2prods in the example above).

3 Select the name of the product to install from the Workstation Command Lines
list.

4 If you changed and renamed the sample response file, click on the Properties
push button and change the value of the parameter to match the new response
file name.

If you do not specify the language, setup will determine the system language, and
launch the appropriate DB2 install for that language. If want to install a different
language, use the /I parameter to specifies the two-character code that represents
your language (for example, EN for English). Table 16 on page 256 lists the code
for each available language.

Click on the Close push button.

Click on OK to close the opened windows.

The Packages window shows the name of the new SMS package.
7 Specify where to run the package:
a Open the Sites and Packages windows.

b In the Packages window, select the appropriate package and drag it onto
the target client in the Sites window. The Job Details window opens.

C Select the Run Workstation Command check box and select the
installation package that you want to use for the Run Command on
Workstation job. For more information about completing the Job Details
window, refer to Microsoft's Systems Management Server for Windows NT
Administrator's Guide.

d When the job specifications are complete, click on OK to close the opened
windows.

The job is created and sent to the SMS client.

Step 5. Run the Installation on the SMS Client

Now that the remote installation package has been prepared and sent, the SMS client
on the target machine can run the installation.

1 On the SMS client where DB2 will be installed, logon as a username that meets
the requirements for installing DB2. See “Creating Usernames for DB2 Installation
and Operation” on page 198 for more information.
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Double-click on the SMS Client folder.

3 Double-click on the Package Command Manager icon. The Package Command
Manager window opens.

4 When packages are sent from the SMS server, they are listed in the window.
Select the DB2 package, then click on the Execute push button. The installation
runs automatically.

5 Following installation, you must reboot the SMS client before using DB2.

Note: If you specified REBOOT=yes in your response file the SMS client will
reboot automatically.

To configure your client to access remote servers, go to Chapter 28, “Administering Clients Using
the CCA” on page 209.
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Chapter 28. Administering Clients Using
the CCA

Use the information in this section to use the Client Configuration Assistant to perform
administration tasks on 0OS/2, Windows 95, and Windows NT workstations.

Read this section if:

¢ You have an 0OS/2, Windows 95, or Windows NT workstation.

¢ You have installed the Client Configuration Assistant option and want to administer
your clients.

¢ You want to configure DB2 Connect Personal Edition to act as a DB2 client and
access information from a DB2 Universal Database server.

This section describes how you configure DB2 Connect Personal Edition to act as a
DB2 client and access information from remote DB2 servers. If you do not intend to use
this feature, you can ignore this section.

The CCA can be installed on 0OS/2, Windows 95, and Windows NT
workstations. If it is not installed on your system, you can install it by
reinstalling the DB2 product and choosing to install the CCA.

With the CCA, you can:

e Configure database connections that applications can use.

e Update or delete existing configured database connections.

¢ Display the information for existing configured connections.

e Test a connection to a database.

e Enable or disable database connections to be configured as CLI/ODBC data
sources.

¢ Import or export client profiles which contain information for the setup of a client.

¢ Update client configuration settings.

¢ Discover remote databases (if enabled).

e Bind user applications and utilities to databases.
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Configuring Database Connections

To complete the steps in this section, you must be logged on to the local
system as a user with System Administrative (SYSADM) authority on the
instance.

You can configure database connections through the Add Database SmartGuide, by:

¢ Using a profile as a source of information to add database connections, see “Using an Access
Profile.”

e Searching the network for databases, see “Searching the Network for Databases” on
page 213.

¢ Adding database connections manually, see “Manually Configure a Connection to a DB2
Database” on page 218.

Each of these is covered in more detail in the material that follows.

Using an Access Profile

210

You can use either a Server profile or a Client profile to configure database connections
on a client.

Server Profiles

Server profiles can be generated for a DB2 server. They contain information about
instances on the server system, and databases within each instance. The information
for each instance includes the protocol information required to set up a client to connect
to databases in that instance.

To generate server profiles, use the Generate Access Profile function provided in the
Control Center. When a profile is generated for a DB2 server system, it includes server
instances that have the discover_inst configuration parameter set to ENABLE, and
databases with the discover_db configuration parameter set to ENABLE. The discover
parameter, in the Administration Server, must be set to either SEARCH or KNOWN to
generate a profile for a server system.

For information on setting the discover _inst, discover_db and discover configuration
parameters, see “Setting Discovery Parameters” on page 217.

Generating a Server Profile:  To generate an access profile, perform the following
steps:

1 start the Control Center.
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Click on the [+] sign beside the Systems icon to get a list of systems.
Select the system to be profiled and click on the right mouse button.

Select the Generate access profile option.

ga b~ W N

Select the path and type in a file name for the profile, then click on the Generate
push button.

To process a server profile and add its databases to the client's connection
configuration list, use the Client Configuration Assistant's Import or Add functions. Using
the Add function is the preferred method.

Using a Server Profile on the Client: To add a database using the Add function:
1 start the Client Configuration Assistant (CCA).
2 Click on the Add push button.

3 Select the Use an Access Profile radio button, and click on the Next push
button.

4 Click on the Browse push button to select the server profile that you want to
access, or enter the path and filename in the File field.

Select a database to be added.

If desired, you can select the Alias and ODBC tabs at the top of the panel to
specify a database alias name for the database, or to select CLI/ODBC options
for the database. This step is optional.

Click on the Done push button.

8 You can test the connection that has been added by clicking on the Test
Connection push button.

Client Profiles

Information in Client profiles can be added to the client through the following:

¢ Using the Add function, which allows you to selectively process the database
connection data in the client profile and add it to the client. (This function invokes
the Add Database SmartGuide.)

¢ Using the Import function, which allows you to selectively process database
connection data, client configuration settings, and CLI/ODBC common parameters.

Note: This scenario assumes that the database connections configured on one client
will be exported and used to set up one or more additional clients.

Exporting a Client Profile:  Client profiles are generated from clients using the Export
function of the CCA. Use the export function to copy the database information used by
one client to other clients.
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The information contained in a client profile is determined during the export process.
Depending on the settings chosen, it can contain the existing client's:

e Database connection information (including CLI/ODBC settings).

¢ Client settings (including database manager configuration parameters).
e CLI/ODBC common parameters.

e Configuration data for the local APPC communications subsystem.

Export can be used to generate a customized profile that can be imported on another
client to set it up initially, or to update it.

To export a profile from the client, configure the client for communications and do the
following:

1 Enter db2cca admin at a command prompt to start the Client Configuration
Assistant in administrator mode. (You must be an administrator on the local
system to perform this command.)

The Export function of the CCA is only available when the CCA is started in
administrator mode. The CCA can be started in administrator mode by
modifying the Client Configuration Assistant  icon to add the parameter
admin to the startup of the CCA, or by issuing the db2cca admin

command.

Click on the Export push button.

3 Select the databases to be exported from the Available DB2 Databases window,
and add them to the Databases to be exported window.

4 Select the check boxes that correspond to the options that you want to set up for
the target client:

¢ Client Settings
e CLI/ODBC Common parameters
e APPC local stack configuration

To customize settings, click on the appropriate Customize push button. The
settings that you customize will only affect the profile to be exported, no changes
will be made to your workstation. For more information, click on the Help push
button.

5 Click on OK.

Enter a path and file name for the Client profile.
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Importing a Client Profile:

The Import function can be used to easily set up new client systems. The
Import function works as follows:

Client Settings
Configuration parameters found in the export file replace existing ones on
the client; all other parameters are set to default.

CLI/ODBC Common Parameters
Values found in the exported file replace those on the client.

Local Configuration Data for the APPC Communications Subsystem
If it is not already configured, this information is used to configure the APPC
communications subsystem.

Perform these steps at the client that you want to set up. You can use this process to
initially set up a new client, or to update an existing one.

1
2
3

Start the Client Configuration Assistant (CCA).
Click on the Import push button.

Select the path and filename of the client profile you want to import and click on
OK.

The Import Client Profile window opens. Select the items you want to import. For
more information, click on the Help push button.

Click on OK.

If databases are contained in the client profile that you are importing, and
you select to import them, the Add Database SmartGuide starts to allow you
to selectively import the databases you want to connect to.

Searching the Network for Databases

Instead of entering protocol information to make a connection to remote database
servers, you can use the CCA to find all the databases on your local network by
following these steps:

The following scenario assumes that the installation defaults on the client
and the server have not been changed, and that messages used by the
Search method of discovery are not filtered by your network.

Start the Client Configuration Assistant (CCA).

Click on the Add push button on the CCA's main panel to start the Add Database
SmartGuide.

Select the Search the network radio button, and click on the Next push button.
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4 Click on the [+] sign beside the Known Systems icon to list all the systems
known to your workstation.

a Click on the [+] sign beside the system to get a list of the instances and
databases on it. Select the database that you want to add and proceed to
Step 5.

b If the system that contains the database that you want is not listed, click on
the [+] sign beside the Other Systems (Search the network) icon to
search the network for additional systems. Click on the [+] sign beside the
system to get a list of the instances and databases on it. Select the
database that you want to add and proceed to Step 5.

C If the system you want is still not listed, it can be added to the list of
systems by clicking on the Add Systems push button.

5 If desired, you can select the Alias and ODBC tabs at the top of the panel to
specify a database alias name for the database, or to select CLI/ODBC options
for the database. This step is optional.

6 Click on the Done push button.

7 You can test the connection that has been added by clicking on the Test
Connection push button.

Searching the network can be customized to meet the needs of individual
organizations. The material that follows provides details on this customization. Refer to
the Administration Guide for more information on individual configuration parameters
and profile registry values.

Choosing a Discovery Method

Network searching uses a DB2 facility called Discovery to obtain information from DB2
servers. This information is used to configure clients for database connections. Two
discovery methods are available for searching the network:

¢ Known

Known discovery allows you to discover instances and databases on systems that
are known to your client, and add new systems so that their instances and
databases can be discovered; however, it does not support searching the network
for servers.

Click on the [+] sign beside the Known Systems icon to get a list of known DB2
server systems. Click on the [+] sign beside the system to get a list of the
instances and databases on it. Select the database that you want to add and
complete the other panels in the Add Database SmartGuide.

Initially, the list of systems will be blank; however, if you are running the CCA on
the server, an entry for the local server will be shown. Add systems to the list by

214 DB2 Connect Personal Edition Quick Beginnings



clicking on the Add System push button. To use this option you must know a few
details about the Administration Server on the DB2 system to be searched:

— A protocol configured and running on the administration server.
— The protocol's configuration information.

The Administration Server will listen for KNOWN discovery requests, from clients,
on the protocols specified by the DB2COMM registry value in the Administration
Server.

e Search

This mode provides all of the facilities of Known discovery, and adds the option to
allow your local network to be searched for DB2 servers.

Searching does not require information about the Administration Server. When you
click on the [+] sign beside the Other Systems (Search the network) icon, a list
of DB2 server systems is displayed. Click on the [+] beside the system to get a list
of the instances and databases on it. Select the database that you want to add and
complete the other panels in the Add Database SmartGuide.

Search may appear to be a simpler discovery method. However, in larger
networks, network routers and bridges can filter the messages search uses
to find DB2 servers on the network, resulting in an incomplete or even
empty list. In this case, use the Add System method; its messages are not
filtered by routers and bridges. If in doubt, contact your network
administrator for assistance.

To have the server support Known discovery, set the discover parameter in the
Administration Server to KNOWN. To have it support Search discovery, set this
parameter to SEARCH. To prevent discovery of the server, and all of its instances and
databases, set discover to DISABLE.

On the client, enabling discovery is also done using the discover parameter; however,
in this case, the discover parameter is set in the client instance (or a server acting as a
client) as follows:

KNOWN Allows the CCA to refresh systems in the known list, and to add new
systems to the list by using the Add Systems button. When discover is set
to KNOWN, the CCA will not be able to search the network.

SEARCH Enables all the facilities of the KNOWN setting, and enables network
searching.

DISABLE Disables discovery. In this case, the Search the network option is not
available in the Add Database SmartGuide.

Servers configured with discover set to KNOWN, will not respond to search
requests from clients. It is important that you consider this when changing
the discover parameter, which was set to SEARCH during the installation.
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Additional Settings for SEARCH Discovery

Search discovery requires that the configuration parameter discover_comm be set on
both the server (in the Administration Server's configuration file) and the client (in the
database manager configuration file).

The discover_comm parameter is used to control the communication protocols that the
server will listen on for search requests from clients, and that clients will use to send
out search requests. The discover_comm parameter can be any combination of TCP/IP
and NetBIOS; the protocols supported by SEARCH discovery.

On the server, the values specified by discover_comm must be equal to, or a subset, of
the values set by db2comm for the Administration Server.

Check the settings for the DB2COMM registry value by issuing the db2set
DB2COMM command. For more information, see Chapter 24, “Controlling
Your DB2 Environment” on page 157.

On the server, discover_comm is set in the Administration Server. On the client (or a
server acting as a client), discover_comm is set in the instance.

Note: When using discovery search mode, at least one protocol specified by the
discover_comm parameter on the client must match those specified by
discover_comm on the Administration Server. If there is no match, the server
will not respond to the client's requests.

In addition, there are two DB2 profile registry values that can be used to tune search
discovery on the client: db2discoverytime and db2nbdiscoverrcvbufs. The default values
should be suitable in most cases. For more information, refer to the Administration
Guide.

Hiding Server Instances and Databases from
Discovery

You may have multiple instances, and multiple databases within these instances, on a
server. You may want to hide some of these from the discovery process.

To allow clients to discover server instances on a system, set the discover_inst
database manager configuration parameter in each server instance on the system to
ENABLE (this is the default value). Set this parameter to DISABLE to hide this instance
and its databases from discovery.

To allow a database to be discovered from a client, set the discover_db database
configuration parameter to ENABLE (this is the default value). Set this parameter to
DISABLE to hide the database from discovery.
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Setting Discovery Parameters

discover and discover_comm
The discover and discover_comm parameters are set in the Administration Server on
the server system, and in the client instance. Set these parameters as follows:

¢ On the Administration Server:

Update the Administration Server's configuration file, in the command line
processor, as follows:

update admin cfg using discover [ DISABLE | KNOWN | SEARCH ]
update admin cfg using discover comm [ NETBIOS | TCPIP ]
db2admin stop

db2admin start

Note: Search Discovery will only operate on TCP/IP and NetBIOS.

¢ On the client:
1 start the Client Configuration Assistant (CCA).
Click on the Client Settings push button.

Select the Communications tab

A WD

Select and change the parameters that you want to modify in the Parameters
window.

If the discover_comm includes netbios, you must ensure that the
Workstation name (nname) parameter is set for the both the client and the
Administration Server. Also, you must ensure that the db2nbadapters
registry value is set to the Adapter number that you want to use. For more
information, refer to the Administration Guide.

discover_inst and discover_db
Use the Control Center to set the discover_inst and discover_db parameters. To set
these parameters, follow these steps:

1 Start the Control Center.

2 Select the instance that you want to configure and click on the right mouse
button.

3 Select the Configure option from the pop-up menu. The Configuration window
opens.

Select the Environment tab and select the discover_inst parameter.
Enter the desired value in the Value box and click on OK.

Select the database that you want to configure and click on the right mouse
button.
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9

Select the Configure option from the pop-up menu. The Configuration window
opens.

Select the Environment tab and select the discover_db parameter.

Enter the desired value in the Value box and click on OK.

discoverytime and db2nbdiscoverrcvbufs

The

db2discoverytime and db2nbdiscoverrcvbufs profile registry values are set in the

client instance (or a server acting as a client). Set these parameters as follows:

To set the db2discoverytime registry value to 35 seconds, enter the following
command:

db2set db2discoverytime=35

This specifies that the searched discovery should wait 35 seconds for a response
from servers.

To set the db2nbdiscoverrcvbufs registry value to 10, enter the following command:
db2set db2nbdiscoverrcvbufs=10

This specifies the number of NetBIOS buffers that will be allocated for response
messages from discovered servers.

Manually Configure a Connection to a DB2

Database

Manually configuring a database connection requires you to know:

One of the protocols supported by the server instance containing the database.
The protocol connection information required to configure the connection to the
server instance.

The name of the database on the server system.

With this information, the SmartGuide will guide you through the steps necessary to add
the database connection.

1
2

Start the Client Configuration Assistant (CCA).

Click on the Add push button on CCA's main panel to start the Add Database
SmartGuide.

Select the Manually configure a connection to a DB2 database radio button,
and click on the Next push button.

Select the protocol that you will use to connect to the database. Click on the Next
push button.

Type in the required protocol parameters. Click on the Next push button.

Type in the name of the database in the Target database field.
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7 If desired, you can select the Alias and ODBC tabs at the top of the panel to
specify a database alias name for the database, or to select CLI/ODBC options
for the database. This step is optional.

8 Click on the Done push button.

9 You can test the connection that has been added by clicking on the Test
Connection push button.
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Part 8. Configuring DRDA Hosts
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Chapter 29. Configuring DRDA Hosts for
DB2 Connect

This chapter details steps to be taken by your network or system administrator and your
DB2 administrator in order for you to be able to successfully connect DB2 Connect to a
DRDA application server (AS) on an MVS or OS/390 DRDA host.

Note that the steps listed in this chapter must be performed by users who have the
necessary privileged system access and special expertise. You should make this
information available to your support staff if required.

This section also provides some information for DB2 for AS/400 users, and pointers to
additional information sources for MVS, OS/390, OS/400, VM, and VSE users, as
follows:

DB2 for OS/390 Version 5 Installation Guide, GC26-8970 contains the most
complete and up to date information for DB2 for OS/390.

Information about how to set up DB2 Universal Database as a DRDA AS is
provided in the Quick Beginnings manuals for DB2 Universal Database products.

Selected information about how to set up an MVS, 0S/390, 0OS/400, VM, or VSE
system as a DRDA AS for use over SNA connections with the DB2 Connect DRDA
application requester (AR) is provided with DB2 Connect in the DB2 Connectivity
Supplement.

More information about how to set up an MVS, 0S/390, OS/400, VM, or VSE
system as a DRDA AR for use with DB2 Universal Database DRDA AS is also
provided in the DB2 Connectivity Supplement.

Distributed Relational Database Cross Platform Connectivity and Applications,
SG24-4311 contains useful post-configuration information.

The examples in this chapter match those provided elsewhere in this book. When you
use these examples you must substitute your own values for elements such as network
name, LU name, and mode name.
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Preparing MVVS/ESA or OS/390 for DB2
Connect

Your VTAM administrator and your host system administrator must configure VTAM and
0S/390 (or MVS/ESA) to prepare DB2 for OS/390 (or DB2 for MVS/ESA) to receive
inbound connection requests from your DB2 Connect workstation.

This section provides:

e Examples of VTAM definitions required at your DB2 for OS/390 host for use with
DB2 Connect SNA connections. These should be compared with current
definitions. See “Configuring VTAM” on page 225.

¢ Instructions for establishing TCP/IP network connections between DB2 Connect
and DB2 for 0OS/390. See “Configuring TCP/IP for DB2 for OS/390” on page 232.
Chapter 18, “Setting up Two-phase Commit using TCP/IP” on page 123 provides
further information on using TCP/IP connections.

e DB2 host configuration steps (see “Configuring DB2 for OS/390” on page 229, or
“Configuring DB2 for MVS/ESA” on page 230). Many details of these steps have
changed with the introduction of DB2 for OS/390 Version 5.1. Most of these steps
apply to SNA users, but some also apply to users who will connect to DB2 for
0S/390 via TCP/IP.

For a summary of the example VTAM names used throughout this book, see “Sample
Network Element Names (VTAM)” on page 225. For TCP/IP names, see “Configuring
TCP/IP for DB2 for OS/390” on page 232.

Summary of Steps

In order to prepare DB2 for OS/390 or DB2 for MVS/ESA to receive connection
requests from DB2 Connect, you must complete the following steps at your DB2 for
0S/390 host:

1 Configure VTAM - see “Configuring VTAM” on page 225, or:

2 Configure TCP/IP - see “Configuring TCP/IP for DB2 for OS/390” on page 232,
or:

3 Configure DB2 for OS/390 or DB2 for MVS/ESA - see “Configuring DB2 for
0S/390” on page 229, or “Configuring DB2 for MVS/ESA” on page 230.
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Configuring VTAM

VTAM needs to be configured only if DB2 Connect will use SNA connections; it is not
required if DB2 Connect will only use TCP/IP database connections (see “Configuring
TCP/IP for DB2 for OS/390” on page 232).

To configure VTAM, your VTAM Administrator needs to determine the names and
options to be used on your system. The following definitions must be provided to
enable the DB2 Connect workstation to connect to the host:

1 The VTAM APPL Definition for DB2 for OS/390 or DB2 for MVS/ESA. (The APPL
name (LU name) for the DB2 subsystem is NYM2DB2 in these examples.)

2 The VTAM PU and LU Definitions for DB2 Connect. (The PU and LU definitions
for the DB2 Connect workstation are NYX1 and NYX1GWO1 respectively in these
examples.)

3 The VTAM Log Mode Definition for DB2. (The log mode entry to be used for the
connection is IBMRDB in these examples.)

The VTAM sample definitions are provided in the sections that follow. These samples
use parameters that match the parameters used elsewhere in this book.

Sample Network Element Names (VTAM)

All the examples in this section use the same names as elsewhere in this book, as
shown in Figure 9 on page 226:
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DB2 Connect GATEWAY:

HOST:

Network ID
Local Node Name
Local Node ID

LU Name

LU Alias

Network ID

Node Name

LU Name
LU Alias

LAN Destination Address :

MODE DEFINITION:

Mode Name

DB2 for MVS/ESA:

SECURITY:

Location

Security Type
Authentication Type

¢ SPIFNET
¢ NYX1 (PU name)
: 05D27509

: SPIFNET.NYX1GWO1 (the same LU is used

for DB2 Connect,
for DB2 Universal Database DRDA-AS,
and for the SPM)

¢ NYX1GWO1

: SPIFNET

. NYX

: SPIFNET.NYM2DB2
: NYM2DB2

400009451902 (NCP TIC address)

: IBMRDB

: NEW_YORK3

: Program
: DCS

Figure 9. Network Element Names Used in the VTAM Examples

Sample VTAM APPL Definition for OS/390

Figure 10 on page 227 lists the sample VTAM application major node definition used
for DB2 for OS/390 in this book. In most cases, such a definition will already exist with
a different LU name.

Otherwise, this application major node must be defined, and DB2 for OS/390 must be
customized in order to use the LU name defined. This name is the Partner LU name
required by DB2 Connect.
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DB2APPLS VBUILD TYPE=APPL

NYM2DB2 APPL

APPC=YES,
AUTH=(ACQ) ,
AUTOSES=1,
DLOGMOD=IBMRDB,
DMINWNL=512,
DMINWNR=512,
DSESSLIM=2048,
EAS=6000,
MODETAB=RDBMODES,
PARSESS=YES,
PRTCT=SFLU,
MODETAB=RDBMODES,
SECACPT=ALREADYV,
SRBEXIT=YES,
VERIFY=NONE,
VPACING=8

DX X > XX X XX X X X X X X X X X

Figure 10. Sample VTAM APPL Definition for DB2 for 0S/390 or DB2 for MVS/ESA

Note: Continuations must begin in column 16, with continuation marks in column 72.

Sample VTAM PU and LU Definitions for DB2

Connect

Figure 11 on page 228 lists the sample VTAM switched major node definition used for

the example DB2 Connect workstation in this book.

If you already use SNA applications on the DB2 Connect workstation, then a PU

definition already exists. However, an independent LU definition might not. The
independent LU definition required for DB2 Connect must have LOCADDR=0 specified.
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SWITCHED MAJOR NODE DEFINITION FOR PU NYX1 and
INDEPENDENT LU NYX1GWO1

LOC300 VBUILD TYPE=LOCAL

NYX1 ADDR=01,IDBLK=071, IDNUM=27509,ANS=CONT,DISCNT=NO, X
IRETRY=YES, ISTATUS=ACTIVE,MAXDATA=4302,MAXOUT=7, X
MAXPATH=1,PUTYPE=2,SECNET=NO,MODETAB=RDBMODES X

SSCPFM=USSSCS,PACING=0,VPACING=2
NYX1GWO1 LOCADDR=000,MODETAB=RDBMODES,DLOGMODE=IBMRDB

OTHERLU ~ LOCADDR=002

Figure 11. Sample VTAM Switched Major Node Definition for DB2 Connect

Alternatively, you can enable DYNPU and DYNLU in VTAM to allow any PU and LU
access through VTAM.

Sample VTAM Log Mode Definition for DB2

Figure 12 on page 229 lists the sample VTAM logon mode table definition IBMRDB
used in this book. Note that this example specifies a 4K RUSIZE, which may not be
suitable for your environment (for example, if you are using Ethernet, which has a
maximum Frame Size of 1536 bytes). Your VTAM Administrator should check these
values and advise you which mode table entry name and RUSIZE to specify for DB2
Connect.
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RDBMODES MODTAB

IBMRDB ~ MODEENT LOGMODE=IBMRDB,  DRDA DEFAULT MODE *
TYPE=0, NEGOTIABLE BIND *
PSNDPAC=X'01", PRIMARY SEND PACING COUNT *
SSNDPAC=X'01", SECONDARY SEND PACING COUNT *
SRCVPAC=X'00", SECONDARY RECEIVE PACING COUNT *
RUSIZES=X'8989", RUSIZES IN-4K OUT-4K *
FMPROF=X'13", LU6.2 FM PROFILE *
TSPROF=X'07", LU6.2 TS PROFILE *
PRIPROT=X'BO', LU6.2 PRIMARY PROTOCOLS *
SECPROT=X'BO', LU6.2 SECONDARY PROTOCOLS *
COMPROT=X'DOB1", LU6.2 COMMON PROTOCOLS *
PSERVIC=X'060200000000000000122F00" LU6.2 LU TYPE

SNASVCMG MODEENT LOGMODE=SNASVCMG, DRDA DEFAULT MODE *
PSNDPAC=X'00", PRIMARY SEND PACING COUNT *
SSNDPAC=X'02", SECONDARY SEND PACING COUNT *
SRCVPAC=X'00", SECONDARY RECEIVE PACING COUNT *
RUSIZES=X'8585", RUSIZES IN-1K 0UT-1K *
FMPROF=X'13", LU6.2 FM PROFILE *
TSPROF=X'07", LU6.2 TS PROFILE *
PRIPROT=X'BO', LU6.2 PRIMARY PROTOCOLS *
SECPROT=X'BO"', LU6.2 SECONDARY PROTOCOLS *
COMPROT=X'DOB1", LU6.2 COMMON PROTOCOLS *

PSERVIC=X'060200000000000000000300" LU6.2 LU TYPE

Figure 12. Sample VTAM Log Mode Definition for DB2 Connect

Note that you must define SNASVCMG when using APPC.

Configuring DB2 for OS/390

Before you can use DB2 Connect, your DB2 for OS/390 Administrator must configure
DB2 for OS/390 to permit connections from the DB2 Connect workstation. This section
indicates the minimum updates required in order to permit the DB2 Connect Application
Requester to make a connection to DB2 for OS/390. More detailed examples can be
found in DB2 Connectivity Supplement, and DB2 for OS/390 Installation Reference.

The following tables need to be updated, depending on the type of connections you are
using (SNA or TCP/IP):

¢ SYSIBM.LUNAMES for SNA connections

¢ SYSIBM.IPNAMES for TCP/IP connections
The sections that follow contain examples of commands to update these tables for DB2

for OS/390. Work with your DB2 Administrator to determine the updates required for
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your DB2 for OS/390 system. The DB2 for OS/390 Communications Database tables
are described in DB2 for 0S/390 SQL Reference.

Updating SYSIBM.LUNAMES

To permit database connection requests to be accepted from any incoming DB2
Connect LU, just insert a blank row. Use an SQL command such as the following:

INSERT INTO SYSIBM.LUNAMES (LUNAME) VALUES (' ")

Alternatively, if you want to restrict access by LU name, you can use an SQL command
such as the following to update this table:

INSERT INTO SYSIBM.LUNAMES (LUNAME,
SECURITY_OUT,

ENCRYPTPSWDS,
USERNAMES)
VALUES('NYX1GWO1','P','N','0");
Result:
COLUMN EXAMPLE REMARK
LUNAME NYX1GWO1 Name of the DB2 Connect LU
SECURITY_OUT P
ENCRYPTPSWDS N
USERNAMES 0

Updating SYSIBM.IPNAMES

If you want to permit inbound database connection requests for TCP/IP nodes, you can
use an SQL command such as the following to update this table:

INSERT INTO SYSIBM.IPNAMES (LINKNAME) VALUES(" ")

Configuring DB2 for MVS/ESA

230

Before you can use the DB2 Connect connection, your DB2 for MVS/ESA Administrator
must configure DB2 for MVS/ESA to permit connections from the DB2 Connect
workstation. To configure DB2 for MVS/ESA, the following tables need to be updated:

¢ SYSIBM.SYSUSERNAMES
e SYSIBM.SYSLUNAMES
e SYSIBM.SYSLUMODES
The sections that follow contain examples of commands to update these tables. Work

with your DB2 Administrator to determine the options required for your DB2 for
MVS/ESA system.
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Updating SYSIBM.SYSUSERNAMES

If you want to use secondary authorization IDs, you can use the following SQL
command to update this table:

INSERT INTO SYSIBM.SYSUSERNAMES VALUES('I','ADBUSER','NYX1GWO1',"' ',"' ');
Result:

COLUMN EXAMPLE REMARK

Type I

Authid ADBUSER

LU Name NYX1GWO1 Name of the DB2 Connect LU

NewAuthID (b1ank)

Password (bTank)

USERNAME types are: O (outbound translation), | (inbound translation), B (both
inbound and outbound) and blank (no authorization ids are translated, and no password
is sent to the server).

Updating SYSIBM.SYSLUNAMES

If you want to restrict access by LU name, you can use an SQL command such as the
following to update this table:

INSERT INTO SYSIBM.SYSLUNAMES VALUES('NYX1GWO1','IBMRDB','A','N',"' ','I');

Result:
COLUMN EXAMPLE REMARK
LUNAME NYX1GWO1 Name of the DB2 Connect LU
SYSMODENAME IBMRDB
USERSECURITY A
ENCRYPTPSWDS N
MODESELECT
USERNAMES I

Alternatively, just insert a blank row, and this will allow any incoming DB2 Connect LUs
to be accepted.

Updating SYSIBM.SYSLUMODES

You can use an SQL command such as the following to update this table:
INSERT INTO SYSIBM.SYSLUMODES VALUES ('NYX1 ', 'IBMRDB', 150, 'Y');
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where:
* NYX1 = PU name of server involved
e |IBMRDB = name of VTAM logon mode
e 150 = max. number of conversations

e Y = number of sessions preallocated at startup. This can also be left as N, or blank
(the default) for deferred at startup.

Configuring TCP/IP for DB2 for OS/390

This section tells you how to configure TCP/IP communications between your DB2
Connect workstation and DRDA servers running DB2 for OS/390 Version 5.1. It
assumes that:

e You are connecting to a single host database via TCP/IP. Multiple host connections
will be handled in exactly the same way, although the port number and service
number required in each case may be different.

¢ The target database resides on DB2 for OS/390 Version 5.1.
e All the necessary software prerequisites are installed.

¢ DB2 clients have been set up as required.

Note: If you want to know how to set up DRDA two-phase commit over TCP/IP
connections, see Chapter 18, “Setting up Two-phase Commit using TCP/IP” on
page 123. This chapter also addresses some migration considerations.

Also, if you do not know this information for the OS/390 or MVS/ESA system
that you are connecting to, consult your system administrator for:

e The host name. You can obtain the host's IP address by entering at the
host:

TSO NETSTAT HOME

e Port numbers available and defined to the DB2 for OS/390 Distributed Data
Facility (DDF). You can check these by looking at DDF startup messages in
the system log. For example:

DSNLOO4I  DDF START COMPLETE
DDF START COMPLETE
LOCATION NEW_YORK3
LU SPIFNET.NYM2DB2
GENERICLU -NONE
DOMAIN mvshost.spifnet.com
TCPPORT 446
RESPORT 5020

These examples use the default port number 446 which has been defined for DRDA.
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Collecting Information

Before you can use DB2 Connect over a TCP/IP connection, you must collect some
information about both the DRDA host and the DB2 Connect workstation. For each

DRDA host server that you are connecting to via TCP/IP, you must know in advance:

The location of the TCP/IP services file at the DB2 Connect workstation:
— On a UNIX system, the location of this file is usually /etc/services.

— On 0OS/2 Warp with IBM TCP/IP for OS/2 Version 3 the location of this file is
usually \mptn\etc\services. If you have LAPS and TCP/IP, the location is
usually \tcpip\etc\services.

— On Windows NT, the location of this file may be
\winnt\system32\drivers\etc\services or \tcpip\etc\services.

The location of the TCP/IP hosts file at the DB2 Connect workstation:
— On a UNIX system, the location of this file is usually /etc/hosts.

— On 0OS/2 Warp with MPTN and IBM TCP/IP for OS/2 Version 3, the location of
this file is usually \mptn\etc\hosts. If you have LAPS and TCP/IP, the location
is usually \tcpip\etc\hosts.

— On Windows NT, the location of this file may be
\winnt35\system32\drivers\etc\hosts, \winnt\system32\drivers\etc\hosts, or
\tcpip\etc\hosts.

You may use a Domain Name Server to avoid maintaining this file on multiple
systems.

The locations of the equivalent files at the target DB2 for OS/390 host.

The TCP/IP port number defined to DB2 for OS/390. (Note that the associated
service name information is not exchanged between the DB2 Connect workstation
and DB2 for OS/390). Port number 446 has been registered for DRDA, and this is
the port number used in these examples.

The TCP/IP addresses and host names for both the host and the DB2 Connect
workstation.

The target database name of the database you will connect to at the DB2 for
0S/390 host. (This is the same as the LOCATION NAME of the database).

The user ID and password to be used when issuing CONNECT requests for the
database at the host.

Refer to your local network administrator and your DB2 for OS/390 administrator for

help getting this information. Use one copy of the example work sheet, Table 14 on

page 235, to plan each TCP/IP connection between DB2 Connect and a DRDA host
server.

Sample Network Scenario:  Figure 13 illustrates the example scenario. The values
used in this diagram correspond to those used in Table 14 on page 235.
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DB2 for OS/390 V5.1

db2con3\} 5678

\TCPIP\ETC\SERVICES

TCP/IP host name = MVSHOST

dbzconsy 5678 TCP/IP address = 9.21.152.100

TCP/IP Target database
name = NEW_YORK3
Service name = db2instic
Port number = 446
DB2 Connect

Enterprise Edition
or Personal Edition

TCP/IP host name = mcook02
TCP/IP address = 9.21.27.179
Service name = db2instic
Port number = 446

Figure 13. Sample scenario for TCP/IP connection to DB2 for OS/390 host
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Example Worksheet

Table 14. Example Worksheet for Planning TCP/IP Connections to DB2 for 0OS/390

User ID

Password

Ref. | Description Sample Value Your Value

User Information

User Name A.D.B.User

Contact Info (123)-456-7890

User ID ADBUSER

Database Type db2390

Connection type (must TCPIP TCPIP
be TCPIP).

Network Elements at the Host

Host name MVSHOST

Host IP address 9.21.152.100

Service name db2instlc

Port number 446

Target database name NEW_YORK3

Network Elements at the DB2 Connect Workstation
Host name mcook02
IP address 9.21.27.179
Service name db2instlc
Port number 446
DB2 Directory Entries (at the DB2 Connect workstation)
Node name MVSIPNOD
TCP-31 Database name nyc3
Database alias mvsipdbl
DCS database name nyc3
TM_DATABASE 1ST_CONN
(recommended)
Notes:

1. If a DB2 Universal Database server is also installed on the same workstation as

DB2 Connect, then the port numbers and service names defined should be the

same: they are shared by DB2 Connect and DB2 Universal Database.

2. Target database name (item 12) is the DB2 for OS/390 LOCATION NAME.

3. TM_DATABASE is required only if you will use two-phase commit.

4. To obtain the host's IP address (item 9), enter at the host:
TSO NETSTAT HOME
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5. To obtain the port number (item 11), look for DSNLOO4I in the DB2 master address

space or system log. Port number 446 has been registered for DRDA, and this is
the port number used in these examples.

Configuring the TCP/IP Connection

Use the manual steps in this section to complete the configuration and make the
connection.

Complete the Worksheet:  Complete a copy of the example worksheet for each
TCP/IP host:

1

Fill in the values to be used for the TCP/IP address and hostname of the DB2 for
0S/390 host (items 8 and 9).

Fill in the values to be used for the TCP/IP address and hostname of the DB2
Connect workstation (items 18 and 19).

Determine the port number or service name to be used for the connection (items
10 and 11, or 20 and 21).

Determine the host database name that you will connect to (the DB2 for OS/390
LOCATION name (item 12).

Determine the values to be used for user ID and PASSWORD when connecting
to the host database.

Determine the value to be used for TM_DATABASE at the DB2 Connect
workstation, item 34. In most cases we recommend 1ST_CONN (the default is
NULL).

Note that some additional planning considerations may apply, for example if you are
using DCE. See the DB2 Connect User's Guide.

Update the DB2 for OS/390 Host: At your DB2 for OS/390 host:

1
2
3

Verify the host address or the host name.
Verify the port number or the service name.

Update the SERVICES file with the correct port number and service name if
necessary.

Update the HOSTS file (or the Domain Name Server used by the DB2 for OS/390
system) with the hostname and IP address of the DB2 Connect workstation if
necessary.

Ensure the new definitions are active before attempting to test the connection.
Refer to your host network administrator or change control staff if necessary.
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6 Check with the DB2 for OS/390 administrator that you have a valid user 1D,
password, and database LOCATION NAME.

7 PING the DB2 Connect workstation, using the correct port number if that option is
supported by TCP/IP on the host system. For example:

ping remote_host_name -p port_number

Update the DB2 Connect Workstation: At your DB2 Connect workstation:

1 Verify the host name. Enter the hostname command at a system prompt. This will
return the TCP/IP host name for the DB2 Connect workstation.
2 Verify the host address. Use the ping command, for example:
ping myhost
This will return the host address.

3 Verify the port number. Examine the TCP/IP services file on the workstation (see
above for location information).

Verify the service name. Same as the previous step.

Update the services file with the correct port number and service name if
necessary.

6 Update the hosts file (or the Domain Name Server used by the DB2 Connect
workstation) with the hostname and IP address of the DB2 for OS/390 system.
This may not need to be done if it has already been defined there. Check with
your network administrator.

7 Ensure the new definitions are active before attempting to test the connection.
Refer to your local network administrator or change control staff if necessary.

8 Check with the local DB2 administrator that you have a valid user ID and
password for use when accessing DB2 Connect. You will need this in order to
update the local Database Manager Configuration, as well as the DB2 Database,
Node, and Data Connection Services directories, prior to issuing a CONNECT
statement for the host database.

9 PING the DB2 for 0S/390 host, using the correct port number if that option is
supported by TCP/IP on the DB2 Connect workstation:

ping MVS_host_name -p port_number
Update the DB2 Connect Configuration: At a command line prompt, issue the
following command to update the Database Manager Configuration:
db2 update dbm config using tm_database "Ist_conn"
where TM_DATABASE can have one of the following settings:

e 1ST_CONN the first database that a connection is established to will be used as
the Transaction Manager database for transactions. If this option is used, then the
first database connected to must be either a DB2 Universal Database Version 5
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database, or a DB2 for OS/390 Version 5.1 database. This is the recommended
setting.

e (database name the named database that is connected to will be used. If this
option is used, we recommend that the named database should be either a DB2
Universal Database Version 5 database, or a DB2 for OS/390 Version 5.1
database.

Note: TM_DATABASE cannot be left to default. If no TM_DATABASE value is
provided then any CONNECT issued will fail with SQLCODE 865. If you want
more information about TM_DATABASE options, refer to Administration Guide.
If you want to know how to set up DRDA Two-phase commit over TCP/IP
connections, refer to Chapter 18, “Setting up Two-phase Commit using TCP/IP”
on page 123.

Update the DB2 Connect Directories
1 Atacommand line prompt, issue the following command to catalog the DB2 for
MVS/ESA node:
db2 catalog tcpip node MVSIPNOD remote MVSHOST server dbs2instlc

where:
e MVSIPNOD is the local DB2 Connect node name to be used for the host.

¢ MVSHOST is the eight-character TCP/IP host name for the DB2 for OS/390
host. TCP/IP name lookup must resolve this name to the correct destination
Internet address, either through an entry in the local hostsfile on the DB2
Connect workstation, or via a Domain Name Server (DNS) referenced by the
DB2 Connect workstation.

e db2instic is either the service name or the port number defined at the DB2
Connect workstation. This must resolve to the same port number as that
defined for use by DB2 Connect at the DB2 for MVS/ESA host.

2 Create entries for the Database and Data Connection Services directories, as
follows (this shows the values used in the sample worksheet):

db2 catalog dcs database NYC3 as NEW_YORK3
db2 catalog database NY(C3 as MVSIPDBI at node MVSIPNOD authentication dcs

where:

e MVSIPDBI1 is the DB2 Connect database alias for the host database.

¢ NYC3is the DB2 Connect database name for the host database.

¢ MVSIPNOD is the DB2 Connect node name for the host.

e NEW_YORKS3is the DB2 for 0OS/390 LOCATION NAME for the target
database.

CONNECT and BIND: Finally, connect to the DRDA Server and bind the utilities and
applications to the DRDA server using commands similar to the following in the
command line processor:
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connect to MVSIPDB1 user USERID using PASSWORD
bind path@ddcsmvs.lst blocking all
sqlerror continue messages ddcsmvs.msg grant public

disconnect all

These commands are described in detail in the Command Reference.

Preparing DB2 for AS/400 for DB2 Connect

DB2 Connect gives applications on remote systems access to data in your DB2 for
AS/400 system. In order to set up the connection, the person installing DB2 Connect
needs the following information:

The local network name. You can get this information by entering DSPNETA.

The local adapter address. You can get this information by entering
WRKLIND (*trlan) .

The mode name. You can get a list of mode names by entering WRKMODD. If the
mode IBMRDB has been defined on your OS/400 system, you should use it.

The local control point name. You can get this information by entering DSPNETA.

The remote transaction program name. The default (defined by DRDA) is
X'07'6DB (X'07F6C4C2'). The default is always used by DB2 for AS/400. If
entering a hexadecimal number is not convenient, an alias is QCNTEDDM.

The relational database name. You can get this information by entering
DSPRDBDIRE. This will display a list. The line containing *LOCAL in the Remote
Location column identifies the RDBNAME which must be defined to the client.

Here is an example screen:
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Display Relational Database Directory Entries
Position to . . . . . .

Type options, press Enter.
5=Display details 6=Print details

Relational Remote
Option Database Location Text

_ DLHX RCHAS2FA
_ JORMT2FA JORMT2FA
B JORMT4FD JORMT4FD
_ JOSNAR7B RCHASR7B
_ RCHASR7B *LOCAL
B RCHASR7C RCHASR7C
_ RCH2PDH3 RCHASDH3
_ R7BDH3SNA RCH2PDH3

RCHASDH3 RCHASDH3

When you have obtained these parameters from OS/400, enter your values into the
worksheet that follows:

Table 15. Configuration Parameters from OS/400
Item Parameter Example Your value
A-1 Local network name SPIFNET
A-2 Local adapter address 400009451902
A-3 Mode name IBMRDB
A-4 Local control point name SYD2101A
A-5 Remote transaction program X'07F6C4C2' (default)
A-6 Relational database name NEW_YORK3

For further information about how to set up DB2 for AS/400 as an application server,
refer to the online DB2 Connectivity Supplement provided with your DB2 Connect
product.

More detailed information can also be found in the DRDA Connectivity Guide.

Preparing DB2 for VSE & VM

For information about how to set up DB2 for VSE & VM as an application server, refer
to the online DB2 Connectivity Supplement.

More detailed information can also be found in the DRDA Connectivity Guide.
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Appendix A. Obtaining Information

Information on the DB2 product is available in several different formats:

¢ Online Help
e PostScript (.ps)
e HTML (.htm)

All books described in this section are also available in printed form. To order printed
versions, contact your IBM authorized dealer or marketing representative, or phone
1-800-879-2755 in the United States or 1-800-IBM-4YOU in Canada.

How the DBZ2 Library Is Structured

The DB2 Universal Database library consists of SmartGuides, online help, and books.
This section describes the information that is provided, and how to access it.

To help you access product information online, DB2 provides the Information Center on
0S/2, Windows 95, and the Windows NT operating systems. You can view task
information, DB2 books, troubleshooting information, sample programs, and DB2
information on the Web. “About the Information Center” on page 250 has more details.

SmartGuides

SmartGuides help you complete some administration tasks by taking you through each
task one step at a time. SmartGuides are available on OS/2, Windows 95, and the
Windows NT operating systems. The following table lists the SmartGuides.

SmartGuide Helps you to... How to Access...
Add Database Catalog a database on a client workstation. From the Client Configuration
Assistant, click on Add.
Create Database Create a database, and to perform some basic From the Control Center, click with the
configuration tasks. right mouse button on the Databases
icon and select Create->New.
Performance Tune the performance of a database by From the Control Center, click with the
Configuration updating configuration parameters to match your right mouse button on the database
business requirements. you want to tune and select Configure
performance .
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SmartGuide Helps you to...

How to Access...

Backup Database

Determine, create, and schedule a backup plan.

From the Control Center, click with the
right mouse button on the database
you want to backup and select
Backup ->Database using

SmartGuide .

Restore Database

to replay.

Recover a database after a failure. It helps you
understand which backup to use, and which logs

From the Control Center, click with the
right mouse button on the database
you want to restore and select
Restore ->Database using

SmartGuide .

Create Table
key for the table.

Select basic data types, and create a primary

From the Control Center, click with the
right mouse button on the Tables icon
and select Create->Table using
SmartGuide .

Create Table Space

Create a new table space.

From the Control Center, click with the
right mouse button on the Table
spaces icon and select Create->Table
space using SmartGuide

Online Help

Online help is available with all DB2 components. The following table describes the

various types of help.

Type of Help

Contents

How to Access...

Command Help

Explains the syntax of
commands in the
command line
processor.

From the command line processor in
interactive mode, enter:

? command

where command is a keyword or the entire
command.

For example, ? catalog displays help for all
the CATALOG commands, whereas ?
catalog database displays help for the
CATALOG DATABASE command.

Control Center
Help

Explains the tasks
you can perform in a
window or notebook.
The help includes
prerequisite
information you need
to know, and
describes how to use
the window or
notebook controls.

From a window or notebook, click on the
Help push button or press the F1 key.

244  DB2 Connect Personal Edition Quick Beginnings



Type of Help Contents How to Access...

Message Help Describes the cause From the command line processor in
of a message interactive mode, enter:
number, and any
action you should
take. where message number is a valid message
number.

For example, ? SQL30081 displays help
about the SQL30081 message.

? message number

To view message help one screen at a time,
enter:

? XXXnnnnn | more

where XXX is the message prefix, such as
SQL, and nnnnn is the message number,
such as 30081.

To save message help in a file, enter:
? XXXnnnnn > filename.ext

where filename.ext is the file where you want
to save the message help.

Note: On UNIX-based systems, enter:
\? XXXnnnnn | more or

\? XXXnnnnn > filename.ext

SQL Help Explains the syntax of From the command line processor in
SQL statements. interactive mode, enter:

help statement
where statement is an SQL statement.

For example, help SELECT displays help
about the SELECT statement.

SQLSTATE Help Explains SQL states From the command line processor in
and class codes. interactive mode, enter:

? sqlstate or ? class-code

where sqlstate is a valid five digit SQL state
and class-code is a valid two digit class
code.

For example, ? 08003 displays help for the
08003 SQL state, whereas ? 08 displays
help for the 08 class code.
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DB2 Books

The table in this section lists the DB2 books. They are divided into two groups:

e Cross-platform books: These books are for DB2 on any of the supported platforms.

¢ Platform-specific books: These books are for DB2 on a specific platform. For
example, there is a separate Quick Beginnings book for DB2 on OS/2, Windows
NT, and UNIX-based operating systems.

Most books are available in HTML and PostScript format, and in hardcopy that you can
order from IBM. The exceptions are noted in the table.

You can obtain DB2 books and access information in a variety of different ways:

View To view an HTML book, you can do the following:

If you are running DB2 administration tools on OS/2, Windows 95, or
the Windows NT operating systems, you can use the Information
Center. “About the Information Center” on page 250 has more details.

Use the open file function of the Web browser supplied by DB2 (or one
of your own) to open the following page:

sqllib/doc/html/index.htm

The page contains descriptions of and links to the DB2 books. The
path is located on the drive where DB2 is installed.

You can also open the page by double-clicking on the DB2 Online
Books icon. Depending on the system you are using, the icon is in the
main product folder or the Windows Start menu.

Search To search for information in the HTML books, you can do the following:

Click on Search the DB2 Books at the bottom of any page in the
HTML books. Use the search form to find a specific topic.

Click on Index at the bottom of any page in an HTML book. Use the
Index to find a specific topic in the book.

Display the Table of Contents or Index of the HTML book, and then
use the find function of the Web browser to find a specific topic in the
book.

Use the bookmark function of the Web browser to quickly return to a
specific topic.

Use the search function of the Information Center to find specific
topics. “About the Information Center” on page 250 has more details.

Print To print a book on a PostScript printer, look for the file name shown in the
table.
Order To order a hardcopy book from IBM, use the form number.
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Book Name

Book Description

Form Number

File Name
Cross-Platform Books

Administration Getting Started Introduces basic DB2 database administration S10J-8154
concepts and tasks, and walks you through the db2kOX50
primary administrative tasks.

Administration Guide Contains information required to design, implement, S10J-8157
and maintain a database to be accessed either locally db2d0x50
or in a client/server environment.

API| Reference Describes the DB2 application programming interfaces S10J-8167
(APIs) and data structures you can use to manage db2b0x50
your databases. Explains how to call APIs from your
applications.

CLI Guide and Reference Explains how to develop applications that access DB2 S10J-8159
databases using the DB2 Call Level Interface, a db210x50
callable SQL interface that is compatible with the
Microsoft ODBC specification.

Command Reference Explains how to use the command line processor, and S10J-8166
describes the DB2 commands you can use to manage db2n0x50
your database.

DB2 Connect Enterprise Edition Provides planning, installing, configuring, and using S10J-7888

Quick Beginnings information for DB2 Connect Enterprise Edition. Also

L . ) 8 db2cyx50
contains installation and setup information for all
supported clients.

DB2 Connect Personal Edition Provides planning, installing, configuring, and using S10J-8162

Quick Beginnings information for DB2 Connect Personal Edition. db2¢1x50

DB2 Connect User's Guide Provides concepts, programming and general using S10J-8163
information about the DB2 Connect products. db2cOX50

DB2 Connectivity Supplement

Provides setup and reference information for
customers who want to use DB2 for AS/400, DB2 for
0S/390, DB2 for MVS, or DB2 for VM as DRDA
Application Requesters with DB2 Universal Database
servers, and customers who want to use DRDA
Application Servers with DB2 Connect (formerly
DDCS) application requesters.

Note: Available in HTML and PostScript formats
only.

No form number
db2h1x50

Embedded SQL Programming
Guide

Explains how to develop applications that access DB2
databases using embedded SQL, and includes
discussions about programming techniques and
performance considerations.

S10J-8158
db2a0x50

Glossary

Provides a comprehensive list of all DB2 terms and
definitions.

Note: Available in HTML format only.

No form number
db2t0x50
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Book Name

Book Description

Form Number

File Name

Installing and Configuring DB2
Clients

Provides installation and setup information for all DB2
Client Application Enablers and DB2 Software

No form number

2
Developer's Kits. db2iyx50
Note: Available in HTML and PostScript formats
only.
Master Index Contains a cross reference to the major topics S10J-8170
covered in the DB2 library. db2WOX50
Note: Available in PostScript format and hardcopy
only.
Message Reference Lists messages and codes issued by DB2, and S10J-8168
describes the actions you should take. db2mOx50
Replication Guide and Reference Provides planning, configuring, administering, and S95H-0999
usmg_lnformauon for the IBM Replication tools db2e0x50
supplied with DB2.
Road Map to DB2 Programming Introduces the different ways your applications can S10J-8155
access DB2, describes key DB2 features you can use
. D . ) db2u0x50
in your applications, and points to detailed sources of
information for DB2 programming.
SQL Getting Started Introduces SQL concepts, and provides examples for S10J-8156
many constructs and tasks. db2y0x50
SQL Reference Describes SQL syntax, semantics, and the rules of the S10J-8165
language. Also |ncl.udes mfo_rr_n.a_tlon about - db2sOX50
release-to-release incompatibilities, product limits, and
catalog views.
System Monitor Guide and Describes how to collect different kinds of information S10J-8164
Reference about your database and the database manager.
; . . db2f0Ox50
Explains how you can use the information to
understand database activity, improve performance,
and determine the cause of problems.
Troubleshooting Guide Helps you determine the source of errors, recover S10J-8169
from problems, and use diagnostic tools in db2p0x50

consultation with DB2 Customer Service.

What's New Describes the new features, functions, and No form number
enhancements in DB2 Universal Database. db2g0x50
Note: Available in HTML and PostScript formats
only.
Platform-Specific Books
Building Applications for UNIX Provides environment setup information and S10J-8161
Environments step_—by-_step instructions to compile, link, and run DB2 db2axx50
applications on a UNIX system.
Building Applications for Provides environment setup information and S10J-8160
Windows and 0S/2 step-by-step instructions to compile, link, and run DB2 db2alx50

Environments

applications on a Windows or OS/2 system.
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Book Name Book Description Form Number
File Name
DB2 Extended Enterprise Edition Provides planning, installing, configuring, and using S72H-9620
Quick Beginnings information for DB2 Universal Database Extended db2v3x50
Enterprise Edition for AlX.
DB2 Personal Edition Quick Provides planning, installing, configuring, and using S10J-8150
Beginnings information for DB2 Universal Database Personal db2i1x50
Edition on 0OS/2, Windows 95, and the Windows NT
operating systems.
DB2 SDK for Macintosh Building Provides environment setup information and S50H-0528
Your Applications step-by-step instructions to compile, link, and run DB2 sqla7x02

applications on a Macintosh system.

Note: Available in PostScript format and hardcopy
for DB2 Version 2.1.2 only.

DB2 SDK for SCO OpenServer
Building Your Applications

Provides environment setup information and S89H-3242
step-by-step instructions to compile, link, and run DB2

e 1a9x02
applications on a SCO OpenServer system. Sqrasx
Note: Available for DB2 Version 2.1.2 only.
DB2 SDK for Silicon Graphics Provides environment setup information and S89H-4032
IRIX Building Your Applications step-by-step instructions to compile, link, and run DB2 sglaax02

applications on a Silicon Graphics system.

Note: Available in PostScript format and hardcopy
for DB2 Version 2.1.2 only.

DB2 SDK for SINIX Building

Provides environment setup information and S50H-0530

Your Applications step-by-step instructions to compile, link, and run DB2
L sgla8x00
applications on a SINIX system.
Note: Available in PostScript format and hardcopy
for DB2 Version 2.1.2 only.
Quick Beginnings for OS/2 Provides planning, installing, configuring, and using S10J-8147
information for DB2 Universal Database on OS/2. Also .
L . . . db2i2x50
contains installing and setup information for all
supported clients.
Quick Beginnings for UNIX Provides planning, installing, configuring, and using S10J-8148
information for DB2 Universal Database on db2ixx50
UNIX-based platforms. Also contains installing and
setup information for all supported clients.
Quick Beginnings for Windows Provides planning, installing, configuring, and using S10J-8149
NT information for DB2 Universal Database on the db2i6x50

Windows NT operating system. Also contains
installing and setup information for all supported
clients.
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Notes:

1. The character in the sixth position of the file name indicates the language of a
book. For example, the file name db2d0e50 indicates that the Administration Guide
is in English. The following letters are used in the file names to indicate the
language of a book:

Language Identifier Language Identifier
Brazilian Portuguese B Hungarian H
Bulgarian U Italian |
Czech X Norwegian N
Danish D Polish P
English E Russian R
Finnish Y Slovenian L
French F Spanish z
German G Swedish S

2. For late breaking information that could not be included in the DB2 books, see the
README file. Each DB2 product includes a README file which you can find in the
directory where the product is installed.

About the Information Center

250

The Information Center provides quick access to DB2 product information. The
Information Center is available on OS/2, Windows 95, and the Windows NT operating
systems. You must install the DB2 administration tools to see the Information Center.

Depending on your system, you can access the Information Center from the:

e Main product folder
e Toolbar in the Control Center
¢ Windows Start menu.

The Information Center provides the following kinds of information. Click on the
appropriate tab to look at the information:

Tasks Lists tasks you can perform using DB2.

Reference Lists DB2 reference information, such as keywords, commands,
and APls.

Books Lists DB2 books.

Troubleshooting Lists categories of error messages and their recovery actions.

Sample Programs Lists sample programs that come with the DB2 Software
Developer's Kit. If the Software Developer's Kit is not installed,
this tab is not displayed.

Web Lists DB2 information on the World Wide Web. To access this
information, you must have a connection to the Web from your
system.
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When you select an item in one of the lists, the Information Center launches a viewer to
display the information. The viewer might be the system help viewer, an editor, or a
Web browser, depending on the kind of information you select.

The Information Center provides search capabilities so you can look for specific topics,
and filter capabilities to limit the scope of your searches.

Ordering the Printed DB2 Books

You can also order the printed DB2 manuals. There are two sets of books available.
The form number for the entire set of DB2 books is SBOF-8915-00. The form number for
the books listed under the heading "Cross-Platform Books" is SBOF-8914-00.

Printing the PostScript Books

If you prefer to have printed copies of the manuals, you can uncompress and print
PostScript versions as follows.

On 0OS/2, Windows 95, and Windows NT systems:

1 Copy the compressed PostScript files to a hard drive on your system. The files
have a file extension of .exe and are located in the x:\language\books\ps
directory, where x: is the letter representing the CD-ROM drive and where
language is the two-character country code that represents your language (for
example, EN for English). Table 16 on page 256 lists the code for each available
language.

2 Uncompress the file by running the book name. The result from this step is a
printable PostScript file with a file extension of .ps.

3 Ensure that your default printer is a PostScript printer capable of printing Level 1
(or equivalent) files.

4 Enter the following command from a command line:

print filename.ps

Specify the full-path name for the file you intend to print.
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Viewing Online Books

The manuals included with this product are in Hypertext Markup Language (HTML)
softcopy format. Softcopy format enables you to search or browse the information more
easily, using hypertext links for related information. It also makes it easier to share the
library across your site.

Although you can use any HTML Version 3.2-compliant browser to view the online
books, a copy of the Netscape browser is available on the Portfolio CD-ROM provided
with DB2 Universal Database Version 5; you can optionally install it on your system.

Installing the Netscape Browser

If you do not have an HTML Version 3.2-compliant browser installed on your system,
you can install the Netscape browser from the Portfolio CD-ROM.

To install Netscape, insert the Portfolio CD-ROM into the CD-ROM drive. The Netscape
installation automatically begins. Follow the instructions provided on the panels to install
the product. If the installation does not automatically begin, see the README.TXT file
located at the root directory on the CD-ROM for installation instructions.

The README.TXT file also contains information about the products.

Setting up a Document Server

252

By default the DB2 information is installed on your local system. This means that each
person who needs access to the DB2 information must install the same files. To have
the DB2 information stored in a single location, use the following instructions:

1 Copy all files and sub-directories from \sgllib\doc\html on your local system to a
web server. Each book has its own sub-directory containing all the necessary
HTML and GIF files that make up the book. Ensure that the directory structure
remains the same.

2 Configure the web server to look for the files in the new location. For information
on NetQuestion, a search facility for HTML documents, see DB2 Online Books on
an Intranet (http://www.software.ibm.com/data/pubs/papers/db2html.html)

3 The Information Center allows you to specify a base URL for all HTML files. The
URL for the list of books should be used.

4 Once you are able to view the book files, you should bookmark commonly viewed
topics such as:
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e List of books.
¢ Tables of contents of frequently used books.
¢ Frequently referenced articles like the "How to use Syntax Diagrams" topic.

e Search form.

The search form provided with DB2 allows you to use several different search
variations. These include:

¢ Local indexes and files — this works by default.
¢ Local indexes, remote files — use the ngmap command to set this up.

¢ Remote indexes, remote files — use the ngmap command and edit the search
form to set this up.

e Create your own indexes for some other search engine — read the documentation
provided with this search engine, and index all files in the \sqllib\doc\html directory.
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Appendix B. National Language Support
(NLS)

This appendix contains information about configuring national language support for the
DB2 Connect product, and includes information on:

¢ Which languages are supported by DB2 Connect Enterprise Edition and DB2
Connect Personal Edition.

¢ How DB2 Connect handles the conversion of data between unalike systems.

e How to customize your DB2 Connect workstation for your particular national
language environment.

¢ How to customize your host Coded Character Set Identifier (CCSID) setting.

Code Page and Language Support for OS/2
and Windows Operating Environments

During installation of DB2, the country, codepage and regional settings are established.
You can, however, change these settings after installing DB2. This includes changing
regional settings such as code page, country language (for monetary, date, and
numeric formatting) and time zone. When a new connection to a database is made, the
database manager uses these new values.

You must ensure that you install the DBCS (double-byte character set)
version of DB2 on the corresponding DBCS version of the operating system.
Also, note that DB2 national language support may not produce the
expected results if the country, code page and regional settings are
incorrect for the intended language.

Table 16 on page 256 shows the languages into which the DB2 messages are
translated.

Note: The code page values in the table that follows are also used as directory hames
on DB2 CD-ROMs. For example, a reference to x:\language\winl6\install would
be x\EN\winl16\install for English.
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Table 16. Languages and Code Pages

Country Code Language Country Code Language

BG Bulgaria IL Hebrew

BR Brazilian IT Italian
Portuguese

CN Simplified Chinese JP Japanese
(PRC)

Ccz Czech KR Korean

DE German NO Norwegian

DK Danish PL Polish

ES Spain RU Russian

Fl Finnish SE Sweden

FR French Sl Slovenian

GR Greece ™ Traditional Chinese

(Taiwan)
HU Hungary EN English

Date and Time Formats

The character string representation of date and time formats is the default format of
datetime values associated with the country code of the application. This default format
may be overridden by specification of the F format option when the program is
precompiled or bound to the database.
The following is a description of the input and output formats for date and time:
e Input Time Format
— There is no default input time format
— All time formats are allowed as input for all country codes.
e Output Time Format
— The default output time format is equal to the local time format.
e Input Date Format
— There is no default input date format

— Where the local format for date conflicts with an 1SO, JIS, EUR, or USA date
format, the local format is recognized for date input. For example, see the UK
entry in Table 17 on page 257.

e Output Date Format
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— The default output date format is shown in Table 17 on page 257.

Note: Table 17 also shows a listing of the string formats for the various
country codes.

Table 17 (Page 1 of 3). Date and Time Formats by Country Code

Country Code Local Date Local Default Input Date
Format Time Output Formats
Format Date
Format

785 Arabic dd/mmlyyyy JIS LOC LOC, EUR, ISO

001 Australia (1) mm-dd-yyyy JIS LOC LOC, USA, EUR,
ISO

061 Australia dd-mm-yyyy JIS LOC LOC, USA, EUR,
ISO

032 Belgium dd/mmlyyyy JIS LOC LOC, EUR, ISO

055 Brazil dd.mm.yy JIS LOC LOC, USA, EUR,
ISO

359 Bulgaria dd.mm.yyyy JIS EUR LOC, USA, EUR,
ISO

001 Canada mm-dd-yyyy JIS USA LOC, USA, EUR,
ISO

002 Canada (French) dd-mm-yyyy I1ISO I1ISO LOC, USA, EUR,
ISO

385 Croatia yyyy-mm-dd JIS ISO LOC, USA, EUR,
ISO

042 Czech Republic yyyy-mm-dd JIS I1ISO LOC, USA, EUR,
ISO

045 Denmark dd-mm-yyyy 1ISO 1ISO LOC, USA, EUR,
ISO

358 Finland dd/mm/lyyyy 1ISO EUR LOC, EUR, ISO

389 FYR Macedonia dd.mm.yyyy JIS EUR LOC, USA, EUR,
ISO

033 France dd/mmlyyyy JIS EUR LOC, EUR, ISO

049 Germany dd/mm/lyyyy 1ISO I1ISO LOC, EUR, ISO

030 Greece dd/mmlyyyy JIS LOC LOC, EUR, ISO

036 Hungary yyyy-mm-dd JIS 1ISO LOC, USA, EUR,
ISO

354 Iceland dd-mm-yyyy JIS LOC LOC, USA, EUR,
ISO

972 Israel dd/mm/yyyy JIS LOC LOC, EUR, ISO

039 ltaly dd/mmlyyyy JIS LOC LOC, EUR, ISO
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Table 17 (Page 2 of 3).

Date and Time Formats by Country Code

Country Code Local Date Local Default Input Date
Format Time Output Formats
Format Date
Format

081 Japan mm/dd/yyyy JIS I1ISO LOC, USA, EUR,
ISO

082 Korea mm/dd/yyyy JIS ISO LOC, USA, EUR,
ISO

001 Latin America (1) mm-dd-yyyy JIS LOC LOC, USA, EUR,
ISO

003 Latin America dd-mm-yyyy JIS LOC LOC, EUR, ISO

031 Netherlands dd-mm-yyyy JIS LOC LOC, USA, EUR,
ISO

047 Norway dd/mml/yyyy I1ISO EUR LOC, EUR, ISO

048 Poland yyyy-mm-dd JIS ISO LOC, USA, EUR,
ISO

351 Portugal dd/mmlyyyy JIS LOC LOC, EUR, ISO

086 PRC mm/dd/yyyy JIS ISO LOC, USA, EUR,
ISO

040 Romania yyyy-mm-dd JIS 1ISO LOC, USA, EUR,
ISO

007 Russia dd/mmlyyyy 1ISO LOC LOC, EUR, ISO

381 yyyy-mm-dd JIS ISO LOC, USA, EUR,

Serbia/Montenegro 1ISO

042 Slovakia yyyy-mm-dd JIS I1ISO LOC, USA, EUR,
ISO

386 Slovenia yyyy-mm-dd JIS 1ISO LOC, USA, EUR,
ISO

034 Spain dd/mmlyyyy JIS LOC LOC, EUR, ISO

046 Sweden dd/mmlyyyy ISO ISO LOC, EUR, ISO

041 Switzerland dd/mml/yyyy I1ISO EUR LOC, EUR, ISO

088 Taiwan mm-dd-yyyy JIS ISO LOC, USA, EUR,
ISO

066 Thailand (2) dd/mmlyyyy JIS LOC LOC, EUR, ISO

090 Turkey dd/mml/yyyy JIS LOC LOC, EUR, ISO

044 UK dd/mmlyyyy JIS LOC LOC, EUR, ISO

001 USA mm-dd-yyyy JIS USA LOC, USA, EUR,

ISO
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Table 17 (Page 3 of 3). Date and Time Formats by Country Code

Country Code Local Date Local Default Input Date
Format Time Output Formats
Format Date
Format
Notes:

1. Countries using the default C locale are assigned country code 001.

2. yyyy is in Buddhist era: Gregorian + 543 years.

Conversion of Character Data

When character data is transferred between machines, it must be converted to a form
that the receiving machine can use.

For example, when data is transferred between the DB2 Connect workstation and a
DRDA server, it is usually converted from a workstation code page to a host CCSID,
and vice versa. If the two machines use different code pages or CCSIDs, code points
are mapped from one code page or CCSID to the other. This conversion is always
performed at the receiver.

Character data sent to a database consists of SQL statements and input data.
Character data sent from a database consists of output data. Output data that is
interpreted as bit data (for example, data from a column declared with the FOR BIT
DATA clause) is not converted. Otherwise all input and output character data is
converted if the two machines have different code pages or CCSIDs.

For example, if DB2 Connect is used to access DB2 for OS/390 or DB2/MVS data, the
following happens:

1. DB2 Connect sends an SQL statement and input data to OS/390 or MVS.

2. DB2 for OS/390 converts the data to an EBCDIC CCSID and processes it.

3. DB2 for OS/390 sends the result back to the DB2 Connect workstation.

4. DB2 Connect converts the result to an ASCII or ISO code page and returns it to
the user.

The table that follows shows the conversions that are supported between code pages
(on the workstation) and CCSIDs (on the host).

For more detailed information about supported code page conversions, refer to the
Administration Guide.
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Table 18. Workstation Code Page to Host CCSID Conversion

Host CCSIDs Code Page Countries
037, 273, 277, 278, 280, 284, 437, 819, 850, 860, 863, Australia, Austria, Belgium,
285, 297, 500, 871 1004, 1051, 1252, 1275 Brazil, Canada, Denmark,

Finland, France, Germany,
Iceland, Italy, Latin America,
Netherlands, New Zealand,
Norway, Portugal, South
Africa, Spain, Sweden,
Switzerland, UK, USA

875, 423 813, 869, 1253, 1280 Greece

870 852, 912, 1250, 1282 Croatia, Czech Republic,
Hungary, Poland, Romania,
Serbia/Montenegro (Latin),
Slovakia, Slovenia

1025 855, 915, 1251, 1283 Bulgaria, FYR Macedonia,
Serbia/Montenegro (Cyrillic)

1026 857, 920, 1254, 1281 Turkey

424 862, 916, 1255 Israel

420 864, 1046, 1089, 1256 Arabic countries

1025 866, 915, 1251, 1283 Russia

838 874 Thailand

930, 939, 1027, 5026, 5035 932, 942, 943, 954, 5039 Japan

937 938, 948, 950, 964 Taiwan

933 949, 970, 1363 Korea

935 1381, 1383 People's Republic of China

Note that code page 1004 is supported as code page 1252.
In general, data can be converted from a code page to a CCSID and back again to the
same code page with no change. The following are the only exceptions to that rule:

¢ In double-byte character set (DBCS) code pages, some data containing
user-defined characters may be lost.

¢ For single-byte code pages defined within mixed-byte code pages, some
characters may be mapped to substitution characters and then lost when the data
is converted back to the original code page.
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Customizing Language Support

By default, DB2 Connect queries the current code page settings for your system and
the database. This section tells you how the conversion is checked, gives examples,
and tells you how you can customize your DB2 Connect Personal Edition workstation.

Summary

When DB2 Connect connects to a database, the client's code page is passed to the
host, which validates the conversion requested between the client code page and the
host database code page. (In the case of DB2 Connect DB2 Connect Personal Edition,
the client is the DB2 Connect workstation).

If the conversion is not supported, then message SQL30073N is issued. Otherwise, a
similar check is then performed by DB2 Connect.

For example, if you are connecting to a DB2 for OS/390 or DB2 for MVS/ESA database
that uses host CCSID 930 (Japan), then your PC must be set up to use one of the
code pages listed in that row of the table.

Note: Always set the DB2ZCODEPAGE environment variable to a value that is
supported by the operating system

How to Determine your Workstation Code Page

To determine what the current code page setting is for your DB2 Connect Personal
Edition workstation:

Windows 3.1 and Windows for Workgroups
3.11

For both these operating systems, DB2 Connect Personal Edition uses the system
default. You can examine or change this by using Windows Setup, as described in the
Microsoft Windows User's Guide. Refer also your operating system documentation
about code page support.

You may also need to set the DB2CODEPAGE environment variable in your DB2.INI
file. You can do this by editing this file. See also Chapter 24, “Controlling Your DB2
Environment” on page 157.
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Windows 95 and Windows NT

For both these operating systems, DB2 Connect Personal Edition automatically
determines your code page and country code.

Note that Windows NT supports both OEM and ANSI code pages concurrently. DB2
programs run in the ANSI code page, and (when using DB2 Windows NT) databases
are created using the ANSI code page as well. The DOS Command Line Processor
runs in the OEM code page but the Windows operating system converts the characters
to ANSI code page before connecting to DB2. This type of conversion does not take
place from DB2 to the DOS Command Line Processor. To avoid any discrepancies, you
can do one of the following:

¢ Use the Command Center instead of the DOS Command Line Processor

e |If you must use the DOS Command Line Processor, do the following:
1 Set the DB2CODEPAGE environment variable to your OEM code page.
2 Choose a TrueType font.
3 Issue the db2.
4

Enter all your commands from within the DB2 shell.

Refer to your operating system documentation.

Customizing Your DRDA Host

MVS

The information in this section provides a summary of the steps required. For further
information, refer to the IBM DRDA Connectivity Guide, SC26-4783, and the
documentation provided for your host RDBMS and operating system.

On an OS/390 or MVS system, the host CCSID cannot be queried when set. The
system setup file DSNHDECP contains code page and character set related system
parameters:

SCCSID Determines the system CCSID setting for single byte characters.

MCCSID  Determines the system setting for mixed character sets, and is not required
unless using double byte characters. It should be set to 65534 when using
single byte characters only.
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0S/400

GCCSID  Determines the system setting for graphic character sets, is not required
unless using double byte characters. It should be set to 65534 when using
single byte characters only.

Example for “US English™:

SCCSID set to 37 (leading zeros not required)
MCCSID set to 65534
GCCSID set to 65534

Example for “Japanese English”:

SCCSID set to 1027
MCCSID set to 5035
GCCSID set to 4396

To change the settings, ask your 0S.390 or MVS system administrator to:

1 Determine the correct values to be set in order to meet your requirements,
bearing in mind the requirements of other system users.

2 Modify and execute the DSNTINST CLIST, specifying UPDATE on the main panel, in
order to change the Application Programming defaults.

Run job DSNTIJUZ, created by the previous step, in order to update the system.
Validate the results.

Halt and restart the DB2 system to activate the change.

The system-wide CCSID setting normally defaults to 65535, which indicates no
character conversion. The DB2 Connect workstation cannot connect to an AS/400
system if this setting is used.

When a connection is made to DB2/400, there is a user profile that the corresponding
job runs under. Individual users have a user profile, in which one of the settings is
CCSID. This defaults to *SYSVAL.

For DB2 Connect to successfully connect, either the system-wide CCSID setting must
be changed to some value other than 65535, or the CCSID attribute of the user's user
profile must be set to some value other than *SYSVAL.

For US English, set the user profile CCSID value to 37. For other languages, see the
appendix entitled “National Language Version Default System Values,” in AS/400
National Language Support, SC41-3101, which lists supported languages and CCSIDs
for the AS/400.
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For double byte characters, OS/400 must be enabled for DBCS, and the CCSID must
be set to a “mixed” value from which the other codes required can be derived.

Refer to your AS/400 system administrator and documentation for further information.

VM and VSE

With DB2 for VM and VSE, the parameter CHARNAME is set when the database is
started. This parameter is set at the database level, and it can be queried by viewing
the system table SYSTEM.SYSOPTIONS.

DB2 for VM and VSE provides a list of possible values for CHARNAME. For example, for
Japanese English, set CHARNAME to the string Japanese_English. For US English
(CCsSID 37), set CHARNAME to English. For CCSID 500, set CHARNAME to
International.

Note that, in addition to database level tagging, DB2 for VM and VSE also provides
column level CCSID tagging. All the data inside a database need not have the same
CCSID. For example, in a single table one column could be tagged with CCSID 500,
another tagged with 277, and so on.

Also, DB2 for VM and VSE does not currently provide support for host code pages
1026 or 931, neither does it provide support for several of the conversions listed earlier,

namely:
Code Host
Page CCSID

1004 037, 273, 277, 278, 280, 284, 285, 297, 500, 871
1051 037, 273, 277, 278, 280, 284, 285, 297, 500, 871
1046 420
1089 420

Any of the Macintosh code pages (1275, 1280, 1281, 1282, 1283)

Refer to your DB2 for VM and VSE Database Administrator and documentation for
further information.
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Appendix C. Naming Rules

Use the following to find the naming rules you need:

¢ “General Naming Rules”

e ‘“Database and Database Alias Names” on page 266

e “Object Names” on page 266

e “User IDs, Group Names, and Instance Names” on page 267
e “DB2SYSTEM Naming Rules” on page 268

¢ “Workstation Names (nname)” on page 268

e “Password Naming Rules” on page 269

General Naming Rules

Unless otherwise specified, all names can include the following characters:
e A through Z

Note: When used in most names, characters A through Z are converted from
lowercase to uppercase.

e 0 through 9

c @

o #

e $

e _ (underscore)

Unless otherwise specified, all names must begin with one of the following characters:

e A through Z
e @
o #
LI

Do not use SQL reserved words to name tables, views, columns, indexes, or
authorization IDs. A list of SQL reserved words is included in the SQL Reference.
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Database and Database Alias Names

Database names are the identifying names assigned to databases in the database
manager.

Database alias names are synonyms given to remote databases. Database aliases
must be unique within the System Database Directory in which all aliases are stored.

When naming a database or database alias, see “General Naming Rules” on page 265.
In addition, the name you specify can contain 1 to 8 characters.

Notes:

1. To avoid potential problems, do not use the special characters @, #, and $ in a
database name if you intend to have a client remotely connect to a host database.
Also, because these characters are not common to all keyboards, do not use them
if you plan to use the database in another country.

2. On Windows NT systems, ensure that no instance name is the same as a service
name.

Object Names

Database objects include:

e Tables

e Views

e Columns

e Indexes

e User-defined functions (UDFs)
e User-defined types (UDTS)

e Triggers

e Aliases

e Table spaces

e Schemas

When naming database objects, see “General Naming Rules” on page 265.

In addition, the name you specify:

e Can contain 1 to 18 characters
e Cannot be any of the SQL reserved words that are listed in the SQL Reference.
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Note: Using delimited identifiers, it is possible to create an object that violates these
naming rules; however, subsequent use of the object could result in errors.

For example, if you create a column with a + or — sign included in the nhame and
you subsequently use that column in an index, you will experience problems
when you attempt to reorganize the table. To avoid potential problems with the
use and operation of your database, do not violate the above rules.

User IDs, Group Names, and Instance
Names

User IDs are the identifiers assigned to individual users. When naming users, groups,
or instances, see “General Naming Rules” on page 265.
In addition, the name you specify:

e Can contain 1 to 8 characters

e Cannot be any of the following:

- USERS
— ADMINS
— GUESTS
— PUBLIC
— LOCAL

e Cannot begin with:

— IBM
- sQL
- SYS

e Cannot include accented characters
¢ In general, when naming users, groups, or instances:

— On 0OS/2, use uppercase names
— On Windows 95 and Windows NT, use any case

Additional Considerations for Usernames in
Windows NT

To use DB2 for Windows NT, you need to create a special username that meets DB2's
naming requirements. You must use this username to install and perform DB2
administration tasks.
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When you name a username in Windows NT, the name you specify:

e Must be a member of the Administrators group on the local machine
e Must be acceptable to DB2 as described previously.

Whenever an instance is created for DB2 servers or DB2 Connect servers, a Windows
NT service is also created using the instance name. In addition, an instance directory is
created in the sqllib using the instance name. For example, if DB2 is installed in the
e:\sqllib directory, the default instance creates the following directory path: e:\sqllib\db2.
Therefore two additional restrictions apply when you are naming DB2 instances:

1. DB2 instance names cannot conflict with other Windows NT service names.
2. DB2 instance names cannot be the same as the names of existing directories or
files under sqllib.

Note: Do not attempt to install or administer DB2 from Windows NT's default
"Administrator" username. Because that username has more than eight
characters, DB2 will not accept the request.

Workstation Names (nname)

Workstation names are used to specify the NetBIOS name for a database server or
database client that resides on the local workstation. This name is stored in the
database manager configuration file. The workstation name is known as the nname.
When naming workstations, see “General Naming Rules” on page 265.

In addition, the name you specify:

e Must be unique within a network
e Can contain 1 to 8 characters
e Cannot include &

DB2SYSTEM Naming Rules

DB2SYSTEM names are used by DB2 to identify a physical DB2 machine, system,
server, or workstation with a network. On OS/2, you must specify a DB2SYSTEM name
during or after install. On Windows 95 and Windows NT, you do not need to specify a
DB2SYSTEM name; the DB2 install program detects the NT Computer name and
assigns it to DB2SYSTEM.

When creating a DB2SYSTEM name, see “General Naming Rules” on page 265.
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In addition, the name you specify:

¢ Must be unique within a network
e Can contain a maximum of 21 characters

Password Naming Rules

When determining passwords on OS/2 and Windows 3.x, the word or name you specify
can consist of a maximum of 8 characters. On all other operating systems the word or
name you specify can consist of a maximum of 18 characters.
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Appendix D. List Files, Bind Files, and
Packages

This appendix lists the bind files contained in different .T1st files shipped with the
product. Although the contents of these lists are similar for each platform, the bind
packages are generated specifically for each platform. each package name can be
mapped back to the client platform.

Note that the Bind function in the DB2 Client Configuration Assistant and in the DB2
Data Sources Setup tool (included in DB2 Connect Personal Edition) choose the correct
bind files for you automatically.

Note: In the following tables, under the Package Name columns, each DB2 bind
package is represented as follows. For example, in the file name SQLabxYz:

e SQL identifies the bind package as a DB2 utility,

e ab identifies the utility,

e xrepresents the last digit of the year the product became available,
e Yrepresents the platform of the client,

e zrepresents the modification level.

Users on 0S/2, Windows 95, Windows NT, and AlX systems can use the ddcspkgn
command to determine the package name for for individual bind files or list (.Ist) files.
This command is found in the bin directory under the DB2 installation directory. For
example, on an AlX system, enter the following command with the bind file in the local
directory:

/sq11ib/bin/ddcspkgn db2ajgrt.bnd

The following list maps Y values to platforms:

XAz Clients for AIX

xHz Clients for HP-UX

xUz Clients for Solaris

XXz Clients for SINIX

xPz Clients for Power PC

xDz Clients for OS/2

xWz Clients for Windows

XNz Clients for Windows 95 and NT
XMz Clients for Macintosh

xSz Clients for SCO OpenServer
xGz Clients for Silicon Graphics
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List Files Associated with DRDA Servers

272

The following table lists which bind files are included in the .1st file associated with a
particular DRDA host. The package associated with each bind file is also listed:

DRDA Server List File

0S/390 and MVS ddcsmvs.Ist

VSE ddcsvse.lIst
VM ddcsvm.Ist
0S/400 ddcs400.Ist

Table 19. DRDA Bind Files and Packages

Bind File Package
Component Name Name MVS VM/IVSE  OS/400
Binder (used by the db2ajgrt.bnd sqlabxyz yes yes yes
GRANT bind option)
DB2 Call Level Interface
Isolation level CS db2clics.bnd sqlllxyz yes yes yes
Isolation level RR db2clirr.bnd sqll2xyz yes yes yes
Isolation level UR db2cliur.bnd sqll3xyz yes no yes
Isolation level RS db2clirs.bnd sqlldxyz no no yes
Isolation level NC db2clinc.bnd  sqll5xyz no no yes
Using MVS table names db2clims.bnd  sqll7xyz yes no no
Using OS/400 table db2clias.bnd sqllaxyz no no yes
names (0S/400 3.1 or
later)
Using VSE/VM table db2clivm.bnd  sqll8xyz no yes no
names
Command Line Processor
Isolation level CS db2clpcs.bnd  sqglc2xyz yes yes yes
Isolation level RR db2clprr.bnd sqlc3xyz yes yes yes
Isolation level UR db2clpur.bnd  sqlcdxyz yes yes yes
Isolation level RS db2clprs.bnd  sqlc5xyz no no yes
Isolation level NC db2clpnc.bnd  sqglc6xyz no no yes
REXX
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Isolation level CS db2arxcs.bnd  sglalxyz yes yes yes
Isolation level RR db2arxrr.bnd  sgla2xyz yes yes yes
Isolation level UR db2arxur.bnd  sgla3xyz yes yes yes
Isolation level RS db2arxrs.bnd  sgladxyz yes yes yes
Isolation level NC db2arxnc.bnd  sgla5xyz no no yes
Utilities
Export db2uexpm.bnd sqglubxyz yes yes yes
Import db2uimpm.bnd sqlufxyz yes yes yes

Note: If your DB2 for MVS/ESA system has APAR PN60988 installed (or if it is a later
release than Version 3 Release 1), you can add the bind files for isolation level
NC to the ddcsmvs.Ist file.

Appendix D. List Files, Bind Files, and Packages
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Appendix E. Notices

Any reference to an IBM licensed program in this publication is not intended to state or
imply that only IBM’s licensed program may be used. Any functionally equivalent
product, program or service that does not infringe any of IBM’s intellectual property
rights may be used instead of the IBM product, program, or service. Evaluation and
verification of operation in conjunction with other products, except those expressly
designated by IBM, is the user’s responsibility.

IBM may have patents or pending patent applications covering subject matter in this
document. The furnishing of this document does not give you any license to these
patents. You can send license inquiries, in writing, to the

IBM Director of Licensing,
IBM Corporation,

500 Columbus Avenue,
Thornwood, NY, 10594
USA.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs and
other programs (including this one) and (ii) the mutual use of the information which has
been exchanged, should contact:

IBM Canada Limited
Department 071

1150 Eglinton Ave. East
North York, Ontario
M3C 1H7

CANADA

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

This publication may contain examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.
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Trademarks

The following terms are trademarks or registered trademarks of the IBM Corporation in

the United States and/or other countries:

ACF/NTAM
ADSTAR

AISPO

AlX

AlXwindows
AnyNet

APPN

AS/400

CiCs

C Set++

C/370

DATABASE 2
DatagLANce
DataHub
DataJoiner
DataPropagator
DataRefresher
DB2

Distributed Relational Database Architecture
DRDA

Extended Services
FFST

First Failure Support Technology
IBM

IMS

Lan Distance

MVS/ESA
MVS/XA
NetView
0S/400
0S/390
0Ss/2
PowerPC
QMF

RACF
RISC System/6000
SAA

SP

SQL/DS
SQL/400
S/370
System/370
System/390
SystemView
VisualAge
VM/ESA
VSE/ESA
VTAM
WIN-OS/2

Trademarks of Other Companies
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The following terms are trademarks or registered trademarks of the companies listed:

C-bus is a trademark of Corollary, Inc.

HP-UX is a trademark of Hewlett-Packard.

Java and HotJava are trademarks of Sun Microsystems, Inc.

Microsoft, Windows, Windows NT, and the Windows 95 logo are trademarks or
registered trademarks of Microsoft Corporation.
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PC Direct is a trademark of Ziff Communications Company and is used by IBM
Corporation under license.

Solaris is a trademark of Sun Microsystems, Inc.

UNIX is a registered trademark in the United States and other countries licensed
exclusively through X/Open Company Limited.

Other company, product, or service names, which may be denoted by a double asterisk
(**), may be trademarks or service marks of others.
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Index

A

Access Profile

creating 210
using 210

accessing host servers

configuring communications
Communications Server for OS/2 59
overview 57

accounting information

sending to DRDA server 133

Administrator name

valid names 29

APPC

configuring on Windows 3.1x 45

configuring with the Data Sources Setup tool

software requirements 20
support on 0S/2
Communications Manager for 0S/2 59
Communications Server for 0S/2 59
support on Windows NT
IBM Communications Server for NT 49

IBM Communications Server for NT SNA

Client 49

IBM Communications Server for Windows NT 81
IBM Communications Server for Windows NT

SNA Client 93
Integrated SNA Support 49, 75
Microsoft SNA Client 117
Microsoft SNA Server 101

application development

using ODBC 143

application types, supported 3
applications

binding
using Client Configuration Assistant
using Data Sources Setup tool 45

authority

B

levels 136

bind files and package names 271
binding
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binding (continued)

utilities and applications 142
book

conventions  Xi

icons list xi

printing Postscript 251

related books 243

road map  Xxii

viewing online 251, 252

C

CD-ROM

installing DB2 Universal Database 25, 26

changing privileges 137
character data conversion 259
Client Configuration Assistant

administering clients communications 127

changing privileges 137
client profiles 127
exporting 211
importing 213
using 211
discover 215
discovering databases 128
overview 49
searching the network 127, 213

setting configuration parameters 167, 217

using access profiles 210
client profile

exporting 211

importing 213
code page

conversion 259
code page conversions 255
Command Center

entering DB2 commands 151

entering SQL statements 151
commands

db2set 158

echo 159, 160

set 159
communication protocols

APPC 21
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communication protocols (continued)
configuring APPC 59
Named Pipes 22
NetBIOS 22
TCP/IP 21, 22
configuring for DRDA host access 232
communications
configuring the client 127
managing
Client Configuration Assistant 127
Communications Server for Windows NT
configuring 81
version required 81
Communications Server for Windows NT SNA Client
configuring 93
version required 93
components
choosing on Windows 3.1x 37
choosing on Windows NT 30
configuration parameters
dft_account_str 133
setting 137, 157, 167
SYSADM_GROUP 137
configuring
APPC 59
DB2 Connect 59
ODBC driver 146, 148
configuring client communications
setting configuration parameters 167
using the Client Configuration Assistant 127
configuring communications 57
using Client Configuration Assistant 127
configuring host communications 57
configuring server communications
setting DB2COMM 210
connecting to a database 136
connections to DRDA hosts
direct to DRDA host 10, 232
overview of scenarios 9
through communications gateway 11, 81, 93, 101,
232
Control Center
changing privileges 137
conventions
book xi

D

data conversion 259
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data source definitions
defining 45
importing 47
sharing 46
Data Source Setup tool
changing MVS password with 53
using 45
database
naming rules 266
database alias
naming rules 266
database objects
naming rules 266

date

formats 256
DB2

installing 26

DB2 Connect
configuration planning 17
overview 3
supported application types 3
DB2 Connect configuration
saving, steps 73
DB2 Connect Enterprise Edition
when to use 11
DB2 Connect Personal Edition
host communications
0S/2 20

Windows 3.1 and Windows for Workgroups

311 22
Windows 95 21
Windows NT 20, 21
installing on Windows 3.1x 37
operating systems supported 20
software requirements 20
DB2 Enterprise Edition
disk requirements 18
DB2 for MVS/ESA
updating system tables 229, 230
DB2 server, definition 5
DB2 Universal Database
getting started 135
DB2 Workgroup Edition
disk requirements 18
db2.ini file
environment keywords 161
DB2ACCOUNT 134
db2set command
using 158



dft_account_str 133
Discovery
choosing a discovery method 215
searching the network 213
setting Discovery parameters 217
disk requirements
client 18
server 18
Distributed Relational Database Architecture (DRDA)
connections
configuring TCP/IP 232
documentation
related publications 243
DRDA server
configuring connection from OS/2 59
sending accounting information 133
DSPNETA command (OS/400) 239
DSPRDBDIRE command (0S/400) 240

E

environment variables
db2instance 165
db2instprof 165
db2path 165

F

files
bind files 271
list files 271
finding topics 252
fixed disks
hardware requirements 18

H

hardware requirements
fixed disk 18
help
See information 243
host character sets 255

IBM Communications Server for NT
configuring communications with 57

IBM Communications Server for NT SNA Client
configuring communications with 57

icons
description xi
information
online help 243
ordering 251
overview 243
related publications 243
road map xii
viewing online 251, 252
installation
CID using SystemView LAN 34, 197
DB2 clients
0Ss/2 25
disk requirements
client 18
server 18
errors 34, 197
log 34, 197
Netscape 252
servers
0S/2 25
unattended
0S/2 179, 185
Windows 3.x 179
Windows 95 189
Windows NT 189
instance
naming restrictions 267
Integrated SNA Support
configuring manually 75

J

Java, running programs 149
JDBC, running programs 149

L

LANG environment variable 255
language support 255

list files 271

logging off the system 136
logging on to the system 136

M

managing connections
client
using the Client Configuration Assistant 127
server
using the Client Configuration Assistant 127

Index
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messages
getting online help 243
Microsoft ODBC Driver Manager 145
Microsoft SNA Client
configuring 117
version required 117
Microsoft SNA Server
configuring 101
version required 101

N

naming rules

database 266

database alias 266

database objects 266

general 265

groups 267

instance names 267

password 269

userids 267

username 30, 267

workstation name (nname) 268
National Language Support (NLS)

character data conversion 259

codepage support 255

configuring 255

customizing language support 261

determining codepage 256
NetBIOS

supports SEARCH discovery 216
network

configuring OS/400 access 57
network scenarios 9

O

ODBC
registering the driver manager 145
running programs 143
setting two-phase commit option 123
ODBC-enabled applications, running 143
odbcad32.exe 145
ordering related publications 243, 251

P

parameters
SYSADM_GROUP 137
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changing on MVS 53
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planning
DB2 configuration 14
DB2 Connect Configuration 12, 17
printing postscript 251
privileges
required 137
product
descriptions 3
overview 3
profile registry
using 157

R

registering
ODBC driver manager 145

registry values
db2account 133, 134, 162
db2clientadpt 167
db2clientcomm 167
db2codepage 162
db2comm 165
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db2dbdft 163
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db2netreq 166
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db2route 167
db2slogon 163
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db2trcsyserr 164
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general 162
setting 157

remote installation
0S/2 185

SystemView 185
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0S/2 181
Windows 3.X 181



response files (continued)

Windows 95 and Windows NT 192
restrictions

instance name 267
running applications

database client 141

ODBC considerations 143

S

setting
environment variables 157
setting up client communications
using the Client Configuration Assistant 127
SNA
configuring Communications Server for Windows NT
manually 81
configuring Communications Server for Windows NT
SNA Client manually 93
configuring Integrated SNA Support on Windows
3.1x 45
configuring Microsoft SNA Client manually on
Windows 117
configuring Microsoft SNA Server manually on
Windows NT 101
configuring Wall Data Rumba manually on Windows
NT 45
configuring with the Data Sources Setup tool 45
software registration 139
software requirements
communication protocols 19
DB2 Connect 19
SYSADM
privileges
controlling 137
sysadm_group parameter 137

T

TCP/IP 50
configuring DB2 for OS/390 for 224
configuring host connections 232
configuring host connections with the Client

Configuration Assistant 50

configuring with the Data Sources Setup tool 45
host connections with DB2 Connect 9
set with db2set 165
setting up two-phase commit 123
software requirements 20, 22
supported to host systems 8

TCP/IP (continued)
supports SEARCH discovery 216
territory 255
time
formats 256
two-phase commit
setting ODBC manager option 123

U

unattended installation
0S/2 185
SystemView LAN 185
Windows 95 or Windows NT
Server Management System (SMS) 198
User Profile Management (UPM)
adding users 169
administering users 169
logon command 169
passwords 169
username
naming rules 267
using the command line processor (CLP)
connecting to a database 136
utilities
binding 141
using Client Configuration Assistant
using Data Sources Setup tool 45

Vv

VTAM
DB2 Connect uses independent LU 70
sample definitions 225
sample logon mode table entry 228
sample PU and LU definitions 227

W

Wall Data Rumba

configuring manually 75
WRKLIND command (OS/400) 63, 239
WRKMODD command (0S/400) 63, 239
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Contacting I1BM

This section lists ways you can get more information
from IBM.

If you have a technical problem, please take the time to
review and carry out the actions suggested by the
Troubleshooting Guide before contacting DB2 Customer
Support. Depending on the nature of your problem or
concern, this guide will suggest information you can
gather to help us to serve you better.

For information or to order any of the DB2 Universal
Database products contact an IBM representative at a
local branch office or contact any authorized IBM
software remarketer.

Telephone

If you live in the U.S.A., call one of the following
numbers:

e 1-800-237-5511 to learn about available service
options.

e 1-800-IBM-CALL (1-800-426-2255) or
1-800-3IBM-0OS2 (1-800-342-6672) to order
products or get general information.

e 1-800-879-2755 to order publications.

For information on how to contact IBM outside of the
United States, see Appendix A of the IBM Software
Support Handbook. You can access this document by
selecting the "Roadmap to IBM Support" item at:
http://lwww.ibm.com/support/.
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Note that in some countries, IBM-authorized dealers
should contact their dealer support structure instead of
the IBM Support Center.

World Wide Web
http://www.software.ibm.com/data/
http://lwww.software.ibm.com/data/db2/library/

The DB2 World Wide Web pages provide current DB2
information about news, product descriptions, education
schedules, and more. The DB2 Product and Service
Technical Library provides access to frequently asked
guestions, fixes, books, and up-to-date DB2 technical
information. (Note that this information may be in English
only.)

Anonymous FTP Sites
ftp.software.ibm.com

Log on as anonymous. In the directory /ps/products/db2,
you can find demos, fixes, information, and tools
concerning DB2 and many related products.

Internet Newsgroups
comp.databases.ibm-db2, bit.listserv.db2-I

These newsgroups are available for users to discuss
their experiences with DB2 products.

CompuServe
GO IBMDB2 to access the IBM DB2 Family forums

All DB2 products are supported through these forums.

To find out about the IBM Professional Certification
Program for DB2 Universal Database, go to
http://www.software.ibm.com/data/db2/db2tech/db2cert.html
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